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Notices
FCC Compliance
In order to comply with FCC/CFR47: Part 15 regulations, it is necessary to use Mini HDMI to 
HDMI high-quality triple-screened cable assemblies with integrated ferrite suppression at 
both ends.

Copyright and Trademark Notice
Copyright © 2019, Grass Valley Canada. All rights reserved.

Belden, Belden Sending All The Right Signals, and the Belden logo are trademarks or 
registered trademarks of Belden Inc. or its affiliated companies in the United States and 
other jurisdictions. Grass Valley, Momentum are trademarks or registered trademarks of 
Grass Valley Canada. Belden Inc., Grass Valley Canada, and other parties may also have 
trademark rights in other terms used herein.

External Trademarks
• Baton is a registered trademark of Interra Systems, Inc.
• Cerify TEKTRONIX and TEK are registered trademarks of Tektronix, Inc. Cerify is 

trademark of Tektronix, Inc.
• Dolby. Manufactured under license from Dolby Laboratories. ‘Dolby’, ‘Pro Logic’, and the 

double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished 
works. Copyright 1992-1999 Dolby Laboratories. All rights reserved.

• FlipFactory is registered trademarks of Telestream, Inc.
• FFmpeg. This product uses software developed by the FFmpeg project, 

www.ffmpeg.org, specifically, support for DV is provided by some components of the 
libavcodec and libavutil libraries.

• iCR is a registered trademark of Amberfin, Inc.
• Matrox®, DSX™, DSX.sdk™, DSX.utils™, FlexEffects.sdk™, X.mio2™, X.mio3™ are registered 

trademarks of Matrox Electronic Systems Ltd.
• Morpheus is a registered trademark of Grass Valley.
• Rhozet WFS and Promedia Carbon is a registered trademark of Harmonic inc.
• Pulsar is a trademark of Venera Technologies Pvt Ltd.
• Windows Media. This product is protected by certain intellectual property rights of 

Microsoft. Use or distribution of such technology outside of this product is prohibited 
without a license from Microsoft.

• MXFTk is a registered trademark of OpenCube Technologies SAS

Terms and Conditions
Please read the following terms and conditions carefully. By using Momentum 
documentation, you agree to the following terms and conditions.

Grass Valley hereby grants permission and license to owners of Momentum to use their 
product manuals for their own internal business use. Manuals for Grass Valley products may 
ii
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not be reproduced or transmitted in any form or by any means, electronic or mechanical, 
including photocopying and recording, for any purpose unless specifically authorized in 
writing by Grass Valley.

A Grass Valley manual may have been revised to reflect changes made to the product 
during its manufacturing life. Thus, different versions of a manual may exist for any given 
product. Care should be taken to ensure that one obtains the proper manual version for a 
specific product serial number.

Information in this document is subject to change without notice and does not represent a 
commitment on the part of Grass Valley.

Warranty information is available from the Legal Terms and Conditions section of Grass 
Valley’s website (www.grassvalley.com).

Title Momentum Configuration Guide

Part Number Issue 1 Revision 1

Revision 2019-04-04, 09:43
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Notices
Important Safety Information
This section provides important safety guidelines for operators and service personnel. 
Specific warnings and cautions appear throughout the manual where they apply. Please 
read and follow this important information, especially those instructions related to the risk 
of electric shock or injury to persons.

Symbols and Their Meanings

Indicates that dangerous high voltage is present within the equipment 
enclosure that may be of sufficient magnitude to constitute a risk of electric 
shock. 

Indicates that the user, operator or service technician should refer to the product 
manuals for important operating, maintenance, or service instructions.

This is a prompt to note the fuse rating when replacing fuses. The fuse 
referenced in the text must be replaced with one having the ratings indicated.

Identifies a protective grounding terminal which must be connected to earth 
ground prior to making any other equipment connections.

Identifies an external protective grounding terminal which may be connected to 
earth ground as a supplement to an internal grounding terminal. 

Indicates that static sensitive components are present, which may be damaged 
by electrostatic discharge. Use anti-static procedures, equipment and surfaces 
during servicing.

Indicates that the equipment has more than one power supply cord, and that all 
power supply cords must be disconnected before servicing to avoid electric 
shock.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Underwriters Laboratory 
(UL) regulations and recommendations for USA.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Canadian Standard 
Association (CSA) regulations and recommendations for USA/Canada.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Underwriters Laboratory 
(UL) regulations and recommendations for USA/Canada.
iv
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Warnings
A warning indicates a possible hazard to personnel, which may cause injury or 
death. Observe the following general warnings when using or working on this 
equipment:

• Appropriately listed/certified mains supply power cords must be used for the 
connection of the equipment to the rated mains voltage.

• This product relies on the building's installation for short-circuit (over-current) 
protection. Ensure that a fuse or circuit breaker for the rated mains voltage is used on 
the phase conductors.

• Any instructions in this manual that require opening the equipment cover or enclosure 
are for use by qualified service personnel only.

• Do not operate the equipment in wet or damp conditions.
• This equipment is grounded through the grounding conductor of the power cords. To 

avoid electrical shock, plug the power cords into a properly wired receptacle before 
connecting the equipment inputs or outputs.

• Route power cords and other cables so they are not likely to be damaged. Properly 
support heavy cable bundles to avoid connector damage.

• Disconnect power before cleaning the equipment. Do not use liquid or aerosol 
cleaners; use only a damp cloth.

• Dangerous voltages may exist at several points in this equipment. To avoid injury, do 
not touch exposed connections and components while power is on.

• High leakage current may be present. Earth connection of product is essential before 
connecting power. 

• Prior to servicing, remove jewelry such as rings, watches, and other metallic objects.
• To avoid fire hazard, use only the fuse type and rating specified in the service 

instructions for this product, or on the equipment.
• To avoid explosion, do not operate this equipment in an explosive atmosphere.
• Use proper lift points. Do not use door latches to lift or move equipment.
• Avoid mechanical hazards. Allow all rotating devices to come to a stop before servicing.
• Have qualified service personnel perform safety checks after any service.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Intertek Testing Services 
regulations and recommendations for USA/Canada.

The presence of this symbol in or on Grass Valley product means that it complies 
with all applicable European Union (CE) directives.

The presence of this symbol in or on Grass Valley product means that it complies 
with safety of laser product applicable standards.
v
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Cautions
A caution indicates a possible hazard to equipment that could result in equipment 
damage. Observe the following cautions when operating or working on this 
equipment:

• This equipment is meant to be installed in a restricted access location.
• When installing this equipment, do not attach the power cord to building surfaces.
• Products that have no on/off switch, and use an external power supply must be 

installed in proximity to a main power outlet that is easily accessible.
• Use the correct voltage setting. If this product lacks auto-ranging power supplies, 

before applying power ensure that each power supply is set to match the power 
source.

• Provide proper ventilation. To prevent product overheating, provide equipment 
ventilation in accordance with the installation instructions.

• Do not operate with suspected equipment failure. If you suspect product damage or 
equipment failure, have the equipment inspected by qualified service personnel. 

• To reduce the risk of electric shock, do not perform any servicing other than that 
contained in the operating instructions unless you are qualified to do so. Refer all 
servicing to qualified service personnel. 

• This unit may have more than one power supply cord.  Disconnect all power supply 
cords before servicing to avoid electric shock.

• Follow static precautions at all times when handling this equipment. Servicing should 
be done in a static-free environment.

• To reduce the risk of electric shock, plug each power supply cord into separate branch 
circuits employing separate service grounds.

Electrostatic Discharge (ESD) Protection
Electrostatic discharge occurs when electronic components are improperly 
handled and can result in intermittent failure or complete damage adversely 
affecting an electrical circuit. When you remove and replace any card from a frame 

always follow ESD-prevention procedures:
• Ensure that the frame is electrically connected to earth ground through the power cord 

or any other means if available.
• Wear an ESD wrist strap ensuring that it makes good skin contact. Connect the 

grounding clip to an unpainted surface of the chassis frame to safely ground unwanted 
ESD voltages. If no wrist strap is available, ground yourself by touching the unpainted 
metal part of the chassis.

• For safety, periodically check the resistance value of the antistatic strap, which should 
be between 1 and 10 megohms.

• When temporarily storing a card make sure it is placed in an ESD bag.
• Cards in an earth grounded metal frame or casing do not require any special ESD 

protection.
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Battery Handling
This product may include a backup battery. There is a danger of explosion if the 
battery is replaced incorrectly. Replace the battery only with the same or equivalent 
type recommended by the manufacturer. Dispose of used batteries according to 

the manufacturer’s instructions. Before disposing of your Grass Valley equipment, please 
review the Disposal and Recycling Information at:

 http://www.grassvalley.com/assets/media/5692/Take-Back_Instructions.pdf

Cautions for LCD and TFT Displays
Excessive usage may harm your vision. Rest for 10 minutes for every 30 minutes of 
usage.

If the LCD or TFT glass is broken, handle glass fragments with care when disposing 
of them. If any fluid leaks out of a damaged glass cell, be careful not to get the liquid crystal 
fluid in your mouth or skin. If the liquid crystal touches your skin or clothes, wash it off 
immediately using soap and water. Never swallow the fluid. The toxicity is extremely low 
but caution should be exercised at all times.

Environmental Information

European (CE) WEEE directive.

This symbol on the product(s) means that at the end of life disposal it should not be mixed 
with general waste.

Visit www.grassvalley.com for recycling information.

Grass Valley believes this environmental information to be correct but cannot guarantee its 
completeness or accuracy since it is based on data received from sources outside our 
company.  All specifications are subject to change without notice.

If you have questions about Grass Valley environmental and social involvement (WEEE, 
RoHS, REACH, etc.), please contact us at environment@grassvalley.com .

On Receipt of the Momentum System
Any equipment is supplied in dedicated packaging provided by the manufacturer and 
should not be accepted if delivered in inferior or unauthorized materials.
vii
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Notices
Carefully unpack the system components and check them against the packing list. 
If there is anything incorrect notify your Grass Valley Partner, or Grass Valley, at once.
Check that the equipment has not been damaged in transit. If any damage has occurred 
notify your Grass Valley Partner (or Grass Valley directly) and the carrier immediately.
Always retain the original packing materials if possible, they could prove useful should it 
ever be necessary to transport or ship the system units.

Always read the Installation Guide, Configuration Guide and the Operator’s Guide (separate 
manuals) carefully, it will provide you with helpful hints and tips about care and 
maintenance and help you get the most out of your Momentum system.

In the unlikely event of an equipment failure, contact your Grass Valley Partner, or Grass 
Valley, at once, contact details are at the rear of this manual.
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Introduction
Overview
Welcome to Momentum!

Momentum is a powerful, media asset management and workflow automation system, 
designed to suit the requirements of leading media organizations. An incredibly flexible, 
enterprise level system, Momentum features fully configurable workflows, detailed process 
reporting and extensive integration with third party applications and platforms, enabling 
you to take complete control of your media assets, operations and business processes.

Based on service-oriented architecture (SOA), Momentum provides access to your business 
processes through the Internet or the company intranet - supplying an extensive suite of 
tools for different stages of the production process.

Momentum maintains and tracks your media assets in an Oracle database, makes them 
searchable, augments them with rich metadata, manages various job queues, controls 
archive and other third party devices, and enables assets to be ingested and exported in a 
number of different formats.

Fig. 1-1:  Example Momentum Workflow Page
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Most of these operations take place through managed workflows, in which you can define 
when and how a new or existing asset requires additional automated or manual processing 
to meet your needs. Powerful workflow modeling tools provide the building blocks to 
manage media assets on the Momentum Workflow page, a canvas on which your business 
processes are represented as a series of interconnected and easy-to-use schematic 
diagrams. Using the workflow functions, you can design and implement your workflows 
and the desired processing paths for the different media asset files. In addition, you can also 
monitor and analyze the progress of running processes and any associated tasks. As a file-
based solution, Momentum is designed to deliver content to a range of targets including 
social media and video on demand (VOD) sites.

In summary, Momentum enables you to:
• Automate the processing of content through reliable and repeatable workflows.
• Deliver content to a range of platforms including social media and VOD applications.
• Extend your organization's capability as operations grow through configurable 

workflows and resource pooling.

Momentum Key Features
Momentum supports the following features:

• User configurable workflows with support for scripting in C#, Python, IronPython and 
Visual Basic.

• HTML5-based user interface for web browser access to a multi-user environment for 
media-file cataloging and faster content distribution.

• Automated media file ingest and delivery using watch folders, standard file transfer 
protocols, and proprietary applications Signiant and Aspera.

• Automated metadata ingest using watch folders, BXF messaging and other third party 
system integrations.

• Video and audio editing using the built-in editor or other integrated SAM editors.
• Desktop proxy browsing, including automated generation of proxy files.
• Integration with a wide range of third party, automated quality checking, transcoding 

and archive devices.
• Integration with other SAM products such as the Go! Video Timeline Editor, sQ Suite 

and Morpheus Playout Automation.
• Configurable metadata publishing templates for delivery to linear playout and non-

linear delivery platforms.
• Web Services API for third party integration.
• Oracle 12c (12.1.0.2.0) database clustering.
• Support for Microsoft Windows 2012 with IIS for dual redundancy and user load 

balancing.
• Reporting and statistical analysis to understand processes and improve capacity 

planning.
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This guide describes how to configure a Momentum system using the administrative 
functions in combination with the XML configuration files. For information on using 
Momentum and creating workflows, refer to the Momentum Operator’s Guide.
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Essential Momentum Configurations
Introduction
Before using Momentum, it is essential to perform some basic configuration in order to 
access the Momentum web interface and perform workflow activities. 

The configuration procedure includes the following tasks:
• Configuring the Momentum License, on page 9.
• Configuring the Location of Media Files, on page 9.
• Configuring the Database Connections, on page 9.
• Configuring the Momentum Web Options, on page 10.
• Configuring the Generic Momentum Server Parameters, on page 13.
• Configuring the Alert System for Workflow Elements, on page 21.
• Configuring the Momentum Farm, on page 22.
• Configuring the Momentum Watchfolder server, see Configuring Watchfolders for File 

Ingest, on page 51.

It is also necessary to configure the following XML files located in the directory 
C:\Mantrics

• FileBasicInfo.xml

• DBConfiguration.xml

• MantricsConfig.xml

• MantricsServer.xml

• MantricsNode.xml

When the basic configuration is complete, navigate to the window Control Panel > System 
and Security > Administrative Tools > Services and start the following Momentum 
manual services:

• Momentum Server
• Momentum Node
• Momentum RLM License Server
• Momentum WatchFolder

You might also need to start other manual services if available (for example, BXF Receiver, 
Etere Receiver, etc.) depending on the modules and third-party products included in your 
system.
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Overview of XML Configuration Files
Momentum includes a suite of XML files used to configure the system before you can start 
configuring workflow elements and workflows in the user interface. These configuration 
files enable you to set-up licensing, communications between server and nodes, specific 
configurations for third party devices, etc. The XML files are available in the default 
installation folder:

XML File Description

Folder: C:\Mantrics

AudioTrackLanguages.xml Defines the languages and labels supported for audio tracks.

AuthenticationConfig.xml [1] Provides authentication data to connect to an LDAP server 
for the bulk import of users from a Microsoft Windows 
environment.

BxfDeleteMessagesGeneratorConfig.xml Defines the parameters passed to the 
BxfDeleteMessagesGenerator executable, which generates a 
BXF message to trigger a workflow to remove BXF messages.

DBConfiguration.xml Provides authentication data to connect to the Momentum 
database.

DivaConfig.xml Defines Diva error codes and associated descriptions that 
may be generated by a DivArchive archiving system.

EtereXMLReceiverConfig.xml Defines the communication parameters for an Etere Receiver 
node. 

FFMpegFramerateConfig.xml [1] Defines the source frame rates that can be selected when 
configuring the default Momentum FFmpeg transcoder 
workflow element.

FileBasicInfo.xml Defines fundamental information to allow the Momentum 
file basic information reader to analyze the metadata in 
source media files to retrieve structural information (e.g., 
timecode in, duration, width, height, framerate, etc.)

HooksConfig.xml Provides parameters to display the task notification panel.

IceConfig.xml Defines authentication parameters to enable additional 
devices to communicate with Momentum using the 
Morpheus API (including Morpheus server, Omneon Server, 
sQ Devices, etc.) This file is also used to enable the 
simultaneous, dual-review of material, available on two 
different Omneon Server ports, in the Momentum Logger 
page using a Morpheus API.

InstanceLabelsConfig.xml Defines the instance labels for the various supported media 
types that can be selected when configuring workflow 
elements (e.g., HQ, AUX, AUDIO, ORIGINAL, etc.)

LicenseConfig.xml Defines the hostname and port of the Momentum license 
server.
6
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MantricsConfig.xml General configuration data for the Momentum system, 
including the configuration of ingest parameters, auxiliary 
files, accessible folders, date formats, storage map, etc.

MantricsNode.xml Defines the node-side parameters to communicate with 
connected Momentum nodes, including transcoder and QC 
devices, thumbnail generator utility, MXF utilities, additional 
workflow element nodes, social media nodes.

MantricsOwnerConfig.xml Defines Owner IDs used for BXF message communication 
with a Morpheus system.

MantricsResourceConfig.xml Defines the maximum tasks that can be processed on 
Momentum nodes.

MantricsServer.xml Defines the server-side parameters to enable nodes to 
communicate with the Momentum server, including 
transcoder and QC devices, thumbnail generator utility, MXF 
utilities, additional workflow elements, social media sites.

MetadataChangeNotifierConfig.xml Defines the settings of the Metadata Change Notifier, a 
tool that can trigger a workflow as a result of a change to 
metadata.

MorpheusServerConfig.xml [1] Defines the communication parameters for a Morpheus 
Playout Automation system, including hostname and port, 
SMTP authentication parameters, synchronization 
parameters, etc.

queries.xml Defines parameters to allow users to save queries defined in 
the Catalog and Logger Pages and in the Material Browser 
pane of the Editing page.

SchedulesConfig.xml Defines the channel names and IDs used in the playout 
schedule.

SchedulesReceiverConfig.xml Defines the location in which a Morpheus system saves 
schedule files for import into Momentum.

SegmentsConsolidatorConfig.xml Defines parameters for third party segment consolidator 
devices.

ServerCommandsConfig.xml Defines default values for the ServerCommands host and 
port used to direct user notifications to the correct web 
page.

TransferRequestsConfig.xml Defines parameters to enable the communication of transfer 
requests between a Morpheus Playout Automation system 
and Momentum.

WatchFolderServerConfig.xml Defines parameters on the Watchfolder server.

XML File Description
7
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WebHooksRouter.xml Defines communication parameters and credentials used by 
the Momentum Web application to start the HooksRouter 
service and to allow WebHooksRouter to get the relevant 
information about the certificate. For more information, see:
https://nodejs.org/api/

tls.html#tls_tls_createserver_options_secureco

nnectionlistener

Folder: C:\Mantrics\BxfExportTemplates

Default.xml
Default template for the generation of BXF Export 
messages.

Folder: C:\Mantrics\BxfQueryTemplates

Default.xml
Default template for the generation of BXF Query 
messages.

Folder: C:\Mantrics\BxfReceiverTemplates

Default.xml
Default template for the generation of BXF Receiver 
messages.

Folder: C:\Mantrics\BxfTransferMetadataRetriever Templates

Default.xml
Default template for the extraction of metadata from BXF 
Transfer Request messages.

Folder: C:\Mantrics\ExportTemplates\TransferRequests

MissingMaterials.xml
Default XML template for schedule missing materials 
report.

MissingMaterials.csv
Default CSV template for schedule missing materials 
report.

Folder: C:\Mantrics\MaterialCheckerTemplates\

MaterialCheckerTemmplate.xml
Default XML template for schedule missing materials 
report.

Folder: C:\Mantrics\MetadataPublisherTemplates

DemoTXT.txt Default 

DemoXML.xml Default 

KeySegment.xml

Folder: C:\Mantrics\WatchfolderTemplates

WatchfolderDefault.xml Default 

XML File Description
8
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Configuring the Momentum License
To configure the license:

1 Navigate to the directory C:\Mantrics and open the file LicenseConfig.xml using a 
text editor. The file contains the following element:
<LicenseConfig>

<LicenseServer>2764@localhost</LicenseServer>
</LicenseConfig>

2 Replace the word localhost in the node <LicenseServer> with the name or IP 
address of the Momentum license server (the machine where the dongle is connected 
and the file license.lic is stored).

3 Save the file LicenseConfig.xml to store the setting.

Configuring the Location of Media Files
To set the location of media files for ingest:

1 Navigate to the directory C:\Mantrics and open the file MantricsConfig.xml using a 
text editor.

2 In the section <IngestRootDirs>, insert the path(s) to the location of the media files. 
For example:
<IngestRootDirs>

<IngestRootDir>\\hostname\folder</IngestRootDir>
</IngestRootDirs>

3 Save the file MantricsConfig.xml to store the locations.
For further information on the <IngestConfig> and <AuxConfig> sections of 
MantricsConfig.xml, see Section  Defining the Ingest Configuration on page 53

Configuring the Database Connections
The Momentum server must be connected to at least one database. Each database can 
support more than one Momentum server. The database connection settings are set in the 
file:

C:\Mantrics\DBConfiguration.xml.

To configure the database connection:
1 Navigate to the directory C:\Mantrics and open the file DBConfiguration.xml using 

a text editor.
In the section <DbConfiguration>, set the user name <user>, the password 
<password> and the instance of the database connection <addressname>. 

Note: The prefix 2764@  must not be modified or replaced.

Note: Both UNC and local paths are supported. It is also possible to use the IP 
address instead of the server hostname.
9
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The default values for this section are as follows:
<DBCconfiguration xmlns:xsi=”http://www.w3.org/2001/XMLSchema-
instance” xmlns:xsd=”http://www.w3.org/2001/XMLSchema”>

<user>MOMENTUMDB</user>
<password>momentumdb</password>
<addressname>orcl</addressname>

</DBConfiguration>

2 Save the file DBConfiguration.xml to store the settings.
3 Select Control Panel > System and Security > Administrative Tools > Services to 

open the Services window and restart the IIS Admin Service.

Configuring the Momentum Web Options
To configure the Momentum Web module, you will need to know the following information 
in advance:

• Name or IP address of the Momentum Server host machine.
• Path to the directory where Momentum stores temporary files for the creation of the 

Edit Decision Lists (EDLs).
• Paths for mapping the storage location of the Mist streaming server (if installed).

The file MantricsConfig.xml contains the main configuration data. Additional 
configuration is described in the subsequent sections.

Configuring the Momentum Server in MantricsConfig.xml

To configure the Momentum server details:
1 Navigate to the directory C:\Mantrics and open the file MantricsConfig.xml using a 

text editor.
2 In the tag <MantricsServer>, replace the default IP value with the IP address of the 

Momentum server.
3 In the tag <MantricsCatalogURL>, replace the placeholder localhost with the 

hostname of the Momentum server.
4 In the tag <IISAndServerAccessibleDirs><Dir>, insert the path to the folder where 

Momentum stores its temporary files.
<IISAndServerAccessibleDirs>

<Dir>c:\Temp</Dir>
</IISAndServerAccessibleDirs>

Note: By default, the database connection is set to the host details created 
during the installation of Oracle.

Note: Values used in the configuration file are case-sensitive.
10
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5 Set the tag <CatalogShowAllMetadata> to true (default) to display all metadata in 
the Catalog page. Alternatively, set to false to display only a limited subset of 
metadata.

6 Set the tag <DefaultToDoViewType> to the materials view (default) to use a 
materials-based search for tasks in the To Do page. Alternatively, set to tasks to display 
a tasks-based view where you can filter available tasks by Material ID in the To Do page.

7 Save the file MantricsConfig.xml to store the new settings.

Configuring the Date and Time
The Momentum system uses references to Date and Time values in several places. The file 
MantricsConfig.xml enables you to customize these settings as follows:

1 Navigate to the directory C:\Mantrics directory and open the file 
MantricsConfig.xml using a text editor.

2 Locate the tag <DateFormats>, which includes a link to information on additional date 
formats, if required.

3 A list of four date format tags is available by default, you can rearrange the elements of 
these formats to display the date and/or time as desired.
<DateFormats Comment="">

<Date>d/m/Y</Date>
<Date_And_Time>H:i d/m/Y</Date_And_Time>
<With_Seconds>H:i:s d/m/Y</With_Seconds>
<With_Milliseconds>H:i:s.u d/m/Y</With_Milliseconds>

</DateFormats>

Where i represents two digit minutes with leading zeros (e.g., 00 to 59) and s represents 
two digit seconds with leading zeros (e.g., 00 to 59).

4 Save the file MantricsConfig.xml to store the new settings.

Configuring the Key Segments
It can be useful to define a pattern for the ID or Title of the key segments. To set these rules, 
two specific tags are available in the file MantricsConfig.xml: 

<KeySegmentIdPattern/>
<KeySegmentTitlePattern></KeySegmentTitlePattern>

Both tags can accept as values: a system keyword (variables), a numeric sequence or a 
combination of both as in the following example: 

<KeySegmentIdPattern>{MATERIALID}-##</KeySegmentIdPattern>

Note: Ensure that the folder is shared and fully accessible from each machine 
that needs to be connected to the server using the Momentum Web 
interface.

Note: Adding parameters to a format is possible but it can have some 
unexpected results as any modification will affect all locations where 
Momentum applies the modified format.
11
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In the above example, the tag <KeySegmentIdPattern> is initialized using the 
variable {MATERIALID} value followed by a dash symbol (-) and a numeric sequence of 
two digits represented by the # characters.

Configuring the Mist Streaming Server
A Momentum installation includes a Mist streaming server which is installed in the 
directory C:\Mantrics\MistServer.

To activate the Mist Server:
1 Navigate to the directory C:\Mantrics and open the file MantricsConfig.xml file 

using a text editor.
2 Locate the tag <MistHost> and replace the default IP value with the IP address of the 

machine currently running the Mist streaming server.

3 Save the file MantricsConfig.xml to store the new settings.

Configuration of Miscellaneous Features in MantricsConfig.xml
Configure the Storage Mappings, HooksRouter and NotifierPopUpLifeTIme in 
MantricsConfig.xml as follows:

1 Navigate to the directory C:\Mantrics and open the file MantricsConfig.xml file 
using a text editor.

2 Locate the section <StorageMap> and in the tag <FromUNC> enter the UNC path to 
the folder containing source files, for example QC reports.
For example:
<FromUNC>\\10.10.0.223\video</FromUNC>

3 In the <StorageMap> tag <ToURL>, enter a virtual folder as a web destination to map, 
enabling the review of the source files:
For example:

Note: When using the # character to specify a numeric sequence, the 
following rules apply:
One # represents an unlimited sequence.
Two or more ## characters implies the use of 0s for padding the number 
and that the sequence is limited to the greatest number possible using 
the number of digits specified by the number of # characters.

Note: You can also change the default value for the port, 8080, but we 
recommend avoiding the use of port 80 if the Mist server is running on 
the same machine as the IIS server.

Note: For more information about installing and configuring the Mist 
Streaming Server, see Chapter  Using a Mist Streaming Server.
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<ToURL>http://localhost/reports</ToURL>

4 Locate the section <HooksRouter> and set the IP address and port of the Hooks 
Router to allow access to the Hooks Router logs and dashboard using a web page.
For example:
<HooksRouter port="8081">127.0.0.1</HooksRouter>

5 Locate the section <NotifierPopUpLifeTime> and set the maximum time that the task 
notification pop-up can remain visible on the screen. Set a time limit in miliseconds 
(default is 20000 ms or 20 seconds) after which the Notifier Popup window will close.
For example:
<NotifierPopUpLifeTime>20000</NotifierPopUpLifeTime>

Configuring the Ingest Parameters in MantricsConfig.xml
See Chapter  Configuring the Ingest Elements on page 163 for details.

Configuring the Generic Momentum Server Parameters
The configuration file MantricsServer.xml is subdivided into several sections, including 
the section <Generic>, which contains values and settings used by various generic 
elements of the Momentum system as shown below:

<Generic>
<commandPort>9000</commandPort>
<MistAPIUrl>http://10.10.0.10:4242/api</MistAPIUrl>
<MistUsername>admin</MistUsername>
<MistPassword>password</MistPassword>
<DoNotRegisterAfterTranscode>true</DoNotRegisterAfterTranscode>
<WebHost>http://localhost/Momentum</WebHost>
<ThumbLx>100</ThumbLx>
<ThumbLy>75</ThumbLy>
<ThumbPath>\\10.10.0.221\Thumbnail\</ThumbPath>
<ThumbFullFrameSetAsIcon>true</ThumbFullFrameSetAsIcon>
<ThumbFullFrameFileName>{MATERIALID}_{INSTANCELABEL}

</ThumbFullFrameFileName>
<ThumbFullFramePath>\\10.10.0.221\Momentum_MEDIA\FULLFRAME

</ThumbFullFramePath>
<ThumbFullFrameSize>
   <SizeConditions />
</ThumbFullFrameSize>
<ThumbFullFrameExtension>jpg</ThumbFullFrameExtension>
<ThumbFullFrameStatusMetadata/>
<RecoverTimeIntervalInSec>30</RecoverTimeIntervalInSec>
<SNMPAgentAddress>127.0.0.1:161</SNMPAgentAddress>
<SNMPBroadcastAddress>10.10.255.255:162</SNMPBroadcastAddress>
<SNMPSendMomentumTrap>false</SNMPSendMomentumTrap>
<ServerCommands port="9004">127.0.0.1</ServerCommands>
<ServerHooksRouter port="9002">127.0.0.1</ServerHooksRouter>
<sQZonesList>
<sQzone ISAManagerPort="2096" ISAManagerIP2="127.0.0.1"

ISAManagerIP1="10.250.170.100" zoneId="1090" zoneName="Newbury
Broadcast Centre"/>

<sQzone zoneName="Mantrics Zone NTSC" zoneId="1401"
13
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   ISAManagerIP1="10.10.5.45" ISAManagerIP2="10.10.5.49"
   ISAManagerPort="2096" />

<sQzone zoneName="Mantrics Zone 1 NTSC" zoneId="1400"
   ISAManagerIP1="10.10.5.38" ISAManagerPort="2096" />
</sQZonesList>
<OmneonHostsList>
   <OmneonHost isSpectrum="false" isMediagrid="false"

OmneonServerAddressOrName=""  />
</OmneonHostsList>
<jobHistoryCleanup>

<maximumJobDeletionStep>50</maximumJobDeletionStep>
<clearHistoryTimeIntervalInMin>5

</clearHistoryTimeIntervalInMin>
<enabled>false</enabled>

</jobHistoryCleanup>
</Generic>

Configure the Generic server tags to grant the Momentum nodes access to a Mist 
streaming server, sQ Zone, or an Omneon server and set Thumbnail and SNMP parameters 
as follows:

Configuring the Momentum Server Command Port 
• Set the tag <commandPort> to the port used by the Momentum server.

For example: <commandPort>9000</commandPort>

Configuring the Mist Streaming Server 
Configure communications between the Momentum Server and the Mist streaming server 
used by the various video players in the Momentum user interface as follows:

1 Set the tag <MistAPIUrl> value using the URL of the streaming server. 
The port value of 4242 is fixed and the path /api directs the nodes to the correct API to 
connect with the Mist Server.

2 Set the values for the tags <MistUsername> and <MistPassword> using the user and 
password required to access the Mist server application.

3 Set the tag <DoNotRegisterAfterTranscode> to true if you want to prevent 
Momentum from automatically registering the MP4 proxy on the Mist Server directly 
after transcoding.
Momentum registers the proxy file at the first attempt to display the proxy in the 
Catalog and/or Logger page.

Configuring the Web Host
• Set the tag <WebHost> to the path of the Momentum web server.

For example: <WebHost>http://<10.12.65.45>/Momentum</WebHost>
14
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Configuring Thumbnail Generation
Configure the generation of thumbnails as follows:

1 Set the tags <ThumbLx> and <ThumbLy> to specify the size of the created 
thumbnails. 
The parameters specified in the <ThumbGenerator> element override these settings.

2 Set the tag <ThumbPath> to the path to be used as root for storing the thumbnails. 
The specified folder contains a new folder for each title and a subfolder for each 
instance of the title. Each instance has its own thumbnails stored in a specific folder. 
The thumbnails are managed as children of the instance from which they are 
generated.

3 Set the tag <ThumbFullFrameSetAsIcon> to enable the use of the last full frame of 
the material saved as an icon. 
The accepted values are true or false.

4 Set the tag <ThumbFullFrameFileName> to the name used for the saved full frame 
file. 
You can use keywords and variables to make the allocated filename dynamic, for 
example:
<ThumbFullFrameFileName>{MATERIALID}-####</ThumbFullFrameFileName>

5 Set the tag <ThumbFullFramePath> to the path used to store the full frame files. 
You can use keywords and variables to use a dynamic path.

6 Set the tags <ThumbFullFrameSize> and <SizeConditions> to set the size conditions 
for exporting a full resolution image frame from the Player. 
The tag <SizeCondition> has the following attributes:

• var indicates which of the size parameters - width or height - must be validated 
against the rule.

• op is the size operation which can be either: Lesser, LesserOrEqual, Greater, 
GreaterOrEqual, Equal, or NotEqual.

• value is the value of the size condition against which the image is compared.
The tag <SizeCondition> includes the sub-tags <width> and <height> to 
populate with the desired height and width settings for the exported image. For 
example:
<ThumbFullFrameSize>
  <SizeConditions>
    <SizeCondition var="width" op="Equal" value="1920">
      <Width>1600</Width>
      <Height>900</Height>
    </SizeCondition>
    <SizeCondition var="width" op="NotEqual" value="1920">
      <Width>960</Width>
      <Height>540</Height>
    </SizeCondition>
  </SizeConditions>
</ThumbFullFrameSize>
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7 Set the tag <ThumbFullFrameStatusMetadata> to generate metadata that shows the 
status of the full frame creation saved from the Player on the Logger or Catalog page.
The permitted values are: 

• Requested
• Queued
• Processing
• Created
• Creation Failed.

8 Set the tag <ThumbFullFrameExtension> to select the desired file type extension for 
the full frame exported version of thumbnails.
You can select the following format: JPG.

Configuring SNMP Trap Communication
Configure SNMP traps as follows:

1 Set the tag <SNMPAgentAddress> to the IP address and port of the Momentum 
server which acts as the SNMP agent.
When the tag <SNMPSendMomentumTrap> is set to TRUE, the Momentum SNMP 
agent sends SNMP traps on the following events:

• Node registered successfully
• Node not successfully registered
• Node offline request
• Node offline complete
• Node online request
• Node online complete
• Node unreachable
• Node re-registered.

The management information base (MIB) file is located in the folder:
C:\Mantrics\MIB\Momentum-MIB.mib

2 Set the tag <SNMPBroadcastAddress> to the IP address and port of the SNMP 
network management system.

3 Set the tag <SNMPSendMomentumTrap> to TRUE to enable the Momentum SNMP 
agent to send SNMP traps. 
When set to the default, FALSE, the Momentum SNMP agent will not send SNMP traps.

Note: The order of <SizeCondition> tags is significant. If the first condition is 
true, its specified width and height are applied to the thumbnail, 
otherwise the second condition (if present) is analyzed and so on.
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Configuring User Notifications
Whenever a task is created on a User Action workflow element, a user notification is 
triggered to users having the role specified in the element.

A user notification is a popup message appearing for some seconds at the bottom right of 
the screen, irrespective of the Momentum page that is currently displayed. The notification 
popup contains the following elements:

• A link to the relevant WorkFlow element.
• A link to the relevant Catalog material.
• Either:

• A Take button, re-directing to the relevant ToDo task, or
• A list of Ports on the element through which the task could be propagated.

The Take option is the default setting. To enable the port listing, select 
Notification from the Task layout options in the settings of the UserAction 
workflow element, see Figure 2-2:

The user can work directly through the notification popup, or open the Notification Panel 
by clicking the notification panel icon  at the top-right of the screen, next to the name 
of the logged-in user.

The notification panel lists all unexpired notifications for all tasks in waiting status at the 
UserAction workflow elements:

Fig. 2-2: UserAction Settings menu - Selecting the Notification Task Layout
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Configure user notifications as follows:
1 Set the tag <ServerCommands> to the default values for the ServerCommands host 

and port used in the configuration file ServerCommandsConfig.xml to direct user 
notifications to the correct web page.

2 Set the tag <ServerHooksRouter> to the IP address and port of the Hooks Router to 
enable the Momentum tasks to progress correctly through the workflow and to direct 
user notifications to the correct web page.

Configuring the sQ Zone
sQ servers are configured into resilient production units, called Zones. An sQ Zone may be 
built of one or more sQ devices communicating by way of FileFlow, to provide scaling of 
ingest and output ports, bandwidth to support editing workstations and video storage 
capacity.

Fig. 2-3: User Action Notification Panel

Open Notification Panel Icon

User Action Manual Review 
Task Required

User Action Generating the 
Task Required

Button to Take Ownership of 
the Task

Button to Progress the Task 
to an Output Port
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A Zone is managed by a resilient management unit, referred to as an ISA Manager (ISA = 
Integrated Server Architecture), which is a Windows application running on a dedicated 
pair of resilient servers. Communications between ISA Managers ensures that users have 
access to all content across the sQ Zones.

Configure the sQ Zones to allow communication with the Momentum environment as 
follows:

1 Set the tag <sQZonesList> to include a list of available, remote sQ zones that contain 
ISA Managers.
The Momentum server uses a CORBA-based C++ library to communicate with sQ ISA 
Manager(s) by allowing multiple Momentum components to access the library 
functions and search for metadata in the sQ database for a given clip ID and zone ID. 

2 Set the tag <sQZone> to include the name of the sQ Zone, the sQ Zone ID and the IP 
address(es) and port(s) of the individual ISA Managers included in the sQ Zone. The tag 
<sQZone> has the following attributes:

• zoneName: Name of the sQ Zone.
• zoneID: sQ Zone identifier.
• ISAManagerIPn: IP address of an ISA Manager in the sQZone. Each ISA 

Manager controls a zone, which may include multiple SQ 
Servers. You can include several IP addresses but each 
must be numbered sequentially, for example: 
ISAManagerIP1, ISAManagerIP2, etc.

• ISAManagerPort: Communication port corresponding to the IP address of 
the ISA Manager.

Configuring Omneon Servers
Whenever Momentum sends a Keysegment, generated from a source clip, to Omneon 
Consolidator, the Omneon Consolidator workflow element checks the IP address of the 
source clip and target destination file against the Omneon server IP addresses specified in 

Fig. 2-4: Scalable sQ Zones
19



Essential Momentum Configurations
Configuring the Cleanup of Job History
the configuration. If the IP addresses match, then the Omneon Consolidator workflow 
element attempts to delegate to the remote Omneon Server to do the consolidation and 
transfer of essence data; the transfer is made internally by the remote Omneon Server as a 
local transfer between source and destination folders in the local Omneon storage.

Configure remote Omneon servers as follows:
1 Set the tag <OmneonHostsList> with the list of available, remote Omneon servers.

Momentum supports either:
• Omneon Spectrum server, or 
• Omneon Mediagrid Storage with the ContentBridge component.

2 Set the tag <OmneonHost> to include the IP address or hostname of the Omneon 
server. In addition, set the attributes isSpectrum or isMediagrid to True or False 
depending on the type of Omneon Server you are connecting.

Configuring the Cleanup of Job History
This function enables a Momentum cleanup agent to run in configurable time cycles at 
which it will automatically remove a configurable number of jobs from the job history of a 
Material.

This function can work together with the Clear History function in the settings of a 
Material Deletion workflow element, which, when enabled, will clear the associated job 
history on deletion of the material. For more information, see Section  Material Deletion on 
page 162.

This clean-up task avoids having to maintain the job history for a material that no loner 
exists on the system.

Configure the Job History cleanup agent as follows:
• Set the cleanup parameters in the section <jobHistoryCleanup> as follows:

• MaximumJobDeletionStep: Defines the maximum number of jobs 
deleted each time the Clear History agent 
runs to delete job history.

• clearHistoryTimeIntervalInMin: Defines the time interval (in minutes) that the 
agent will wait between job history clean-up 
cycles. If, in a cycle, the clean-up agent finds 
300 jobs to delete, for example, but the tag 
<maximumJobDeletionStep> is set to 100, 
then the agent will delete the first 100 jobs on 
that cycle and then the remaining 200 on 
subsequent cycles. The minimum time 
between cycles is 5 minutes. The value of this 
parameter helps to reduce the impact on the 
Momentum database.

• enabled: When set to true, activates the job history 
cleanup agent to allow the clean-up of 

Note: You can set only one of these attributes to True.
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associated job history on deletion of a 
material Title.

Configuring the Alert System for Workflow Elements
You can configure each element of a workflow to raise an alert if the tasks that are currently 
processing are taking longer than expected to complete. The alert system automatically 
sends an email to a specified address to signal that an unexpected event is occurring using 
the Simple Mail Transfer Protocol (SMTP).

To configure the alert system, modify the <Alarms> tag in the configuration file 
MantricsServer.xml as follows:

<Alarms>
<SmtpServer>10.10.0.225</SmtpServer>
<SmtpUser>mailtest@mail.local</SmtpUser>
<SmtpPwd>example password</SmtpPwd>
<SmtpSSL>false</SmtpSSL>
<SmtpAuthenticate>false</SmtpAuthenticate>
<taskProcesingThreshold>

<Recipients>support@momentum.com</Recipients>
<AlarmSubject>Task threshold Alarm</AlarmSubject>
<AlarmMessage>The task taskId = '{TASKID}' has exceeded the

 time processing threshold. MaterialId =
 '{MATERIALID}'. 
Filename = '{FULLMEDIA;PATH}'</AlarmMessage>

<TimeNotificationInterval>5</TimeNotificationInterval>
</taskProcesingThreshold>

</Alarms>

To activate this feature for a workflow element, first double-click the element and open the 
Setting dialog. Select the Statistics tab from the left-hand menu and check the Active 
Alerts checkbox.

The Alerts group of tags specifies the account access configuration for the SMTP server and 
define alert thresholds and email details as follows:

• <SmtpServer>: Sets the IP address of the SMTP server.
• <SmtpUser>: Specifies the user to log on the SMTP server.
• <SmtpPwd>: Specifies the password used by the <SmtpUser>.
• <SmtpSSL>: Specifies whether the SSL protocol is active or not and 

can be set to true or false.
• <SmtpAuthenticate>: Specifies whether the authentication of the SSL 

protocol is active or not, possible values are true or 
false.

• <taskProcesingThreshold>: Collects all the parameters needed to compose the 
email message sent by the alert system. The alert is 
raised when the processing of a task on a specific 
element of the workflow exceeds the expected time 
span of the task.

• <Recipients>: Collects the email address target for the alert (there 
can be multiple addresses, comma separated).
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• <AlarmSubject>: Specifies the content of the Subject field in the sent 
email.

• <AlarmMessage>: Defines the content of the Body field of the sent 
email. System variables can be used to create 
messages for specific task properties. In the above 
example, the values {TASKID}, {MATERIALID}, and 
{FULLMEDIAPATH} are variables related to a task that 
is being processed and taking more time than 
expected. 

• <TimeNotificationInterval>: Specifies the time span in minutes to wait between 
sending two consecutive emails. The emails are sent 
when a task crosses the threshold time set, until the 
task is managed.

Configuring the Momentum Farm
Momentum is based on a Server-Node configuration where a node is a service or system 
with which Momentum is permitted to communicate and manage, for example, Alchemist 
XF, Omneon Consolidator, DivArchive, etc.) The server accepts connections from the nodes 
and, when registering on the server, the node provides information including:

• the tasks that the node can manage
• the available resources
• the node’s status within a pool of nodes.

The server manages the job distribution to optimize the use of available resources. There is 
no software limitation to the number of nodes that can be managed by a server. The 
combination of server and nodes is referred to as the Momentum Farm.

To set up the communication channels between the server and associated nodes, the 
appropriate parameters must be initialized in both dedicated configuration files: 

• MantricsServer.xml

• MantricsNode.xml

These two configuration files contain similar lists of sections, which correspond to the 
various nodes with which the Momentum server must communicate. A section is a custom 
XML tag that groups together one or more specific parameter tags having a similar 
function. 

The configuration file MantricsServer.xml is composed of the following main sections:
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Each section contains the configuration parameters for the following server-side 
components:

• <tsc>: Configuration of the transcoder engines.
• <qcc>: Configuration of the quality check applications.
• <mxfc>: Configuration of the MXF communication parameters.
• <usc>: Configuration of server utility, the Thumbnail Generator.
• <wfc>: Configuration of the settings of the workflow elements 

implemented in the Momentum workflow page.
• <scl>: Configuration to publish material to the social media sites 

Facebook, Twitter, etc.
• <Generic>: Configuration of the generic Momentum components, including 

the Mist streaming server, SNMP traps, sQ Zones and Omneon 
servers.

• <Alarms>: Configuration of the alerting system for the workflow elements 
implemented in the Momentum workflow page.

The configuration file MantricsNode.xml is composed of the following main sections:

Each section contains the configuration parameters for the following node-side 
components:

• <transcoderNodeConfig>: Configuration of the transcoder engine nodes.
• <qcNodeConfig>: Configuration of the quality check nodes
• <utilsNodeConfig>: Configuration of the Thumbnail Generator utility 

node.
• <MXFUtilsNodeConfig>: Configuration of the MXF feature parameters.

Fig. 2-5: XML Sections in the Configuration File MomentumServer.xml

Fig. 2-6: XML Sections in the Configuration File MantricsNode.xml
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• <workflowNodeConfig>: Configuration of the settings of the workflow 
elements implemented in the Momentum workflow 
page.

• <socialNodeConfig>: Configuration to publish material to the social media 
sites Facebook,  Twitter, etc.

To complete the set-up of a specific section, see the related paragraph in Chapter  
Configuring Additional Momentum Features.

Momentum includes two dedicated applications that you can use to configure the 
Momentum Farm, avoiding having to edit XML files directly: 

• Momentum Server Configurator
• Momentum Node Configurator

For further information, see the section Using the Momentum Configuration Tools, on 
page 26.

Configuring the Basic Server Settings
To configure the basic settings of a server XML section:

1 Navigate to the directory C:\Mantrics and open the file MantricsServer.xml using a 
text editor.

2 Locate the section to configure, identified by its appropriate section tag, for example: 
consider the FFmpeg transcoder <ffmpeg>:
<ffmpeg>

<server port="XXXX">0.0.0.0</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</ffmpeg>

3 Use the tag <server port=""> to set the port required for communication between the 
server and the node. 
By default, the attribute port="XXXX" is the same in the corresponding sections of the 
files MantricsServer.xml and MantricsNode.xml. If a change is required, remember 
to modify both files in the same way. Momentum uses the IP configuration to monitor 
incoming traffic from every valid IP address.

4 Use the tag <policy> to set the processing policy for that type of node. There are two 
available values: Failover and Weighted.

• Failover: Allows the Momentum server to use a single node as the main 
processor. In the event that the main node fails, the Momentum 
server automatically uses the second node as the main processor 
creating the same queue of tasks as on the failing node.

• Weighted: Allows the Momentum Server to use all available nodes. The Pool 
feature creates a pool of servers, which are loaded through the 
configuration of the workflow element to enable selective 
loading.
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5 Use the tag <retryCount> to set the number of retries that the Momentum Server can 
perform in order to establish that a node is available.

6 Use the tag <active> to set the server status. There are two available values:
• True - the Momentum server is ready to register a Momentum node of that type, in 

this example, an FFmpeg transcoder.
• False - the Momentum server ignores all of the possible node’s connection 

attempts.
7 The tag <reconnectRetryCount> sets the number of times that the Momentum server 

can try to establish whether a node is active and reachable after losing the connection. 
8 The tag <reconnectTimeout> sets the delay between two consecutive connection 

attempts if the <reconnectRetryCount> value is greater than 1.

Configuring Base Node Settings
To configure the base settings of a node XML section:

1 Navigate to the directory C:\Mantrics and open the file MantricsNode.xml using a 
text editor.

2 Locate the section to configure identified by the appropriate section tag, for example: 
<rhozet>:
<rhozet slotCount="xx">

<active>false</active>

<server port="XXXX">127.0.0.1</server>

<node port="XXXX">127.0.0.1</node>

<pool />

<rhozetNode port="xxxx">0.0.0.0</rhozetNode>

<rhozetNode_descr>Node_Description</rhozetNode_descr>

</rhozet>

3 The attribute slotCount defines the number of slots available for processing tasks. 
If the Momentum node is installed on a third party application, it is recommended to 
set the same number of slots.

4 Use the tag <active> to set the node status. There are two available values:
• True: The Momentum node is active and, once started, is registered to the 

Momentum server.
• False: The Momentum node is not active and does not try to connect to the 

server.
5 Use the tag <server port> to define the port number used for communication 

between Server and Node. 
Enter the name or the IP address of the machine where the server is installed. By 
default, the attributes port="XXXX" are the same in the corresponding sections of the 

Note: The slotCount value is a way of measuring the number of analogous 
tasks that can be simultaneously started on a node. This value can 
increase depending on the number of physical resources available.
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configuration files MantricsServer.xml and MantricsNode.xml. If a change is 
required, remember to modify both files in the same way.

6 Use the tag <node port> to define the port number used to communicate between 
server and node. Enter the hostname or the IP address of the machine on which the 
node is installed.

7 Use the tag <pool> to assign the node to a specific pool to balance processing.

8 Use the tag <...Node_descr> (e.g., <rhozetNode_descr>) to define a descriptive label 
for the node. This label enables Momentum to identify the specific node.

Using the Momentum Configuration Tools
To help configure the various Momentum features and any third party transcoders and 
modules, two dedicated applications are provided: the Momentum Server Configurator 
and the Momentum Node Configurator. These applications remove the need to open and 
manually edit the XML configuration files.

Using the Momentum Server Configurator
The Momentum Server Configurator populates the file MantricsServer.xml. Start the 
Momentum Server Configurator application as follows:

1 Navigate to the directory: C:\ProgramFiles\Mantrics S.r.L\Momentum Server.
2 Run the file MantricsServerConfig.exe.

The Server Configurator opens as follows:

Note: The pool value acts as a label to identify a subset or pool of nodes. 
Setting the pool parameter of a workflow element to a chosen value 
limits the server to selecting only the nodes with the same pool value in 
order to perform the task initiated by the workflow element.
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The panel includes the following tabs, corresponding to the main sections of the 
MantricsServer.xml file:

• Alarms: Use to configure the automatic alert system for workflow 
elements and corresponds to the section <Alarms> of 
MantricsServer.xml

• Generic: Use to configure the section <Generic> of the file 
MantricsServer.xml.

• MXF: Use to configure the MXF feature parameters and corresponds to 
the section <mxfc> of MantricsServer.xml.

• QC: Use to configure the settings of the quality check devices 
supported by Momentum and corresponds to the section <qcc> 
of MantricsServer.xml.

• Social: Use to configure the settings for publishing material to, or 
removing material from the social media sites Facebook and 
Twitter and corresponds to the section <scl> of 
MantricsServer.xml.

• Transcoder: Use to configure the settings of the transcoding engines 
supported by Momentum and corresponds to the section 
<Alarms> of MantricsServer.xml.

• Utils: Use to configure the Thumbnail Generator and corresponds to 
the section <usc> of MantricsServer.xml.

Fig. 2-7:  Momentum Server Configurator
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• Workflow: Use to configure the settings of the workflow elements 
implemented in the Momentum workflow page and corresponds 
to the section <wfc> of MantricsServer.xml.

Each of these tabs, when active, shows one or more sub-tabs in the main area, for each 
option available.

The main area is subdivided into two panels (Basic and Specific) as follows:
• Base: Enables you to configure the base settings of the corresponding 

Server section. For further information about the base server 
settings see section  ’Configuring the Basic Server Settings’ on 
page 24.

• Specific: Enables you to configure the specific settings of the 
corresponding Server section. For further information about the 
specific settings of a Server section see Configuring Additional 
Momentum Features.

Modifying the Server Settings
To modify the settings of a server section:

1 Select the appropriate tab and, if required, the appropriate sub-tab.
2 Modify the settings in the Base and/or Specific areas.
3 Click Close.
4 When prompted to save the new configuration, click the Yes button to save the 

configuration changes to the modified file.

Using the Momentum Node Configurator
This application populates the file MantricsNode.xml. Start the Momentum Node 
Configurator application as follows:

1 Navigate to the directory: C:\Program Files\Mantrics S.r.L\Momentum Node.
2 Run the file MantricsNodeConfig.exe 

The Momentum Node Configurator opens as follows:
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The panel includes the following tabs corresponding to the main sections of the file 
MantricsNode.xml:

• MXF: Use to configure the MXF feature parameters and corresponds to 
the section <MXFUtilsNodeConfig> of MantricsNode.xml.

• QC: Use to configure the settings of the quality check devices 
supported by Momentum and corresponds to the section 
<qcNodeConfig> of MantricsNode.xml.

• Social: Use to configure the settings for publishing material to or 
removing material from the social media sites Facebook and 
Twitter and corresponds to the section <socialNodeConfig> of 
MantricsNode.xml.

• Transcoder: Use to configure the settings of the transcoding engines 
supported by Momentum and corresponds to the section 
<transcoderNodeConfig> of MantricsNode.xml.

• Utils: Use to configure the Thumbnail Generator and corresponds to 
the section <utilsNodeConfig> of MantricsNode.xml.

• Workflow: Use to configure the settings of the workflow elements 
implemented in the Momentum workflow page and corresponds 
to the section <workflowNodeConfig> of MantricsNode.xml.

Each of these tabs, when active, shows one or more sub-tabs in the main area, for each 
option available.

The main area is subdivided into two panels (Base and Specific) as follows:
• Base: Enables you to edit the base settings of the corresponding Node 

section. For further information about the base node settings, see 
Configuring Base Node Settings, on page 25.

Fig. 2-8:  Momentum Node Configurator
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• Specific: Enables you to edit the specific settings of the corresponding 
Node section. For further information about the specific node 
settings, see Chapter  Configuring Additional Momentum Features.

Modifying the Node Settings
To modify the settings of a Node section:

1 Select the appropriate tab and, if required, the appropriate sub-tab.
2 Modify the settings in the Base and/or Specific areas.
3 Click Close.
4 When prompted to save the new configuration, click Yes to save the configuration 

changes to the modified file.

Using the Database Update Tool
On occasion, the Momentum software may require an update to the structure of the 
database to enable new features. To accomplish this task, use the Database Update Tool: 
MDBVersionTool.exe.

Once started, the MDBVersionTool, connects automatically to the Oracle database server 
using the parameters in the DBConfiguration.xml file.

The interface of the MDBVersionTool consists of one panel, containing the following items:
• DBUser field - reports the name of the connected user.
• Text filter, Field filter, Customer filter and Apply Filter buttons - a group of filters to 

enable you to select specific subsets of patches from the patches list. The Text filter 
works as an additional filter applied to a Field. The Customer filter displays only the 
patches required for the installation of a specific customer. The button Apply filter 
runs the query and applies the set filters to the patches list.

Note: Do not run the MDBVersionTool on the Oracle DB server. The tool must 
be run from the Momentum Application Server for it to run correctly.

Fig. 2-9: Database Update Tool - MDBVersionTool 
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• Patches list - the main area of the tool. For each patch, the following data items are 
reported:

• ID - The ID which identifies each patch.
• descr - Provides a a short description of the patch function.
• date - Date that the patch was created.
• SQLType - The object/s on which the patch operates.
• SQLText - The SQL string that the patch executes.
• user - The user that created the patch.
• customer - Specifies whether the patch is required for a specific customer.
• DB Sync Status - The color reports if the system requires the patch to be applied 

(red) or has already been applied (green).
• DB Sync - Contains the button Apply & Register. This applies the patch and logs 

this action so that you can track the status of the database.
• Register modify (development) - Contains the button Register. Only used in the 

development environment to register the patch log of an already applied patch.
• Add patch button - Used during development to add a new patch to the Patches list.
• Apply and Register All button - Applies all the patches marked with a red rectangle as 

DB Sync Status, on a single Oracle installation, instead of applying them one by one. A 
list of the patches is created and a progress bar shows the current installation status.

To apply the patch/es to a Momentum installation using the MDBVersionTool:
1 Start the MDBVersionTool application.
2 Apply the required patch/es individually by clicking the corresponding button Apply 

& Register, or all at once by clicking the button Apply and Register All. When 
applying each patch manually, start from the first patch marked by a red square, 
directly above the last patch marked by a green square

Modifying the Security Properties of the Configuration Files
Momentum requires that its processes have free access to the configuration files. To avoid 
any access problems, the Security Properties of each file can be modified as follows:

1 At the end of the configuration procedure, navigate to the folder C:\Mantrics.
2 Right click each of the files listed below and open the Properties panel:

• DBConfiguration

• FileBasicInfo

• MantricsConfig

• MantricsNode

• MantricsServer

• WatchFolderServerConfig

3 Select the Security tab.
4 From the Group or User names list, select Users.
5 Click Edit.
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6 From the Group or User name list, select Users.
7 In the Permission for Users section, select the Full Control Allow option.
8 Click OK and then OK again.
9 Repeat steps 2-8 for all the listed files.
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Overview
In Momentum, users, roles and associated permissions, and the scope of assigned roles can 
be defined and modified in the Admin > Users page as shown below:

Security is granted by a permission management system which controls user access 
according to company policy. For example, a user may have permission to see a page on 
the menu toolbar, to accept certain tasks in the workflow, or to edit metadata in the 
Catalog.

It is recommended to assign Permissions to a role, and then assign roles to the users. 
Different roles may have some permissions in common and a user can be assigned different 
roles.

Fig. 3-10: Administration Page - User Set-up
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Defining Users
Users are created and managed in the Admin > Users page. Using this page, you can create 
a User, modify a user’s details, assign a role or roles to a user, or even remove a user from the 
system. 

Creating a User
To create a new user:

1 Click the Create user... button.
2 In the dialog, type the user name, full name, password and email address for the user as 

shown in the example below:

3 Click Ok to save the new user.

Assigning Roles To A User
To assign a role or roles to a user:

1 In the Users list, select the user.
2 In the User roles list, select the role(s) in the Available pane that you want to assign to 

the user and use the arrow buttons to move them into the Selected pane as shown in 
Figure 3-12:

Fig. 3-11: Adding a New User

Fig. 3-12: Assigning Permissions to a Role
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Use the arrow buttons to move the roles within the Selected pane. Optionally, in order 
to remove all roles from the user, click the Clear button. To undo the settings created in 
this session, click the Reset button. 

3 Click the Save button to save the new settings. 

Changing User Details and Passwords
To change a user’s details or password:

1 In the users list, select the user.
2 Click Edit details (  ) in the options area next to the user name as shown below:

3 Enter the new details or password and confirm it in the dialog, see Figure 3-13:

Note: To create an Administrator user, assign the ADMIN role to the user.

Arrow Button Description

 
Move Role to the top of the list.

 
Move Role up one line in the list.

 
Move Role from the Available pane to the Selected pane.

 
Move Role from the Selected pane to the Available pane.

 
Move Role down one line in the list.

 
Move Role to the bottom of the list.
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4 Click Save to save your changes.

Deleting a User
To remove a user:

1 In the users list, select the user you want to remove.
2 Click Delete    in the options area next to the user name as shown below:

3 Click OK to confirm deletion.

Sending Email to a User
You can send an email to any user with an email address using this page as follows:

1 In the options area next to the user name as shown below:

2 Click the Send Email button shown below:

3 A send email window opens, prepopulated with the user’s email address.
4 Write the message and send the email as usual.

Importing Users from an LDAP Source
When setting up several users in Momentum, it is generally more efficient to import groups 
of users from an LDAP source, for example, MS Windows Active Directory. Once imported, 
you can add the users to Momentum as valid accounts for logging, using the password 
rules and permissions established in the LDAP hierarchy.

Fig. 3-13: Changing User Details or Password
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To import LDAP groups:
1 Open the Admin > Roles page.
2 Click Import LDAP Groups... in the Roles pane. The Import LDAP groups dialog opens, 

see Figure 3-14:

3 Provide the following information in order to establish the connection to the LDAP 
source:

• LDAP server IP: IP address of the target LDAP application server.
• Domain: Domain in use for the LDAP application. Enter the fully-

qualified domain name in this field (for example, 
domain.com or subdomain.domain.com) to ensure that 
your search will include the entire forest.

• User name: User name of a valid account for logging onto the LDAP 
server.

• Password: Password of the account for logging onto the LDAP server.
• Filter Groups: Sets a value used to filter (include or exclude) the groups 

imported.
4 Click the Get groups button. On first connection to the LDAP server, some of the above 

information is stored in the configuration file 
C:\Mantrics\AuthenticationConfig.xml, and is used for the successive 
connections to LDAP, for example, to refresh the user list. No password is stored.
When Momentum establishes a connection with the LDAP server, two new panes are 
displayed. On the left, the Remote groups pane reports the list of all existing groups, 
or the list of the groups matching the Filter Groups parameter, if a value was entered in 
this field. On the right, the Local roles pane lists all roles available in the Momentum 
system.

Fig. 3-14: Import LDAP Groups Dialog
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5 Select the group or groups you want to import from the LDAP list. You can make 
multiple selections by holding down the [ Ctrl ] key.

6 Click the arrow button , or drag and drop the selection on the Local roles pane, to 
add the selected groups to the list of groups to import.

7 Click OK. 
Momentum retrieves the data relating to the users in the selected groups and opens a 
new pane showing all imported users, grouped as either Synced or Without Roles. If 
necessary, you can remove any unneeded users from the list.

Fig. 3-15: Import LDAP Groups Pane Listing Groups
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8 Click Ok to import the users and close the Synced users pane or click Cancel to close 
the LDAP groups pane.

9 In the Users page, check that the newly imported users are available. You can now 
associate roles, permissions and scopes with the new users as required.

Synchronizing Deleted Users with the LDAP Source
When synchronizing with LDAP, as described in the previous section, if any current 
Momentum users are not present in any of the Windows LDAP groups, you are given the 
option to delete those users manually from Momentum.

Note: It is not possible to change the password of a user imported from LDAP 
in Momentum as the password is managed under Windows Active 
Directory.

Fig. 3-16: Import LDAP Synced Users
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When the pop-up shown in Figure 3-17 is displayed, click Yes to confirm that the user(s) 
should be removed from the Momentum database.

A further screen is displayed, listing the users that can be deleted, see Figure 3-18.

Fig. 3-17: LDAP Sync - Notification of Users to Remove

Fig. 3-18: LDAP Sync - Summary of Users to Delete
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Select all users you want to remove from Momentum using the checkboxes, then click 
Delete to remove them from the database. If you decide not to remove a user at this point, 
click Cancel.

Defining Roles and Permissions
Roles and permissions are managed in the Admin > Roles page. Roles can be created or 
removed and permissions can be assigned to each role by deciding which pages and 
functions a role can access.

To access the Roles pages, click Roles in the left-hand menu of the Admin page. The Roles 
page is displayed as follows:

The following permissions are available to assign to roles:

Fig. 3-19: Administration Page - Role Set-up

Note: Role names are case-sensitive.

Permission Description

CAN_ALWAYS_EDIT_TAGGING ? TBA

CAN_CHANGE_TASK_PRIORITY Allows the changing the priority of a task operating on 
the workflow page.

CAN_CHANGE_TASK_STATUS Allows changing the status of a task using the related 
buttons in the workflow page.
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CAN_CHANGE_WFPAGES_PERMISSION Allows the user to set and modify the roles that can 
edit a workflow page.

CAN_CREATE_TITLE Assigns the user access to the Actions > Create > Title 
function in the Catalog page.

CAN_DELETE_MATERIALS Deletes any kind of material from the catalog page.

CAN_DELETE_OTHERS_MATERIALS Allows deletion of material created by other roles.

CAN_DELETE_OWN_ROLES_MATERIALS Allows the user to delete material created by users of 
the same role. The CAN_DELETE_MATERIAL permission 
is required.

CAN_DO_PARTIAL_RESTORE Allows the user to perform a partial restore (create 
subclips) from the Diva Archive.

CAN_DOWNLOAD_PROXY Allows the user to download proxies.

CAN_EDIT_AUDIO_DEFECTS Allows the user to create and edit audio defects.

CAN_EDIT_BXF_ROUTES Allows the user to edit BXF routes using the Admin 
page.

CAN_EDIT_CUSTOMER_CATALOG ? TBA

CAN_EDIT_MATERIALS Allows the user to edit material metadata values and 
create timelines.

CAN_EDIT_METADATA_MASKS Allows the user to create customized metadata masks 
for the Catalog page and also edit the metadata which 
appears in a result list.

CAN_EDIT_PROJECTS Allows the user to create, edit, add and remove objects 
for projects in the Catalog page.

CAN_EDIT_PUBLIC_DASHBOARD_VIEWS Allows the user to create, edit, add and remove 
different dashboard views.

CAN_EDIT_PUBLIC_QUERIES Allows the user to create, edit and delete public 
queries.

CAN_EDIT_QC_DEFECTS_STATUS Changes the defect’s status from the VisualQC page.

CAN_EDIT_ROLES Allows the creation and customization of roles on the 
Admin page.

CAN_EDIT_TRANSFER_REQUESTS Allows the user to delete transfer requests using the 
Transfers page.

CAN_EDIT_USERS Allows the creation and customization of users on the 
Admin page.

CAN_EDIT_WF_ELEMENTS_DEFAULT Allows editing of workflow elements.

CAN_EDIT_WORKFLOW Allows editing actions in the workflow.

CAN_EXPORT_WORKFLOWS Allows the use of the export feature on the Workflow 
page.

CAN_HAVE_TASKS_NOTIFICATION Assigns permission to receive notification of task status 
from the workflow.

Permission Description
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CAN_INGEST ? TBA

CAN_JUKE_ARCHIVE Juke capabilities are being deprecated
Allows the archive feature on the Juke page.
Note: It is planned to deprecate the Juke functions 
from Momentum version 5.1

CAN_JUKE_INGEST Allows the ingest feature on the Juke page.
Note: It is planned to deprecate the Juke functions 
from Momentum version 5.1

CAN_OMNEON_CONSOLIDATOR_ALL_ELEMENTS Assigns permission to connect all workflow elements 
to the Omneon Consolidator.

CAN_PERFORM_QC ? TBA

CAN_RELINK_MEDIA_ASSETS ? TBA

CAN_REMOVE_GATEWAY_MEDIA Allows the user to instruct an XMLGateway Receiver 
server to remove duplicate media files from the 
Gateway Receiver Dashboard, if the Required Action 
displays Remove Media. This function is only available 
if the Gateway Receiver Dashboard is configured.

CAN_REMOVE_GATEWAY_MEDIA_IN_PROGRESS Assigns permission to instruct an XMLGateway 
Receiver server to remove unnecessary media files 
from the Gateway Receiver Dashboard, if the Required 
Action displays Upload Metadata. This function is only 
available if the Gateway Receiver Dashboard is 
configured.

CAN_REVIEW_HQ_ON_SDI Provides the ability to review any media from the 
Catalog on any SDI output by assigning permission to 
switch viewing between proxy and HQ on SDI 1 from 
the Tracks menu of the Catalog Player.
The Tracks menu of the player(s) allows selection of 
the options: View > Proxy or View > HQ on SDI.

CAN_SAVE_CURRENT_FRAME Allows the user to save the current frame in the player.

CAN_SEARCH_EVERYTHING ? TBA

CAN_SEND_TO_WORKFLOW Allows the use of the Send To feature in the Catalog 
page.

CAN_SENDTO_ALL_ELEMENTS Allows the use of the Send To feature to send material 
to all elements, bypassing the role restriction.

CAN_SKIP_TASKS Allows the user to skip a task at an element on the 
Workflow page.

CAN_STOP_USERACTION_TASKS Allows the user to stop tasks that are in waiting or 
processing statuses on User Action elements.

CAN_UPLOAD_PAMEVS_FILE ? TBA

CAN_VIEW_EXPIRED_TRANSFERS Allows the user to visualize the expired transfer 
requests in the Transfers page.

Permission Description
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To find a permission, select it from the Available list on the right-hand side of the page.

Creating a Role
To create a new role:

1 Click the Create role... button.
2 In the dialog that opens, enter the role name as shown in the example below:

CAN_VIEW_HQ ? TBA

CAN_VIEW_INGEST_WORKFLOWS ? TBA

CAN_VIEW_NON_INGEST_WORKFLOWS ? TBA

CAN_VIEW_PATH ? TBA

CAN_VIEW_PROXY_IN_MATERIAL_TREE Allows access to proxy files when available in the 
Catalog Material Tree.

HAS_ABOUT_PAGE Allows access to the About page.

HAS_ADMIN_PAGE Allows access to the Admin page.

HAS_COCKPIT_PAGE  Not used

HAS_CATALOG_PAGE Allows access to the Catalog page.

HAS_CUSTOMER_CATALOG_PAGE  Not used

HAS_DASHBOARD_PAGE Allows access to the Dashboard page.

HAS_EDITING_PAGE Allows access to the Editing page.

HAS_GATEWAY_DASHBOARD Allows access to the Gateway Receiver Dashboard 
page.

HAS_INGEST_PAGE Not used

HAS_LOGGER_PAGE Allows access to the Logger page.

HAS_LOGS_PAGE Allows access to the Logs page.

HAS_SCHEDULES_PAGE Allows access to the Schedules page, which enables 
the user to import schedules into Momentum.

HAS_SERVICES_PAGE Allows access to the Services page.

HAS_STATS_PAGE Allows access to the Stats page.

HAS_TODO_PAGE Allows access to the To Do page.

HAS_TRANSFERS_PAGE Allows access to the Transfers page.

HAS_VISUALQC_PAGE ? TBA

HAS_VKEDITOR_PAGE ? TBA

HAS_VTR_PAGE ? TBA

HAS_WORKFLOW_PAGE Allows access to the Workflow page.

1.HQ on SDI - High Quality on Serial Digital Interface.

Permission Description
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3 Click the Ok button.

Assigning Permissions to a Role
To assign permissions to a role:

1 In the roles list, select the role for which you want to modify the permissions.
2 In the permission list, select the required permissions in the Available pane and use 

the arrow buttons to move them into the Selected pane.

Use the arrow buttons to move the permissions up or down the Selected pane. 
Optionally, in order to remove all permissions from the role, click the Clear button. To 
undo the settings created in this session, click the Reset button.

3 Click the Save button to save your changes.

Removing a Role
To remove a role:

1 In the roles list, select the role you want to remove.

2 In the options area next to the role name click the Delete button shown below:

Fig. 3-20: Adding a Role

Fig. 3-21: Assigning Permissions to a Role
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3 Click Yes to confirm that you want to delete the role.

Defining the Scope of a Role
The ability to associate users, roles and permissions enables you to create certain 
boundaries that can customize the experience and the tools available to specific users or 
groups of users. This can make certain pages visible or editable and allow specific users to 
perform some high-level actions such as ingesting or deleting materials.

Occasionally, a more detailed type of condition is useful. For example, an operator can edit 
all the materials ingested but when managing a large amount of material every day, it 
might be useful if only the materials ingested that same day are available on the pages 
used and the material from previous days is hidden.

You can define this level of detail using Scopes:

Creating a New Scope
Scopes are created by clicking the Create scope... button in the Scopes tab of the Admin > 
Roles page. The Create scope dialog appears as follows:

Fig. 3-22: Scopes Page
46



Momentum
Configuration Guide
Enter a new name to identify the scope in the scopes list, then click Ok to save the new 
scope.

The Search tool enables you to define filter criteria to apply to the scope as shown in the 
example below:

Click the expression evaluation drop-down (see Figure 3-24) to display the options menu 
for the matching expression.

For more information on the buttons in the Scope Search panel, see the Momentum 
Operator’s Guide.

After defining all required conditions, click Save... to save a search of the criteria so that it 
can be applied to additional scopes and searches in the future. 

For example, to create a scope to limit the available material only to that which was 
ingested the same day, do the following:

1 Click the Create scope button.
2 Select the Ingest date option from the drop-down list for he first search field.
3 Leave the date condition field set to on.
4 Open the calendar and click the Today button.
5 Click Search. The Query column of the scope is updated with the new search criteria, 

see Figure 3-26.

Fig. 3-23: Creating a Scope

Fig. 3-24: Defining Filter Criteria in the Scope Search Tool

Expression Evaluation 
Drop-down Menu

Calendar for Date 
Selection

Fig. 3-25: Expression Evaluation Advanced Options
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Assigning a Scope to a Role
Assign a scope to a role as follows:

1 Select a role from the Roles list.

2 Select one or more scopes in the Scopes list by selecting the corresponding 
checkboxes.
Now the scope is active for the selected role and is assigned together with the role. In 
the example above, if a user with the role OPERATOR opens the Catalog page and starts 
to query the materials, the result of the query will only show materials ingested that 
day.

Fig. 3-26: Saving Search Criteria to Scope

Defined Search Criteria Saved to 
Scope Query

Fig. 3-27: Assigning Scopes
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Deleting a Scope
To delete a scope:

1 Select a scope from the Scopes list.
2 Click the Delete icon .
3 Click Yes to confirm the deletion or No to cancel.

Fig. 3-28: Deleting a Scope
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Configuring the Archive Workflow Elements
The Archive workflow elements enable you to archive, delete and partially or fully restore 
material using archiving solutions from either Masstech, Oracle or StorNext. The following 
Archive elements are available:

• Masstech FlashNet media object archiving solution elements:
• Flashnet Archive
• Flashnet Delete
• Flashnet Partial Restore
• Flashnet Restore

• Oracle Diva archiving solution elements:
• Diva Archive
• Diva Delete
• Diva Partial Restore
• Diva Restore

• StorNext archiving solution elements:
• StorNext Archive
• StorNext Restore

The configuration details for these archiving workflow elements are provided in the 
following sections.

Archiving to a Masstech Flashnet System
The Masstech FlashNet workflow elements enable Momentum to integrate with SGL’s 
FlashNet Media Archive Content Management solution by way of the FlashNet XML API 

The following workflow elements are available to manage archiving to a Masstech Flashnet 
archive repository:

• Flashnet Archive
• Flashnet Delete
• Flashnet Partial Restore
• Flashnet Restore
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Archiving Material to a Flashnet Archive

The Archive element initiates a media archive process on a FlashNet cluster. This process 
transfers data from a network-attached source server to a storage medium within the 
control of the FlashNet cluster.

Element Settings Configuration
The Flashnet Archive element has the following settings:

Fig. 4-29:  Flashnet Archive Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label The label associated with the archived instance.

Volume Group Defines the target set of tapes or disks to be used for the archive 
operation, for example: RAID%

Switch new instance When selected (true), this option activates the newly created 
Instance and propagates the new Instance to the next step in the 
workflow. The default setting is false (unselected).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 4-30:  Flashnet Archive Element Configuration Fields
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Configuration Files
The tag <flashnetarchive> contains the configuration for this application.

MantricsServer.xml Configuration
<flashnetarchive>

<server port="8708">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</flashnetarchive>

MantricsNode.xml Configuration
The recommended port settings for this element are as follows:

<flashnetarchive slotCount="4">
<active>false</active>
<server port="8708">10.250.170.183</server>
<node port="8709">10.250.170.183</node>
<pool/>
<flashnetip>172.31.7.13</flashnetip>
<flashnetport>8199</flashnetport>
<apiVersion>2018.001.006</apiVersion>
<userName>Mike</userName>

</flashnetarchive>

The FlashNet specific XML tags have the following functions:

Flashnet Element Server Port Node Port

Flashnet Archive 8708 8709

Tag Description

flashnetip Sets the IP address of the FlashNet server.

flashnetport Sets the TCP socket number to the Flashnet cluster.

apiVersion Identifies the revision of the FlashNet XML API to which the 
calling application has been written. Set to the revision 
number of your client package. This is generally used for 
support purposes and troubleshooting.

userName Name of the operator making the call. It is recommended to 
supply a user-friendly name for the job as it is displayed in 
the job list, especially if multiple users communicate with 
the archive.
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Deleting Material from a Flashnet Archive
The Flashnet Delete element removes the target material from the Flashnet Archive.

Element Settings Configuration
This element has the following settings:

Configuration Files
The tag <flashnetdelete> contains the configuration for this application.

MantricsServer.xml Configuration
<flashnetdelete>

<server port="8710">10.250.170.183</server>
<policy>Weighted</policy>

Fig. 4-31:  Flashnet Delete Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 4-32:  Flashnet Delete Element Configuration Fields
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<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</flashnetdelete>

MantricsNode.xml Configuration
The recommended port settings for this element are as follows:

<flashnetdelete slotCount="4">
<active>false</active>
<server port="8710">10.250.170.183</server>
<node port="8711">10.250.170.183</node>
<pool/>
<flashnetip>172.31.7.13</flashnetip>
<flashnetport>8199</flashnetport>
<apiVersion>2018.001.006</apiVersion>
<userName>Mike</userName>

</flashnetdelete>

For more information on the FlashNet specific XML tags, see Configuration Files, on page 53.

Partial Restore from a Flashnet Archive
Use the Partial Restore element if the file to be restored is very large, and you only want to 
retrieve part of the file.

A partial file-restore is typically implemented as a frame offset, where the start and end 
values are defined by the start and end frames required. For MXF In order for this to 
function for MXF files, the content being archived must comply with the standard SMPTE 
378.

The Partial Restore element passes start-frame and end-frame values to Flashnet. If the start 
timecode of the clip is greater than zero, subtract the start timecode of the clip from the 
start frame and end frame.

Flashnet Element Server Port Node Port

Flashnet Delete 8710 8711

Fig. 4-33:  Flashnet Partial Restore Workflow Element
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Element Settings Configuration
This element has the following settings:

Configuration Files
The tag <flashnetpartialrestore> contains the configuration for this application.

MantricsServer.xml Configuration
<flashnetpartialrestore>

<server port="8712">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</flashnetpartialrestore>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label The label associated with the archived instance.

Partial Restore Path Defines the path to which the partial restore media file(s) will be  
saved.
A partial restore returns from archive only part of the media in your 
sequence, based on in and out timecodes, helping to reduce 
retrieval times.

Switch new instance
When selected (true), this option activates the newly created 
Instance and propagates the new Instance to the next step in the 
workflow. The default setting is false (unselected).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 4-34:  Flashnet Partial Restore Element Configuration Fields
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MantricsNode.xml Configuration
The recommended port settings for this element are as follows:

<flashnetpartialrestore slotCount="4">
<active>false</active>
<server port="8712">10.250.170.183</server>
<node port="8713">10.250.170.183</node>
<pool/>
<flashnetip>172.31.7.13</flashnetip>
<flashnetport>8199</flashnetport>
<apiVersion>2018.001.006</apiVersion>
<userName>Mike</userName>

</flashnetpartialrestore>

For more information on the FlashNet specific XML tags, see Configuration Files, on page 53 
.

Restoring Material from a Flashnet Archive
The Flashnet Restore element initiates a restore process on a FlashNet cluster. This process 
transfers data from a storage medium within the control of the FlashNet cluster to a target 
network-attached server.

The settings for the Flashnet Restore element are as follows:

Flashnet Element Server Port Node Port

Flashnet Partial Restore 8712 8713

Fig. 4-35:  Flashnet Restore Workflow Element

Fig. 4-36:  Flashnet Restore Element Configuration Fields
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This element has the following settings:

Configuration Files
The tag <flashnetrestore> contains the configuration for this application.

MantricsServer.xml Configuration
<flashnetrestore>

<server port="8714">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</flashnetrestore>

MantricsNode.xml Configuration
The recommended port settings for this element are as follows:

<flashnetrestore slotCount="4">
<active>false</active>
<server port="8714">10.250.170.183</server>
<node port="8715">10.250.170.183</node>
<pool/>
<flashnetip>172.31.7.13</flashnetip>
<flashnetport>8199</flashnetport>
<apiVersion>2018.001.006</apiVersion>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label The label associated with the archived instance.

Restore Path Defines the fully-qualified path to which the restored media will be 
saved. If not specified, media is restored to the original location 
from which it was archived.
A full restore returns from archive all of the media in your sequence.

Switch New Instance When selected (true), this option activates the newly created 
Instance and propagates the new Instance to the next step in the 
workflow. The default setting is false (unselected).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Flashnet Element Server Port Node Port

Flashnet Restore 8714 8715
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<userName>User</userName>
</flashnetrestore>

For more information on the FlashNet specific XML tags, see Configuration Files, on page 53 
.

Archiving to an Oracle DivArchive System

Overview of the Oracle DivArchive System
Momentum is designed to integrate with an Oracle DivArchive1 digital archive solution for 
the archiving of digital media assets and assistance in providing material for production 
workflows.

The Oracle DIVArchive solution has interfaces to broadcast and post-production devices; it 
understands how content is organized on the device, and stores all files belonging to this 
content as a single object. The DivArchive system supports the storage and management of 

1.Formerly known as Front Porch Digital DIVA and acquired by Oracle in September 2014.

Fig. 4-37:  Overview of a Typical DivArchive System
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several instances of the same object, for example, it can store and track one instance on 
disk, one instance on tape within a robotic tape library, and one instance on tape stored on 
an external shelf.

The DIVArchive solution consists of, and uses, a number of related DIVA products. 

The following are the most relevant to a Momentum Installation: 
• DIVArchive Manager: Manages the overall archive solution. It also hosts 

the archive system database. Typically runs on 
dedicated hardware.

• DIVArchive Partial File Restore: Allows restoration of a segment of a piece of content 
that is managed by the DIVArchive. This is specified 
by an in timecode and an out timecode and is more 
efficient than restoring a full media asset when only 
a short clip is required.

• DIVArchive Application Filter: Limits access to DIVArchive managed content by 
third-party systems based on user permissions.

• DIVAnet: Facilitates a direct connection between separate 
DIVArchive Systems and automatically replicates 
content from one site to the other, typically for 
disaster recovery (DR) purposes.

• DIVAdirector: Asset Management System that provides direct 
interfaces into edit systems and provides some 
workflow management and search with low 
resolution proxy viewing, thumbnails and metadata 
management. This module also allows file upload 
with time-code based logging and tagging.

The interface with a Diva archive system is managed using the following workflow 
elements:

• Diva Archive used to archive material to Diva.
• Diva Delete used to remove a material asset from the Diva archive.
• Diva Restore used to restore a new instance of a material asset from the Diva archive.
• Diva Partial Restore used to restore a segment of a material asset from the Diva archive, 

while maintaining a link with the source asset.

Configuring the Diva Workflow Elements
Momentum provides four workflow elements (Archive, Delete, Restore and Partial Restore) 
to integrate workflows with the DivArchive archiving system. These elements are available 
from the Workflow page in the elements folder: Archive > Oracle, see Figure 4-38.
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The location of the DIVArchive Manager is configured for each of these archiving elements 
in the configuration files: MantricsServer.xml and MantricsNode.xml.

In addition, the configuration file Diva.xml contains a list of the Diva error codes together 
with their associated error descriptions. The file MantricsNode.xml defines the default 
communication port between Momentum and the DIVArchive system as port 9763.

Archiving Material to a DivArchive
The Diva Archive workflow element enables a workflow to push content, currently 
managed by Momentum, into the archive repository managed by a DIVArchive Manager.

The Diva Archive workflow element has the following settings:

Fig. 4-38:  Diva Archive Workflow Elements 

Oracle Diva Archive 
Workflow Elements

Fig. 4-39:  Diva Archive Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label for the instance. Available values from the 
configuration file InstanceLabelConfig.xml are included in 
the drop-down list.

Category Sets the Category value used by Diva when archiving the current 
object.

Source Enables you to select a profile that describes the characteristics 
of the source of the assets to be archived (e.g. FTP, CIFS, Disk, etc.) 
from a list of existing Diva profiles.

Media Enables you to set (by selecting from a list of available Diva 
Media profiles) the type of device used to store the material in 
the Diva archive. This drop-down also lists the selectable Storage 
Plans created in the Diva interface.

QoS Sets the quality level to assign to the archived material.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. 
The default setting is False (unchecked).

Comments Sets comments linked to the material.

Options Enables you to specify parameters needed to manage the 
material correctly (for example, the credentials used to access an 
FTP site) if that information is not present in the selected Source 
profile.

Fig. 4-40:  Diva Archive Element Configuration Fields
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A DivaInstance metadata category and schema, is linked to the DivaInstance type 
definition. The Diva Archive element does not delete the source Momentum Instance, 
rather it creates a new DivaInstance as output, which includes the Diva metadata in 
addition to the base, inherited metadata.

Configuration Files
To use a Diva archiving system with Momentum, you will need to add the details to the 
configuration files MantricsServer.xml and MantricsNode.xml. The basic Diva 
configuration follows the same rules and guidelines as the Momentum Farm (see 
Configuring the Momentum Farm, on page 22).

The tags <divaarchive>, <divarestore>, <divapartialrestore> and <divadelete> in the 
configuration file MantricsServer.xml contain the server-side configuration for this 
application. In addition, the configuration file MantricsNode.xml contains the 
configuration of the Diva node(s). Replace the default address of the tag <ipdiva> in 
MantricsNode.xml with the IP address of the Diva server. 

. If this is not the current port in use, modify this value accordingly.

For example:
<ipdiva>http://xxx.xxx.xxx.xxx:9763</ipdiva>

MantricsServer.xml Configuration
<divaarchive>

<server port="9763">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</divaarchive>

The port 9763 is the default port used by the Diva application.

Object Name Metadata field used to identify the archived material. When this 
parameter is not specified, the {MATERIALID} is used by default.
The Diva Restore and Diva Delete workflow elements both  use 
the value from the Object Name when calling the DivArchive API. 

Proxy Output Dir Defines the target folder into which the MP4 proxy file is copied. 
The Diva Archive element will then assign a proxy to the new 
instance, based on the copied file.

Pool Sets the name of a pool associated with the element to balance 
the processing load.

Option Description

Note: The file C:\Mantrics\DivaConfig.xml stores the status code 
messages of the Diva system and does not contain parameters for the 
configuration of the service.
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MantricsNode.xml Configuration

<divaarchive slotCount="2">
<active>false</active>
<server port="9763">10.250.170.183</server>
<node port="8179">10.250.170.183</node>
<pool/>
<ipdiva>http://172.19.77.80:9763</ipdiva>

</divaarchive>

Deleting Material from a DivArchive
The Diva Delete workflow element enables a workflow to delete content, that Momentum 
is aware of, from the DIVArchive repository managed by a DIVArchive Manager. This action 
permanently deletes the physical material from the archive.

The Diva Delete workflow element has the following settings:

The Diva Delete workflow element calls an API function to delete an object entry in the Diva 
Archive system, based on the metadata information of the MEDIA-ASSET material 
processed by the element.

This workflow element deletes the specified content only from the Diva archive; it does not 
remove content from the Momentum database. To delete content from both Diva and 

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Fig. 4-41:  Diva Delete Workflow Element

Fig. 4-42:  Diva Archive Element Configuration Fields
64



Momentum
Configuration Guide
Momentum, connect a Material Deletion workflow element after the Diva Delete 
element and activate the option Ignore file deletion error.

Configuration Files
The tag <divadelete> contains the configuration for this application.

MantricsServer.xml Configuration
<divadelete>

<server port="8196">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</divadelete>

MantricsNode.xml Configuration

<divadelete slotCount="2">
<active>false</active>
<server port="8196">10.250.170.183</server>
<node port="8197">10.250.170.183</node>
<pool/>
<ipdiva>http://172.19.77.80:9763</ipdiva>

</divadelete>

Partial Restoration of Material from a DivArchive
The Diva Partial Restore workflow element enables a workflow to instruct the DIVArchive 
Manger to restore a key segment of an entire asset contained in the DIVArchive repository. 
It uses the partial restore capability provided by the DIVArchive Partial File Restore. The in 
and out points for the partial restore can be determined by markers logged against the 
material.

The Diva Partial Restore workflow element has the following settings:

Fig. 4-43:  Diva Partial Restore Workflow Element
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As Diva Partial Restore is a start element, it does not require an in-port. When the requested 
segment is retrieved from the Diva archive, a new Title and Media Asset are generated and 
then propagated to the next steps of the workflow.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label for the instance. Available values from the 
configuration file InstanceLabelConfig.xml are included in 
the drop-down list.

Restore Path Sets the target directory for the restored file.

Destination Enables you to select a profile describing the characteristics of 
the destination of the restored material (for example, path, type, 
etc.) from a list of existing Diva profiles.

Schema Sets the metadata schema to be applied to the new Title.

QoS Sets the quality level that the Diva system assigns to the material 
while restoring.

Options Enables you to specify parameters needed to manage the 
material correctly (for example, the credentials used to access an 
FTP site) if that information is not present in the selected Source 
profile.

Pool Sets the name of a pool associated with the element to balance 
the processing load.

Fig. 4-44: Diva Partial Restore Element Configuration Fields
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Configuration Files
The tag <divapartialrestore> contains the configuration for this application.

MantricsServer.xml Configuration
<divapartialrestore>

<server port="8208">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</divapartialrestore>

MantricsNode.xml Configuration

<divapartialrestore slotCount="2">
<active>false</active>
<server port="8208">10.250.170.183</server>
<node port="8209">10.250.170.183</node>
<pool/>
<ipdiva>http://172.19.77.80:9763</ipdiva>

</divapartialrestore>

Restoring Material from a DivArchive
The Diva Restore workflow element enables a workflow to instruct the DIVArchive 
Manager to restore an entire asset from the archive repository.

The Diva Restore workflow element has the following settings:

Fig. 4-45:  Diva Restore Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label for the instance. Available values from the 
configuration file InstanceLabelConfig.xml are included in 
the drop-down list.

Restore Path Sets the target directory for the restored file.

Destination Enables you to select a profile describing the characteristics of the 
destination of the restored material (for example, path, type, etc.) 
from a list of existing Diva profiles.

QoS Sets the quality level that the Diva system assigns to the material 
while restoring.

Options Enables you to specify parameters needed to manage the 
material correctly (for example, the credentials used to access an 
FTP site) if that information is not present in the selected Source 
profile.

Switch New Instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. 
The default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance 
the processing load.

Fig. 4-46:  Diva Restore Element Configuration Fields
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Configuration Files
The tag <divarestore> contains the configuration for this application.

MantricsServer.xml Configuration
<divarestore>

<server port="8194">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</divarestore>

MantricsNode.xml Configuration
<divarestore slotCount="2">

<active>false</active>
<server port="8194">10.250.170.183</server>
<node port="8195">10.250.170.183</node>
<pool/>
<ipdiva>http://172.19.77.80:9763</ipdiva>

</divarestore>

Archiving to a Quantum Stornext System
The two StorNext elements enable you to create workflows that archive media to a Stornext 
archive or restore media from a Stornext archive .

An archive workflow can be used to place HR media into the deep archive while 
maintaining a proxy copy on SAN storage. 

A restore workflow can be used to search and preview proxies in the Catalog page and if 
there is a Archived flag in metadata choose to implement a restore action manually.

Archiving Material to a StorNext Archive

The StorNext Archive workflow element has the following settings:

Fig. 4-47:  StorNext Archive Workflow Element
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Restoring Material from a StorNext Archive

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

BaseUrl Defines the base URL for the StorNext web services address, in 
the form:
<Protocol>://<Server>/sws/v2/ 
Where:
<Protocol> is http or https
<Server> is the IP address of the StorNext server.
For example: http://192.168.1.214:81/sws/v2/

SanPath Defines the path of the StorNext folder to which files will be 
archived.
For example: /SAN/toTape/

UseHttps Select this option if the StorNext web services are configured to 
use HTTPS.

UseAuthentication Select this option if authentication is required to access the 
StorNext web services.

Username The username for authentication by StorNext web services.

Password The password for authentication by StorNext web services.

Pool Sets the name of a pool associated with the element to balance 
the processing load.

Fig. 4-48:  StorNext Archive Element Configuration Fields
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The StorNext Restore Element workflow element enables you to restore material from a 
StorNext archive. You can use this element to confirm that material is available in the 
StorNext archive and if required, trigger a restore action. It resides in the SAM folder of the 
Automation group of elements. 

A StorNext archive system may include a primary storage disk system for immediate data 
access and a secondary LTO tape archive. The StorNext Restore element can restore data 
immediately from disk storage but must wait for the StorNext controller to restore material 
from tape before the element can start a restore to the Momentum environment.

This element has the following settings:

Note: To transfer files to a StorNext archive use the Momentum Copy workflow 
element.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Fig. 4-49:  StorNext Archive Workflow Element

Fig. 4-50:  StorNext Restore Element Configuration Fields
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StorNext Configuration Files
The StorNext configuration files are available from the following folder:
C:\Mantrics\Plugins\StorNext

Include the following:
• For the StorNext Archive Element:

• StorNextArchiveNode.xml
• StorNextArchiveServer.xml

• For the StorNext Restore Element:
• StorNextRestoreNode.xml
• StorNextRestoreServer.xml

StorNextArchiveNode.xml
<StorNextArchiveNodeConfig xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" slotCount="4">

<active>true</active>
<server port="8030">127.0.0.1</server>
<node port="8031">127.0.0.1</node>
<pool />

</StorNextArchiveNodeConfig>

BaseUrl The base URL for the StorNext web services address, in the form:
<Protocol>://<Server>/sws/v2/ 
Where:
<Protocol> is http or https
<Server> is the IP address of the StorNext server.
For example: http://192.168.1.214:81/sws/v2/

SanPath The path of the StorNext folder from which files will be restored.
For example: /SAN/toTape/

UseHttps Select this option if the StorNext web services are configured to use 
HTTPS.

UseAuthentication Select this option if authentication is required to access the 
StorNext web services.

Username The username for authentication by StorNext web services.

Password The password for authentication by StorNext web services.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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StorNextArchiveServer.xml
<StorNextArchiveServerConfig xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<server port="8030">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</StorNextArchiveServerConfig>

StorNextRestoreNode.xml
<StorNextRestoreNodeConfig xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" slotCount="4">

<active>true</active>
<server port="8032">127.0.0.1</server>
<node port="8033">127.0.0.1</node>
<pool />

</StorNextRestoreNodeConfig>

StorNextRestoreServer.xml
<StorNextRestoreServerConfig xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<server port="8032">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</StorNextRestoreServerConfig>
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Configuring the Automation Workflow Elements
The Automation workflow elements enable you insert transcoder elements to transcode 
media files into different formats, depending on the supported codecs.

 The following Automation elements are available:
• Automation File Transfer Elements

• Aspera 
• Copy
• Fileflow Export
• Fileflow Import
• FTP
• Signiant

• Automation Grass Valley Elements
• BXF Morpheus Export
• BXF Morpheus Query
• BXF Transfer Metadata Retriever
• Gateway Export
• iTX

• Automation Housekeeping Elements
• Material Deletion

• Automation Imagine Communications Elements
• Harris Data Import
• Harris Data Updater

• Automation Social Elements
• Publish to Dailymotion
• Publish to Facebook
• Publish to Twitter
• Publish to Youtube
• Remove from Dailymotion
• Remove from Facebook
• Remove from Twitter
• Remove from Youtube

• Automation Miscellaneous Elements
• Add to Project
• End
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• Etere Xml Exporter
• Go To
• Instance switcher
• Key Segmentator
• Metadata Publisher
• Remove From Project
• Send Mail
• Send To...
• Set Metadata
• Set Priority
• Sleep
• Technical Metadata Retriever

The configuration details for these elements are provided in the following sections.

Automation File Transfer Workflow Elements
The File Transfer group of workflow elements enables you to define various methods of 
transferring material in to, or out of, a workflow. This group contains the following:

• Aspera
• Copy
• Fileflow Export
• Fileflow Import
• FTP
• Signiant

File Transfer: Aspera
The Aspera workflow element connects to the Aspera service to enable the high-speed 
transfer of video content files using the Aspera FASP transfer technology interface.

The Aspera watchfolder communicates with the Aspera client on which the Aspera API is 
located to transfer files to the Aspera service for high-speed transmission to defined target 
endpoints.

Use a Watchfolder to ingest material then use an Aspera element in the workflow to transfer 
files to a target location, for example, to different regional stations or to a NAS.

Note: All the elements described in this section require configuration of 
the files MantricsServer.xml and MantricsNode.xml.
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Element Settings Configuration
This element is available in the Automation > File transfer folder and has the following 
settings:

Fig. 5-51: Aspera Workflow Element

Fig. 5-52:  Aspera Element Configuration Fields - Part 1

Fig. 5-53:  Aspera Element Configuration Fields - Part 2
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Username Username to access the Aspera client on which the Aspera API is 
located.

Password Password to access the Aspera client on which the Aspera API is 
located.

Server Address IP address of the Aspera client.

Server Folder Destination IP address and folder for the transferred files.

Server Port Port to communicate with the Aspera server.

Timeout Defines the transfer timeout in seconds for the current transfer.
Default: 7200 seconds

TransferURL Defines the URL address of the web service used to send files to the 
Aspera service. Set by default to:
http://localhost:40001

Upload Target Rate Sets the maximum transfer rate to upload files to a target endpoint. 
This enables you to use the maximum transfer rate offered by the 
various delivery stations when using the Aspera workflow element.
The default upload target rate is 100,000 kbps or 100 Mbps per 
element (where the default unit is 1 kbps or 1000 bps).
It is important to consider the Aspera licensing requirements when 
defining the upload target rate. For example, with an Aspera client 
licensed for a maximum upload rate of 300 Mbps that allows two 
concurrent client logins, when using a workflow with two Aspera 
elements, it would be recommended to set the upload target rate 
on each element to 150 Mbps.

Polling Interval Interval in seconds at which the Aspera element checks for 
information on the status and completion of the data transfer 
process.

Create New Instance Option to create a new instance as the result of a successful transfer. 
This should allow to configure the hostname + shared folder name 
to be assigned to the instance.
Default: unchecked

Label Hidden unless Create new instance is checked.
When Create new instance is checked, select the label assigned to 
the new instance from InstanceLabelsConfig.xml using the 
drop-down menu.

Host Hidden unless Create new instance is checked.
When Create new instance is checked, defines the hostname of 
the target server to which Momentum transfers the new instance.
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The tag <aspera> contains the configuration details to allow this application to 
communicate with Momentum.

MantricsServer.xml Configuration
<aspera>

<server port="8210">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</aspera>

MantricsNode.xml Configuration
<aspera slotCount="4">

<active>false</active>
<server port="8210">127.0.0.1</server>
<node port="8211">127.0.0.1</node>
<pool/>

</aspera>

File transfer: Copy
The Copy element copies an instance of material into a selected destination folder. You can 
configure the behavior of the element to treat a file that may already exist in the 
destination folder.

Shared Folder Hidden unless Create new instance is checked.
When Create new instance is checked, defines the shared folder on 
the target server to which Momentum transfers the new instance.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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Element Settings Configuration
This element is available in the Automation > File Transfer folder and has the following 
settings:

Fig. 5-54: Copy Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dst Folder Sets the destination directory. Type in a UNC path or set it using the 
browser.

Fig. 5-55: Copy Element Configuration Fields
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FileName Specify the name of the Instance destination file without a file 
extension. The default setting is to use the keyword 
{instance.FileNameWithoutExtension} so by default the copied 
file is not renamed.
This is a copy operation so file extension changes are not permitted.

Mode Defines what happens if the file already exists in the destination 
directory.The values are:
Overwrite - to overwrite the existing file
Skip - to skip the copy
Unique - to rename the copy by automatically appending a 
progressive number to the file name.
In all the above cases, if an instance of the selected material already 
exists in the database, then no action is taken and the task goes 
through the failed port.
If no Instance exists, then Momentum creates it and the file is 
managed as set by the mode selected. The task goes through the 
port named for the Mode value.

Skip Instance Creation When checked, prevents the copy process from creating a new 
instance.

FXP Activates the File eXchange protocol (FXP) which enables you to 
copy files from one FTP server to another by way of an FXP client.
The Copy workflow element will validate the FXP settings in both 
the element settings and in the configuration file 
MantricsServer.xml. If invalid parameters are specified, a 
suitable error message will be displayed.

Preserve Timestamp Active only when the FXP protocol option is selected. 
Sets the timestamp of the destination file to be the same as that of 
the original file.

Move Changes the Copy operation into a Move and removes the files 
after the copy action.
If the file does not already exist in the target location, then 
Momentum always creates a new Instance in the database and a file 
in the target location. The task goes through the ok port. 
If the file is already present, then the behavior matches the selected 
Mode and the task goes through the port named as the Mode 
value.
This option is available if the FXP protocol option is inactive.

Instance Type Sets which Instance to copy through the workflow. The values are: 
HQ (high quality) or AUX (Auxiliary Instance, formats include e.g. 
TXT, PDF, PAC, DOC, DOCX file).

Label Sets the label of the AUX Instance. Available values are retrieved 
from the file InstanceLabelConfig.xml.

Switch New Instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Option Description
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The tag <copy> contains the configuration for this element.

MantricsServer.xml Configuration
<copy>

<server port="8118">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<fxpItemList/>
<overwriteInstance>false</overwriteInstance>

</copy>

MantricsNode.xml Configuration
<copy slotCount="4">

<active>true</active>
<server port="8118">10.250.170.183</server>
<node port="8119">10.250.170.183</node>
<pool/>
<fxp>false</fxp>
<fxp_descr>Fxp</fxp_descr>

</copy>

Configuring FXP in the Copy Element

Configuring FXP in MantricsServer.xml
FXP is configured in the <fxpItemList> section of the <copy> tag and appears as follows:

Include Segmentation Active only when Instance Type set to HQ.
When checked, includes soft segmentation in the copy process. The 
default setting is not to include soft segmentation.

Segment Id Pattern Active only when Include Segmentation is checked for HQ 
instances.
Enter a pattern to use for the Segment ID in the copied file. The 
default setting of this parameter is: {GUID}-## to copy the segment 
incrementally from the key-segments parent list.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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<fxpItemList>
<fxpItem>

<schemaDir />
<host />
<port />
<username />
<password />

</fxpItem>
</fxpItemList>

These tags have the following functions:

Configuring FXP in MantricsNode.xml
FXP is configured in the <copy> tag and appears as follows:

<fxp>false</fxp>
<fxp_descr>Fxp</fxp_descr>

The tag <fxp> defines whether the FXP feature is active for the node. The available values 
are true and false. Set to true to activate FXP.

File transfer: Fileflow Export
The Fileflow Export element provides Momentum with an interface to media clips exported 
from an sQ Server environment by way of the sQ Fileflow API. The Fileflow Export element 
picks up the exported sQ media clip and generates a physical media file in MXF format in 
the Momentum database.

Option Description

fxpItemList A collection of all of the FXP sources and destinations.

fxpItem Contains the data for a single FXP source or destination.

schemaDir Defines the UNC path to the Destination directory. Momentum 
validates entries in this field to ensure that correct paths are 
entered.

host Defines the IP address of the FTP host.

port Defines the port number to use for an FXP transfer by the Copy 
workflow element.

username Defines the user to logon to the FTP host.

password Provides the password for the user defined in <username>.

overwriteInstance When set to false (default) the Copy action will not overwrite an 
instance of material with the same characteristics that is already 
present in the database. Set the value to true to enable the Copy 
action to overwrite an existing instance.
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The successful output of the Fileflow Export task is a new Instance located in an accessible, 
defined file path.

Element Settings Configuration
This element is available in the Automation > File Transfer folder and has the following 
settings:

Fig. 5-56: Fileflow Export Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Autoselect instance When selected (default) automatically takes the sQ instance with 
the most recent creation date and uses this in the export operation 
and creation of the MXF file.
When unselected Fileflow Export will select only a specific sQ 
instance.

Label Sets the label of the newly generated Instance. The available values 
are contained in the InstanceLabelConfig.xml file.

Fig. 5-57: Fileflow Export Element Configuration Fields
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The tag <fileflowexport> contains the configuration for this element.

MantricsServer.xml Configuration
<fileflowexport>

<server port="8312">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</fileflowexport>

MantricsNode.xml Configuration
<fileflowexport slotCount="4">

<active>true</active>
<server port="8312">10.250.170.183</server>
<node port="8313">10.250.170.183</node>
<pool/>
<ipfileflow>http://10.250.170.141:8080/fileflowqueue/ffq</ipfileflow>

</fileflowexport>

File transfer: Fileflow Import
The Fileflow Import workflow element provides Momentum with an interface to an sQ 
Server environment by way of the sQ Fileflow API. The Fileflow Import element creates a 
media Instance in a suitable format and with appropriate metadata in the Momentum 

Dst Defines the destination file path in which to store the new Instance 
(in MXF format) generated by the Fileflow Export task from the sQ 
source.

Filename Filename of the media Instance (in MXF format) generated by the 
Fileflow Export task from the sQ source instance.

Profile A task-specific configuration set that can be attached to a task to 
instruct the Fileflow API to process the task using the defined profile 
instead of the default configuration.

Switch New Instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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database to enable the sQ Fileflow API to import the sQ Instance into the sQ Server 
environment.

The successful output of the Fileflow Import task is a new sQ Clip Instance, with ClipID and 
ZoneID set using the sQInstance metadata schema. 

Element Settings Configuration
This element is available in the Automation > File Transfer folder and has the following 
settings:

Fig. 5-58: Fileflow Import Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

SQ Instance Schema Sets the instance category for the imported sQ instance. 
Default: SQ Instance

Label Sets the label of the newly generated Instance. The available values 
are contained in the InstanceLabelConfig.xml file.

Fig. 5-59: Fileflow Import Element Configuration Fields
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Target Sets the target network destination for the output clip instance on 
the target ISA Manager.
The specified network path may be outside the list of configured 
hosts for the Fileflow Queue as long as it can be accessed.
Note: If authentication is required for network access, the Fileflow 
Queue must be correctly configured with the relevant 
authentication details. Refer to the Fileflow Queue documentation 
for more information.

Profile A task-specific configuration set that can be attached to a task to 
instruct the Fileflow API to process the task using the defined profile 
instead of the default configuration.

Rename Rule Select one of the available rename rules used to tell the Fileflow 
Engine to add either a prefix or suffix to the output name or to 
override it completely. You can select from the following options:
None: No change to the output name.
Prefix: Add the specified string as a prefix at the beginning of 

the output name.
Replace: Overwrite the output name with the specified string.
Suffix: Add the specified string as a suffix to the end of the 

output name.

Rename Rule Text Active only when you specify a Rename Rule.
Enter a text string, which may include variables, to be applied to the 
output name as specified in the field Rename Rule.

Switch New Instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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The tag <fileflowimport> contains the configuration for this element.

MantricsServer.xml Configuration
<fileflowimport>

<server port="8310">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</fileflowimport>

MantricsNode.xml Configuration
<fileflowimport slotCount="4">

<active>true</active>
<server port="8310">10.250.170.183</server>
<node port="8311">10.250.170.183</node>
<pool/>
<ipfileflow>http://10.250.170.141:8080/fileflowqueue/ffq</ipfileflow>

</fileflowimport>

File transfer: FTP
The FTP workflow element enables you to deliver material to a remote destination using 
FTP (file transfer protocol).

Element Settings Configuration
This element is available in the Automation > File Transfer folder and has the following 
settings:

Note: The buffer size for FTP transfers is set at 100 M B.

Fig. 5-60: FTP Workflow Element
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Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Host Sets the IP address of the FTP host site (for example, ftp://
ip_address/folder_name or ftp://ftp_name/folder_name).

User Sets a username for accessing the FTP site.

Password Sets a password for accessing the FTP site.

Dst Folder Defines the destination folder on the FTP host serverfor the file(s) 
transferred by FTP. 

Mode Sets how the transfer process behaves if a transferring file is already 
present in the destination folder. The values are: 
Overwrite The file into the destination folder is overwritten by 

the new file.
Skip The task is skipped and the next file (if present) is 

taken for transfer (port Skip).
Unique No transfer is attempted and a failure procedure is 

started (see the On Failure option below).

Transfer Mode Sets whether the FTP connection works in passive or active mode.

Fig. 5-61: FTP Configuration Fields
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On Failure Sets the action in the event of an upload failure, using the Retry 
Count and Interval values (if needed) in order to try to restore a 
connection.
The values are: 
Do nothing  No attempt is made to restore the connection and 

the task is propagated trough the Failed port.
Append If the transfer can be restored, it continues from 

where it stopped.
Restart A new transfer is started from the beginning, erasing 

the previous transfer.

Retry Count Active when you set the parameter On Failure to Append or 
Restart.
Sets the maximum number of attempts to restore a broken 
connection. This option is active if Append or Restart are selected as 
On Failure values. A minimum value of 1 is the default setting.

Interval Active when you set the parameter On Failure to Append or 
Restart.
Sets the number of attempts for the retry mode.

Check Consistence This option activates a post-transfer control that compares the size 
of a just transferred file against the size of the original file to verify 
that they are the same.

Port Allows you to specify a non-standard port for the FTP transfer, 
where this is required. By default, the FTP element uses the 
standard port 21.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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The tag <ftp> contains the configuration for this element.

MantricsServer.xml Configuration
<ftp>

<server port="8126">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</ftp>

MantricsNode.xml Configuration
<ftp slotCount="4">

<active>true</active>
<server port="8126">10.250.170.183</server>
<node port="8127">10.250.170.183</node>
<pool/>

</ftp>

File transfer: Signiant
The Signiant workflow element enables you to configure jobs to transfer files using the 
third party Signiant file transfer applications.

Element Settings Configuration
This element is available in the Automation > File Transfer folder and has the following 
settings:

Fig. 5-62: Signiant Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Username User name required to run the Signiant job.

Password Password required to run the Signiant job.

Job ID Unique identifier of the Signiant job. Also referred to as Job Name. 
For example: mam_export1234

Job Group Name of the Signiant Job grouping. For example: mam_sigxfer

Job Template Library Name of the library to which the job template belongs. For 
example: Sig_Lib

Job Template Name Name of the template used to run the Signiant job. For example: 
Job_Tmplt_START

Source Variable Name Variable to define the source file to transfer. For example: 
Job_Tmplt_START.filename_to_send
Note: The Source Variable must not be used in the Variables 
parameter described below.

Is Unix Path Check to specify that the source agent uses a UNIX path.

Fig. 5-63: Signiant Configuration Fields
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The tag <signiant> contains the configuration for this application.

MantricsServer.xml Configuration
<signiant>

<server port="8210">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</signiant>

MantricsNode.xml Configuration
<signiant slotCount="4">

<active>false</active>
<server port="8210">10.250.170.183</server>
<node port="8211">10.250.170.183</node>
<pool/>
<ipsigniant/>
<username>username</username>
<password>password</password>
<sourceAgentPathMap/>

</signiant>

Automation Grass Valley Workflow Elements
The Grass Valley group of workflow elements provides a BXF messaging interface with a 
Morpheus system, an interface with iTX and a generic Gateway Export interface. This group 
contains the following:

• BXF Morpheus Export 
• BXF Morpheus Query
• BXF Transfer Metadata Retriever

Variables Variables to define the transfer parameters. For example:
Job_Tmplt_START.localAgent=sig-agt001.playout.co.uk
Job_Tmplt_START.destinationAgent=sig-agt001.playout.co.uk
Job_Tmplt_START.emailAddress=rdfc44@gmail.com
Job_Tmplt_START.message=Signiant Transfer Complete
Job_Tmplt_START.destinationFolder=/mnt/server/momentum/
sigdestination

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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• Gateway Export 
• iTX

Grass Valley: BXF Morpheus Export
BXF messages are used to integrate Momentum with a Morpheus Playout Automation 
system and its database, or with another Momentum system. BXF Morpheus Export is one 
component of the set of BXF workflow elements in Momentum, with the others being BXF 
Receiver and BXF Morpheus Query.

The BXF Morpheus Export workflow element enables you to publish metadata available in 
Momentum to a Morpheus database, or to another Momentum, using BXF messaging. 

BXF Morpheus Export inserts or updates metadata as defined by the configuration of the 
Mode attribute, see the table on the following page. This metadata insert or update action 
can occur as a result of a transfer request being opened from a Morpheus system, or even 
without a transfer request being initiated.

For example, if you select the operational mode Complete Transfer, BXF Morpheus Export 
expects that a transfer request was previously opened. Once the BXF Morpheus Export 
element receives a transfer request for a Morpheus ID, then it sends a complete transfer 
message back to Morpheus. This BXF message will complete the transfer in MAPP and 
insert the material in the Morpheus database. Morpheus then returns an acknowledgment 
(ACK) to Momentum. 

Alternatively, If the operational mode is set to Import Content, Delete Content or Smart 
Import Content the BXF Morpheus Export element inserts or updates metadata without 
checking whether a transfer request exists for the specific Morpheus ID. In the event that a 
transfer request is open, BXF Morpheus Export does not complete the transfer request in 
these modes.

Element Settings Configuration
This element is available in the Automation > Grass Valley folder and has the following 
settings:

Fig. 5-64: BXF Morpheus Export Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Bxf Route Select one of the pre-configured BXF communication routes. BXF 
Routes are defined in the Momentum Admin page.
The BXF Agent section of the BXF Route sets the receiver mode of 
the BXF Receiver. You can choose whether the element monitors a 
watchfolder for the arrival of BXF message files or whether it uses a 
socket connection to an IP address and port. 
To set up a list of available BXF Routes, select Admin > BXF Routes.

Fig. 5-65: BXF Morpheus Export Configuration Fields
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Mode Sets the desired operational mode of the element, with the settings 
being:
Complete Transfer Request: Complete a transfer request 

associated with a specific 
Morpheus ID and originally 
received by a BXF Receiver 
element.

Delete Content: Delete an Item and/or Instance 
from the Morpheus database. This 
mode can check whether the 
operation is allowed in the 
Morpheus database if the Use 
Query checkbox is enabled.

Import Content: Add / Update an Item and/or 
Instance in the Morpheus 
database. This mode can check 
whether the operation is allowed 
in the Morpheus database if the 
Use Query checkbox is enabled.

Send Transfer Request: Sends a transfer request from 
Momentum either to another 
Momentum system or to a 
Morpheus system. The request 
can be either a File Transfer or a 
Purge.

Smart Import Content: Adds or updates an item and/or 
instance in the Morpheus 
database. The action (add or 
update) is decided after 
performing a query in the 
Morpheus database.

Each mode selected, opens additional configuration fields 
specifically for that mode.

Transfer Type When Mode is set to Send Transfer Request, defines the type of 
transfer request in the BXF message. You can select either: 
FileTransfer, Purge or Set Icon.
Note: A Purge transfer type message will trigger the deletion of the 
specified material from all devices in the Morpheus environment. 

Origin Specifies the originator of the BXF message, for example, 
MomentumSystem.
All BXF messages have an Origin attribute which must be set to the 
name of the originator of the message. This is free-form text string 
and is case-sensitive.

Option Description
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Destination Specifies the name of the Morpheus host shell service which 
processes the BXF messages. This is often the BXF Import Content 
Service. It contains the same value as the Processing Agent Name 
field in the BXF Import Content service.
BXF messages can use an optional attribute Destination that is 
used to decide which BXF agent should process a given message 
once it is placed in the Morpheus database. The BXF agents are 
configurable so that the destination they represent can be set as 
required, for example: SAM.BXF.ImportContentService.

Use Query Active when Transfer Type is set to Delete Content or Import 
Content. 
When enabled, checks whether the selected operation is allowed in 
the Morpheus database. Displays the field Query Destination and 
the Send Ack to Morpheus checkbox.
If you do not want to enable the Use Query option or use the mode 
Smart Import Content, you can achieve the same result by using a 
BXF Morpheus Query element in front of a BXF Morpheus Export 
element. 

Query Destination Active when you enable the Use Query checkbox.
Specifies the name of the Morpheus BXF Query host shell service 
which processes BXF Morpheus Query messages. For example:
If a Momentum system identifies itself with the name: 
MomentumSystem and you have configured the BXF Morpheus 
Query host shell service with the agent name: BXF Query Main 
System, when Momentum queries whether a material exists, it 
creates a BXF query message with the values of the Origin and 
Query Destination fields in the header: "MomentumSystem" and 
"BXF Query Main System". The Query header must match exactly 
and is case-sensitive.
The BXF Query service receives the message and immediately 
generates an acknowledgment (ACK) message to confirm receipt of 
the message and that the message will be processed, This new ACK 
message will invert the Origin and Destination in the header as: 
"BXF Query Main System" and "MomentumSystem".

Template Defines the BXF Export template selected from the list of available 
files stored in the folder: C:\Mantrics\BXFExportTemplates.
The default template (Default.xml) defines the following 
components of the BXF Export element:
BXF Metadata List: Contains the list of generic fields to set for the 
BXF Message, Every field has a default value but only some fields 
are mandatory for BXF message creation. If left empty, BXF Export 
uses the default values.
BXF Program and Non-Program Additional Metadata List: 
define additional metadata.
Custom Parameter List: define custom parameters for the BXF 
Export element.
Output Port: configurations for BXF Export actions.

Option Description
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Include Segments Checkbox is active when Modes Import Content and Smart 
Import Content are selected.
When enabled, includes segmentation information with the other 
content to be imported into the Morpheus database.

Delete Action Active when you select the mode Delete Content, the following 
options are available:
Remove Item - purges the specified Item from the Item table of the 
Morpheus database. If the target Item is not present in the 
Morpheus database, it returns an error in the BXF ACK message.
Update Item, Remove Instance - Updates the specified Item in the 
Item table of the Morpheus database and purges the specified 
Instance, if present, from the Instance table of the Morpheus 
database. If the target Item or Instance is not present in the 
Morpheus database, it returns an error in the BXF ACK message.

Import Action Active when you select the mode Import Content, the following 
options are available:
Add Item and Instance - Inserts the Item into the Item table of the 
Morpheus database and inserts the Instance into the Instance table. 
If either Item or Instance is already present in the Morpheus 
database, it returns an error in the BXF ACK message.
Update Item and Instance - Updates the Item in the Item table of 
the Morpheus database and updates the Instance in the Instance 
table. If either Item or Instance is not present in the Morpheus 
database, it returns an error in the BXF ACK message.
Update Item, Add Instance - Updates the Item in the Item table of 
the Morpheus database and inserts the Instance in the Instance 
table. If the Item is not present in Morpheus database, it returns an 
error in the BXF ACK message.

Ack Analysis For Quick ACK Analysis, Momentum simply checks whether or not 
an Ack is received and does not analyze other folders 
(e.g.,completed, failed, etc.) on Morpheus for further information. In 
general, it is recommended to use Quick ACK Analysis. In the event 
that an ACK/NACK is not received, the task is propagated through 
the Timeout port without any additional information.
For Detailed ACK Analysis, if Momentum does not receive an ACK/
NACK message it directs any failures to the failure port, for further 
processing or investigation of the completed and failed folders in 
Morpheus.
You can only use the Ack Analysis functions if the selected BXF 
Route is set-up for Watchfolder file communication. Do not use Ack 
Analysis with a BXF Route setup for Socket communication.

Wait for Ack Checkbox active when you select the mode Send Transfer 
Request.
When enabled, waits for receipt of an ACK message before 
progressing the task.

Option Description
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The tag <bxfexport> contains the configuration for this element.

MantricsServer.xml Configuration
<bxfexport>

<server port="8168">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<messageType/>
<origin/>
<originType/>
<userName/>
<checkDstFolderCount>0</checkDstFolderCount>
<retryDstFolderSeconds>0</retryDstFolderSeconds>
<AddDeleteAfterDays>60</AddDeleteAfterDays>

</bxfexport>

MantricsNode.xml Configuration
<bxfexport slotCount="4">

<active>false</active>

Interval (sec) Sets the interval, in seconds, that Momentum waits to receive an 
ACK/NACK from the Morpheus database When the Interval is 
exceeded, the task is propagated through the Timeout port,

Skip Complete Message Active when you select the mode Complete Transfer Request.
When selected all parameters relating to the Complete Transfer 
Request messages are hidden as the transfer is completed in the 
Momentum database without sending a BXF Complete Transfer 
message.

Origin ID in Ack Filename This field will be deprecated from Momentum version 5.1 and 
should not be used.
Momentum always includes the Origin ID in its ACK/NACK 
messages. When enabled, Momentum expects that the messages 
from Morpheus will contain the Origin ID.

Send Ack to Morpheus When enabled, sends an ACK/NACK message to the originating 
service (Morpheus) for all messages received, as appropriate.

Archive When selected, Momentum will archive a copy of all messages 
involved in the specific task, including queries, query responses, 
import content messages. and all ACKs/NACKs.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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<server port="8168">10.250.170.183</server>
<node port="8169">10.250.170.183</node>
<pool/>

</bxfexport>

Configuring the BXF Morpheus Export Message Template
For the element BXF Morpheus Export to export BXF messages in the correct format, at 
least one template file must be available. A default template file Default.xml is stored in 
the installation folder: C:\Mantrics\BXFExportTemplates\Default.xml.

More than one template file can be stored in the folder although they must all follow the 
rules of the structure described below. You can select the template to be used by the BXF 
Export workflow element from the Template drop-down menu in the Settings dialog of 
the workflow element.

To configure the BXF Export template settings:
• In a text editor, open the file: C:\Mantrics\BxfExportTemplates\ Default.xml

The file has the following structure:
<BXFExportTemplate>

<BXFMetadataList>
<BXFMetadata>

<Label>Notes</Label>
<Value>MomentumCore.MomentumCore.Notes</Value>
<Kind></Kind>

</BXFMetadata>
</BXFMetadataList>
<BXFProgrammeAdditionalMetadataList>

<BXFMetadata>
<Label></Label>
<XPath></XPath>
<Value></Value>
<Kind></Kind>

</BXFMetadata>
</BXFProgrammeAdditionalMetadataList>
<BXFNonProgrammeAdditionalMetadataList>

<BXFMetadata>
<Label></Label>
<XPath></XPath>
<Value></Value>
<Kind></Kind>

</BXFMetadata>
</BXFNonProgrammeAdditionalMetadataList>
<CustomParametersList>

<BXFMetadata>
<Label></Label>
<XPath></XPath>
<Value></Value>
<Kind></Kind>

</BXFMetadata>
</CustomParametersList>
<AddDaysToNowIfDeleteAfterIsNull>60

</AddDaysToNowIfDeleteAfterIsNull>
<TransferFilters>

<Filter>
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<Label></Label>
<Value></Value>

</Filter>
</TransferFilters>
<NackReceived_Port>failed</NackReceived_Port>
<Timeout_Port>failed</Timeout_Port>
<BxfInvalid_Port>failed</BxfInvalid_Port>
<MorpheusNotResponsive_Port>failed</MorpheusNotResponsive_Port>
<MessageLost_Port>failed</MessageLost_Port>
<ItemNotInMorpheus_Port>failed</ItemNotInMorpheus_Port>
<ItemAlreadyInMorpheus_Port>failed</ItemAlreadyInMorpheus_Port>
<InstanceNotInMorpheus_Port>failed</InstanceNotInMorpheus_Port>
<InstanceAlreadyInMorpheus_Port>failed
</InstanceAlreadyInMorpheus_Port>
<NoRequest_Port>failed</NoRequest_Port>
<TransferNotFound_Port>NotFound</TransferNotFound_Port>

</BXFTemplate>

These XML tags have the following functions:

Tag Description

BXFMetadataList Contains a list of the generic fields contained in the 
generated BXF message to be exported, Every field has a 
default value but only some fields are mandatory for the 
creation of the message. If the <BXFMetadataList> list is 
empty, BXF Export uses the default values: Label Value Kind.
Collects all the metadata to be included in the BXF message 
being exported from Momentum.
The tag <Label> is used to mark the metadata in the BXF file. 
The value is specified using the extended ID of the metadata 
in the Momentum system and can be retrieved in the Admin 
page Metadata, in the Metadata ID field.
The tag <Value> is the value given to the metadata specified 
in <Label>. The tag <Kind> specifies whether the metadata 
is taken from the Title or the Instance of the related material.

BXFProgrammeAdditional
MetadataList

Collects the metadata specific to the materials belonging to 
the category Programme that have to be exported from 
Momentum. The tags <Label>, <Value> and <Kind> have 
the same functions as described above.
The tag <XPath> specifies the XML path to map the value 
stored in the related <Value> tag to a specific node of the 
BXF message structure.

BXFNonProgrammeAdditio
nalMetadataList

Collects the metadata specific to the materials belonging to 
categories other than Programme that have to be exported 
from Momentum. The tags <Label>, <Value>, <Kind> and 
<Xpath> of the list are the same as described previously.
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Grass Valley: BXF Morpheus Query
BXF messages are used to integrate Momentum with a Morpheus Playout Automation 
system and its database, or with another Momentum system. BXF Morpheus Query is one 
component of the set of BXF elements in Momentum, with the others being BXF 
Morpheus Export and BXF Receiver.

The BXF Morpheus Query workflow element enables you to query the Morpheus 
database for the existence of specific material in a playlist or for playlists using specific 
material, with the returned data in BXF message format. This element can query the 
following:

• Whether a specific Material exists in the Morpheus database.
• Whether an Instance on a specific device exists in the Morpheus database.

Element Settings Configuration
This element is available in the Automation > Grass Valley folder and has the following 
settings:

CustomParametersList Collects the metadata specific to the materials belonging to 
any custom parameters that have to be exported from 
Momentum. The tags <Label>, <Value>, <Kind> and 
<Xpath> of the list are the same as described previously.

TransferFilters Collects a list of Transfer Request metadata with specific 
values to filter out a unique Transfer Request to complete 
that matches the filter values. If the list of metadata is empty, 
there must not be more than one Transfer Request related to 
the specific route and Morpheus ID.

Output Port Configurations Use to configure the output ports. You can map an action, 
whether successful or not to a designated port.

Tag Description

Fig. 5-66: BXF Morpheus Query Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Bxf Route Select one of the pre-configured BXF communication routes. BXF 
Routes are defined in the Momentum Admin page.
The BXF Agent section of the BXF Route sets the receiver mode of 
the BXF Receiver. You can choose whether the element monitors a 
watchfolder for the arrival of BXF message files or whether it uses a 
socket connection to an IP address and port.
To set up a list of available BXF Routes, select Admin > BXF Routes.

Origin Specifies the originator of the BXF message, for example, 
MomentumSystem.
All BXF messages have an origin attribute which must be set to the 
name of the originator of the message. This is free-form text and is 
case-sensitive.

Destination Specifies the name of the Morpheus host shell service which 
processes the BXF messages. 
BXF messages can have an optional attribute Destination that is 
used to decide which BXF agent should process a given message 
once it is placed in the Morpheus database. The BXF agents are 
configurable so that the destination they represent can be set as 
required. For example: SAM.BXF.ScheduleQuery for a query service.
This option specifies the destination of the query as the BXF Query 
workflow element enables you to perform only query actions. As a 
result, you need to know the agent name of the Query Service.

Fig. 5-67: BXF Morpheus Query Configuration Fields
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Template Defines the BXF Query template selected from the list of available 
files stored in the folder: C:\Mantrics\BXFQueryTemplates.
The default template (Default.xml) defines the following 
components of the BXF Query element:
Material Type - set the type of Notifier messages to skip, if any.
MorpheusID, DeviceID, LongFileID
Output Port configurations for BXF Query actions.

Mode Sets the type of query that you want the element to perform in the 
target Morpheus database. The following options are available:
Item Only: Queries the Morpheus database Item table 

for the presence of an Item.
Item and Instance: Queries both the Morpheus database Item 

and Instance tables for the presence of an 
Item and Instance.

Instance Only: Queries the Morpheus database Instance 
table for the presence of an Instance.

Ack Analysis For Quick ACK Analysis, Momentum simply checks whether or not 
an Ack is received and does not analyze other folders 
(e.g.,completed, failed, etc.) on Morpheus for further information. In 
general, it is recommended to use Quick ACK Analysis.In the event 
that an ACK/NACK is not received, the task is propagated through 
the Timeout port without any additional information.
For Detailed ACK Analysis, if Momentum does not receive an ACK/
NACK message it directs any failures to the failure port, for further 
processing or investigation of the completed and failed folders in 
Morpheus.
You can only use the Ack Analysis functions if the selected BXF 
Route is set-up for Watchfolder file communication. Do not use Ack 
Analysis with a BXF Route setup for Socket communication.

Interval (sec) Sets the interval, in seconds, that Momentum waits to receive an 
ACK/NACK from the Morpheus database When the Interval is 
exceeded, the task is propagated through the Timeout port,

Origin ID in Ack Filename This field will be deprecated from Momentum version 5.1 and 
should not be used.
Momentum always includes the Origin ID in its ACK/NACK 
messages. When enabled, Momentum expects that the messages 
from Morpheus will contain the Origin ID.

Send Ack to Morpheus When enabled, sends an ACK/NACK message to the originating 
service (Morpheus) for all messages received, as appropriate.

Archive When selected, Momentum will archive a copy of all messages 
involved in the specific task, including queries, query responses, 
import content messages. and all ACKs/NACKs.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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The tag <bxfquery> contains the configuration for this element.

MantricsServer.xml Configuration
<bxfquery>

<server port="8218">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</bxfquery>

MantricsNode.xml Configuration
<bxfquery slotCount="4">

<active>false</active>
<server port="8218">10.250.170.183</server>
<node port="8219">10.250.170.183</node>
<pool/>

</bxfquery>

Configuring the BXF Query Message Template
For the element BXF Query to generate BXF Queries in the correct format, at least one 
template file must be available. A default, template Default.xml is stored in the default 
installation folder: C:\Mantrics\BXFQueryTemplates.

More than one template file can be stored in the folder although they must all follow the 
rules of the structure described below. You can select the template to be used by the BXF 
Query workflow element from the Template drop-down menu in the Settings dialog of 
the element.

To configure the BXF Query template settings:
• In a text editor, open the file: C:\Mantrics\BxfQueryTemplates\Default.xml

The file has the following structure:
<?xml version="1.0"?>

<BXFQueryTemplate>
<MaterialType>

<Value>MomentumCore.MomentumCore.MATERIAL_TYPE</Value>
<Kind>TITLE</Kind>

</MaterialType>
<MorpheusId>

<Value>MomentumCore.MomentumCore.MORPHEUS_ID</Value>
<Kind>TITLE</Kind>

</MorpheusId>
<DeviceId>

<Value>MomentumInstance.MomentumInstance.DEVICE_ID
</Value>
<Kind>MEDIAASSET</Kind>

</DeviceId>
<LongFileId>

<Value>MomentumInstance.MomentumInstance.LONG_FILE_ID
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</Value>
<Kind>MEDIAASSET</Kind>

</LongFileId>
<NackReceived_Port>failed</NackReceived_Port>
<Timeout_Port>failed</Timeout_Port>
<BxfInvalid_Port>failed</BxfInvalid_Port>
<MorpheusNotResponsive_Port>failed
</MorpheusNotResponsive_Port>
<MessageLost_Port>failed</MessageLost_Port>
<ItemNotInMorpheus_Port>failed</ItemNotInMorpheus_Port>
<InstanceNotInMorpheus_Port>failed
</InstanceNotInMorpheus_Port>
<ItemAndInstanceNotInMorpheus_Port>failed
</ItemAndInstanceNotInMorpheus_Port>
<OnlyItemInMorpheus_Port>failed</OnlyItemInMorpheus_Port>

</BXFQueryTemplate>

These XML tags have the following functions:

Tag Description

MaterialType Contains a list of the standard Morpheus material types 
(Programme, Commercial, Live, Live Record, Junction, etc.)
The tag <Value> is a Metadata Id if Kind is TITLE or 
MEDIAASSET, the value can be rendered if Kind is set to 
NOMETADATA. The tag <Kind> specifies whether the 
metadata is taken from the Title or the Instance of the 
related material.

MorpheusId ID of the target Morpheus system, for example;
<MorpheusId>
<Value>MomentumCore.MomentumCore.

MORPHEUS_ID</Value>
<Kind>TITLE</Kind>

</MorpheusId>

DeviceId For a given list of devices, Momentum queries the MAPP 
database for all the instances on that device 
Specifies a list of devices by Device ID of a single video 
server, for example:
<DeviceId>
<Value>MomentumInstance.MomentumInstance.

DEVICE_ID
</Value>
<Kind>MEDIAASSET</Kind>

</DeviceId>

LongFileID Specifies the LongFileID to restrict a query of the MAPP 
database, together with DeviceID

Output Port Configurations Use to configure the output ports. You can map an action, 
whether successful or not to a designated port.
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The BXF Transfer Metadata Retriever workflow element enables you to retrieve values 
from a BXF Transfer Request message and save the values, as a string, to a metadata field.

You can configure the workflow element to select a Transfer Request by matching a specific 
Job ID, or to a list of transfers related to a RouteID, MorpheusID and configurable filter 
criteria.

This workflow element extracts the value of the matching metadata from the selected 
Transfer Requests and writes the value(s) to a metadata value associated with the Title or 
the Media Asset. You can also configure the element to propagate the task through a 
specific port named after the metadata value.

Element Settings Configuration
This element is available in the Automation > Grass Valley folder and has the following 
settings:

Note: The target metadata for the BXF Transfer Metadata Retriever element 
must be of the data type string.

Fig. 5-68: BXF Transfer Metadata Retriever Workflow Element

Fig. 5-69: BXF Transfer Metadata Retriever Configuration Fields
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The tag <technical MetadataRetriever> contains the configuration for this element.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Template Defines the BXF Transfer Metadata Retriever template selected 
from the list of available files stored in the folder: 
C:\Mantrics\BXFTransferMetadataRetrieverTemplates.
The default template (Default.xml) defines the following 
components of the BXF Transfer Metadata Retriever element:
Transfer Filters - set filters to select specific transfer requests.
Propagation Case - set whether the metadata case is significant 
when using the Use Metadata to Propagate option.
Output Port - port configuration for matched and unmatched 
transfer requests.
For more information on the template settings, see Configuring the 
BXF Transfer Metadata Retriever Template, on page 109

Filter Mode Sets the mode used to filter Transfer Requests received from the 
Morpheus database. The following options are available:
UseFilterSection - Select a transfer request, with a status of open, 
that matches the filter criteria specified in the section 
<TransferFilters> of the template 
BXFTransferMetadataRetrieverTemplate. On matching, the 
element extracts the specific metadata field and creates a string by 
concatenating the values.
UseJobId - Select a transfer request, with a status of open, that 
matches a specific JobID. On matching, the element extracts the 
specific metadata field and creates a string by concatenating the 
values.

Enable Metadata Setting When checked, displays fields to specify the type of target material, 
the specific metadata element and its value.

Material Kind Only displayed when Enable Metadata Setting checked.

Metadata Only displayed when Enable Metadata Setting checked.

Value Only displayed when Enable Metadata Setting checked.

Use Metadata To 
Propagate

When checked, uses the value of the transfer metadata as port 
name to propagate the task. You can use the BXF Transfer Metadata 
Retriever Template to specify whether the case of the metadata is 
significant when propagating the task using the value of the 
metadata.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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MantricsServer.xml Configuration
<technicalMetadataRetriever>

<server port="8642">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</technicalMetadataRetriever>

MantricsNode.xml Configuration
<technicalmetadataretriever slotCount="4">

<active>true</active>
<server port="8642">10.250.170.183</server>
<node port="8643">10.250.170.183</node>
<pool/>

</technicalmetadataretriever>

Configuring the BXF Transfer Metadata Retriever Template
To enable the workflow element BXF Transfer Metadata Retriever to extract metadata 
from a Transfer Request in the correct format, at least one template file must be available. A 
default template Default.xml is provided in the default installation folder: 
C:\Mantrics\BxfTransferMetadataRetrieverTemplates.

You can configure multiple template files as required and save them in this folder, however,  
they must all follow the rules of the structure described below. You can select the template 
to be used by the BXF Transfer Metadata Receiver workflow element from the Template 
drop-down menu in the Settings dialog of the element.

To configure the Transfer Metadata Retriever template settings:

In a text editor, open the file: 
C:\Mantrics\BxfTransferMetadataRetrieverTemplates\Default.xml

The file has the following structure:
<?xml version="1.0"?>
<BXFTransferMetadataRetrieverTemplate>

<MetadataLabelToRetrieve/>
<TransferFilters>

<Filter>
<Label></Label>
<Value></Value>

</Filter>
</TransferFilters>
<PropagationCase>SENSITIVE</PropagationCase>
<TransfersMatch_Port>ok</TransfersMatch_Port>
<TransferUnMatch_Port>failed</TransferUnMatch_Port>

</BXFTransferMetadataRetrieverTemplate>

These XML tags have the following functions:
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Grass Valley: Gateway Export
The Gateway Export workflow element enables you to export material metadata in 
Morpheus Gateway XML format. This is useful for segmented material metadata as it can be 
exported to a single file. It resides in the SAM folder in the Automation group of elements.

Tag Description

MetadataLabelToRetrieve Contains the label of the transfer request metadata from 
which you want to extract the value.

TransferFilters Groups filter conditions to match the transfer request.
In this section you can specify a list of transfer metadata 
which match specific values, to filter out a selection of the 
transfer requests. If the list is empty, you take all the transfer 
requests related to a Route ID and a Morpheus ID.

Filter Defines each filter criterion for the target transfer requests.

Label Defines the metadata to match, to obtain a selection of the 
transfer requests.

Value Defines the metadata value to extract from the transfer 
request message. If the list is empty, you take all the transfers 
related to the Route ID and Morpheus ID.

PropagationCase Only used when the Settings parameter Use Metadata To 
Propagate is checked. In this case, Momentum uses the 
value of the transfer metadata as the output port name to 
propagate the task.
This field enables you to specify whether to use the value as 
case-sensitive (SENSITIVE), in upper-case (UPPER) or in 
lower-case (LOWER). Leave blank to ignore the case of the 
value.

TransfersMatch_Port You can specify a port name to propagate the task if at least 
one transfer request matches the filter criteria. This port is 
used only if the Settings parameter Use Metadata To 
Propagate is unchecked or if the Settings parameter Filter 
Mode is set to UseFilterSection.

TransferUnMatch_Port You can specify a port name to propagate a task if no transfer 
request matches the filter criteria.

Note: It is recommended to use the workflow element BXF M orpheus Export 
in preference to the Gateway Export as it is planned to deprecate this 
element in Momentum version 5.1.
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This element is available in the Grass Valley > File Transfer folder and has the following 
settings:

Fig. 5-70: Gateway Export Workflow Element

Option Description

Name Sets a label for the element.

Color Enables the user to select a color in order to easily identify the 
element on the Dashboard page. Black is equivalent to no color.

Device_ID Specifies the Morpheus’s Device ID for a storage device.

Watchfolder Sets the path to the directory to be monitored.

Completed Folder Specifies the location in which the completed Gateway XML file is 
placed if the process is successful.

Error Folder Specifies the location in which the completed Gateway XML file is 
placed if the message is invalid.

Fig. 5-71: Gateway Export Configuration Fields
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The tag <xmlGatewayExport> contains the configuration for this element.

MantricsServer.xml Configuration
<xmlGatewayExport>

<server port="8188">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<XmlWithoutTaskId>false</XmlWithoutTaskId>
<isTitleMandatory>false</isTitleMandatory>
<momentumCoreMandatoryFields/>
<momentumInstanceMandatoryFields/>
<areEmptyFieldsVisible>false</areEmptyFieldsVisible>
<isKeySegmentTimecodeOutNotEmpty>false

</isKeySegmentTimecodeOutNotEmpty>
<checkDstFolderCount>0</checkDstFolderCount>
<retryDstFolderSeconds>0</retryDstFolderSeconds>

</xmlGatewayExport>

These XML tags have the following functions:

Duplicated Folder Specifies the location in which the completed Gateway XML file is 
placed if the file already exists.

File Name Sets the name of the metadata file to export.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Tag Description

isTitleMandatory Specifies whether the Title field in the 
XMLGateway message is to be initialized. Tasks 
for messages which do not match this setting 
automatically fail.

momentumCoreMandatoryFields Collects all of the tags required to specify 
mandatory fields using the tag 
<momentumCoreMandatoryField>.

momentumCoreMandatoryField Specifies a single Momentum Core field to be 
initialized in the XML message. Tasks for 
messages which do not match this setting 
automatically fail.

momentumInstanceMandatoryFields Collects all of the tags required to specify 
mandatory fields using the tag 
<momentumInstanceMandatoryField>
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<areEmptyFieldsVisible>false</areEmptyFieldsVisible>
<isKeySegmentTimecodeOutNotEmpty>false

</isKeySegmentTimecodeOutNotEmpty>
<checkDstFolderCount>10</checkDstFolderCount>
<retryDstFolderSeconds>30</retryDstFolderSeconds>

MantricsNode.xml Configuration
<xmlgatewayexport slotCount="4">

<active>false</active>
<server port="8188">10.250.170.183</server>
<node port="8189">10.250.170.183</node>
<pool/>

</xmlgatewayexport>

Grass Valley: iTX
The iTX workflow element enables Momentum to register content with an iTX or iTX Flex 
system and deliver media for playout. It is assumed that content is ingested into 
Momentum by way of a Watchfolder.

The Signiant workflow element enables you to configure jobs to transfer files using the 
third party Signiant file transfer applications.

momentumInstanceMandatoryField Specifies a single Momentum Instance field to 
initialize in the XML message (use one or more 
tags as needed). Tasks for messages which do 
not match this setting automatically fail.

areEmptyFieldsVisible Creates an XML message, formatted in a 
compact way, which hides all empty fields.

isKeySegmentTimecodeOutNotEmpty Specifies if the Segment Timecode Out field of 
the XML message needs to be initialized.

checkDstFolderCount Sets the maximum number of checks done by 
Momentum to verify if Morpheus has screened 
the XML message, copying it to one of the 
directories specified in the related element 
parameters.

retryDstFolderSeconds Defines the amount of time elapsed between 
two consecutive checks.

Tag Description
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This element is available in the Automation > Grass Valley folder and has the following 
settings:

Fig. 5-72: iTX Workflow Element

Option Description

Name Sets a label for the element.

Color Enables the user to select a color in order to easily identify the 
element on the Dashboard page. Black is equivalent to no color.

Template Provides access to the iTX templates used to communicate with the 
iTX system.
Used to define media assets that can be imported into an iTX 
system.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-73: iTX Configuration Fields
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The iTX workflow element is not configured in either MantricsServer.xml or 
MantricsNode.xml.

MantricsServer.xml Configuration
Not applicable for the iTX element.

MantricsNode.xml Configuration
Not applicable for the iTX element.

Automation House-keeping Workflow Elements
The Housekeeping group of workflow elements provides an element to delete material that 
is no longer required.

This group contains the workflow element:
• Material Deletion 

House-keeping: Material Deletion
The Material Deletion workflow element enables you to remove an item of material (and 
its instances, if specified) from the Momentum database. If configured, this workflow 
element can also delete clips from an sQ Server. It resides in the House Keeping folder of 
the Automation group of elements.

Fig. 5-74: Schematic Overview of Communication Between  Momentum and iTX
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This element is available in the Automation > House Keeping folder and has the following 
settings:

Fig. 5-75: Material Deletion Workflow Element

Option Description

Name Sets a label for the element.

Color Enables the user to select a color in order to easily identify the 
element on the Dashboard page. Black is equivalent to no color.

Fig. 5-76: Material Deletion Configuration Fields
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Title Specifies that the Title is to be deleted. If selected, the other 
parameters can be set to delete everything related to the title. For 
the MediaAsset, Audiotrack, Subtitle, Proxy and Thumbnails 
parameters, you can select whether to delete both the instances 
and the files, or preserve the file while deleting the instances’ data.
Selecting this checkbox also activates the Clear History checkbox.

Current instance Specifies that the currently selected instance into the workflow, of 
the material is the one undergoing deletion.

MediaAsset label Specifies the value of the label for which a media asset can be 
deleted. Multiple entries, comma separated, are permitted.

MediaAsset Specifies which parts of the MediaAsset are to be deleted. The 
choices are: File, Instance, InstanceAndFile or None. When the Title 
is active, only the Instance and InstanceAndFile values are available.

Proxy Specifies which type of Proxy instance is deleted. The options are: 
Instance, InstanceAndFile, None.

Audiotrack label Specifies the value of the label for which an audio track can be 
deleted. Multiple entries, comma separated, are permitted.

Audiotrack Specifies which part of the audio track is to be deleted. The choices 
are: File, Instance, InstanceAndFile or None. When the Title is active, 
only the Instance and InstanceAndFile values are available.

Subtitle label Specifies the value of the label for which a subtitle can be deleted. 
Multiple entries, comma separated, are allowed.

Subtitle Specifies which part of the subtitle is to be deleted. The choices are: 
File, Instance, InstaceAndFile or None. When the Title is active, only 
the Instance and InstanceAndFile values are available.

Auxiliary label Selects the auxiliary entity to be deleted by the Material Deletion 
element. Auxiliary files associated with a generic object include files 
of format: txt, pdf, pac, doc, docx, etc.)

Auxiliary Select the deletion mode for the type of auxiliary entity that should 
be deleted from: File, Instance, InstanceAndFile, or None.

Thumbnail Specifies which part of the Thumbnail is to be deleted. The choices 
are: File, Instance, InstaceAndFile or None. When the Title is active, 
only the Instance and InstanceAndFile values are available.

Ignore file deletion error Enables you to delete the data in the database and the related 
structures even if the files are not accessible. If this option is not 
active, when a file is not accessible, the data and data structure 
related to this item are retained in the database.

Clear History Enables you to clear the tasks recorded in the job history related to 
an item of material when a Material Deletion workflow element 
deletes that material. When selected, Momentum will remove the 
task history for material that is no longer present in the system.
This checkbox is only enabled if the checkbox Title is enabled.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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Configuration Files
The tag <materialDeletion> contains the configuration for this element.

MantricsServer.xml Configuration
<materialDeletion>

<server port="8158">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</materialDeletion>

MantricsNode.xml Configuration
<materialdeletion slotCount="4">

<active>true</active>
<server port="8158">10.250.170.183</server>
<node port="8159">10.250.170.183</node>
<pool/>

</materialdeletion>

Automation Imagine Communications Workflow Elements
The Imagine Communications group of workflow elements provides elements to connect 
to a Harris database to extract or update material and/or metadata.

This group contains the elements:
• Harris Data Import
• Harris Data Updater

Imagine Communications: Harris Data Import
The Harris Data Import workflow element enables you to connect to a Harris database 
system to retrieve segments and materials metadata.

Fig. 5-77: Harris Data Import Workflow Element
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Element Settings Configuration
This element is available in the Automation > Imagine Communications folder and has 
the following settings:

Configuration Files
The tag <harrisDataImport> contains the configuration for this element.

MantricsServer.xml Configuration
<harrisDataImport>

<server port="8540">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</harrisDataImport>

MantricsNode.xml Configuration
<harrisdataimport slotCount="4">

<active>false</active>
<server port="8540">10.250.170.183</server>

Option Description

Name Sets a label for the element.

Color Enables the user to select a color in order to easily identify the 
element on the Dashboard page. Black is equivalent to no color.

Server Specifies the SQL Server Address.

Database Sets the target database to be accessed.

User ID Allows the specified user access to the specified database.

Password Sets the user’s password for access to the specified database.

Pool Sets the name of the pool associated with the element.

Fig. 5-78: Harris Data Import Configuration Fields
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Imagine Communications: Harris Data Updater
<node port="8541">10.250.170.183</node>
<pool/>

</harrisdataimport>

Imagine Communications: Harris Data Updater
The Harris Data Updater workflow element enables you to connect to a Harris system to 
update media asset metadata in the Harris database.

Element Settings Configuration
This element is available in the Automation > Imagine Communications folder and has 
the following settings:

Fig. 5-79: Harris Data Updater Workflow Element

Option Description

Name Sets a label for the element.

Color Enables the user to select a color in order to easily identify the 
element on the Dashboard page. Black is equivalent to no color.

DNS Sets the Domain Name System (DNS) name of the target database 
server to be accessed.

User ID Allows the specified user access to the Harris database.

Fig. 5-80: Harris Data Updater Configuration Fields
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Configuration Files
The tag <??> contains the configuration for this application.

MantricsServer.xml Configuration
TBA

MantricsNode.xml Configuration
TBA

Automation Social Workflow Elements
The Social group of workflow elements provides elements either to publish material to or 
remove material from various social media websites.

This group contains the elements:
• Publish To Dailymotion
• Publish To Facebook
• Publish To Twitter
• Publish To Youtube
• Delete From Dailymotion
• Delete From Facebook
• Delete From Twitter
• Delete From Youtube

Social: Publish to Dailymotion
The Publish to Dailymotion workflow element enables you to publish text and/or 
videocontent (the instance) on the social network website Dailymotion. In addition, you 
can create a new instance, using the Social Instance schema in the Catalog, to track the 
published material.

Password Sets the user’s password for access to the Harris database.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

Fig. 5-81: Publish to Dailymotion Workflow Element

Option Description

Name Sets a label for the element.

Color Enables the user to select a color in order to easily identify the 
element on the Dashboard page. Black is equivalent to no color.

Target The target profile for the publishing action selected from the list of 
target profiles already defined in the Momentum Admin > Social 
page.

Post Title The content to be published to the Dailymotion site. 

Label The label of the new Social instance.

Switch new instance When selected, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-82: Publish to Dailymotion Configuration Fields
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Configuration Files
The tag <publishtodailymotion> contains the configuration for this element.

MantricsServer.xml Configuration
<publishtodailymotion>

<server port="8700">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</publishtodailymotion>

MantricsNode.xml Configuration
<publishtodailymotion slotCount="4">

<active>false</active>
<server port="8700">127.0.0.1</server>
<node port="8703">127.0.0.1</node>
<pool/>

</publishtodailymotion>

Social: Publish to Facebook
The Publish to Facebook workflow element enables you to publish text and/or video 
content (the instance) to pre-configured target Facebook sites. In addition, you can create a 
new instance, using the Social Instance schema in the Catalog, to track the published post.

Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

Note: Registration on the Dailymotion page uses the OAuth 2.0 authorization 
protocol, which requires you0 to configure your browser to allow pop-
ups.

Fig. 5-83: Publish to Facebook Workflow Element
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Configuration Files
The tag <publishtofacebook> contains the configuration for this element.

MantricsServer.xml Configuration
<publishtofacebook>

<server port="8686">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Target The target Facebook profile for the publishing action selected from 
the list of target profiles already defined in the Momentum Admin 
> Social page.

Post Text The content to be included in the post. You can use variables in 
this field, for example {dateTime.Now}:{Core.Description}

Label The label of the new Social instance.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: Registration on the Facebook page uses the OAuth authorization 
protocol, which requires you to configure your browser to allow pop-
ups.

Fig. 5-84: Publish to Facebook Configuration Fields
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<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</publishtofacebook>

MantricsNode.xml Configuration
<publishtofacebook slotCount="4">

<active>false</active>
<server port="8686">127.0.0.1</server>
<node port="8687">127.0.0.1</node>
<pool/>

</publishtofacebook>

Social: Publish to Twitter
The Publish to Twitter workflow element enables you to publish text and/or video content 
(the instance) on the social network website Twitter. In addition, you can create a new 
instance, using the Social Instance schema in the Catalog, to track the published tweet.

Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

Fig. 5-85: Publish to Twitter Workflow Element

Fig. 5-86: Publish to Twitter Configuration Fields
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The tag <publishtotwitter> contains the configuration for this element.

MantricsServer.xml Configuration
<publishtotwitter>

<server port="8690">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</publishtotwitter>

MantricsNode.xml Configuration
<publishtotwitter slotCount="4">

<active>false</active>
<server port="8690">127.0.0.1</server>
<node port="8691">127.0.0.1</node>
<pool/>

</publishtotwitter>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Target The target Twitter profile for the publishing action selected from the 
list of target profiles already defined in the Momentum Admin > 
Social page.

Tweet Text The content to be included in the tweet. Note: as you can enter 
variables in this field, Momentum does not check the number of 
characters at this point.

Label The label of the new Social instance.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: Registration on the Twitter site uses the OAuth authorization protocol, 
which requires you to configure your browser to allow pop-ups.
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Social: Publish to YouTube
The Publish to YouTube workflow element enables you to publish video and/or playlists 
(the instance) direct to a YouTube channel. This element uses the YouTube API to automate 
the publishing process.

Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

Note: The material may need to be submitted to a transcoder as part of the 
publishing process.

Fig. 5-87: Publish to YouTube Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Target The target YouTube profile for the publishing action selected from 
the list of target profiles already defined in the Momentum Admin 
> Social page.

Fig. 5-88: Publish to YouTube Configuration Fields
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Element Settings Configuration
The tag <publishtoyoutube> contains the configuration for this element.

MantricsServer.xml Configuration
<publishtoyoutube>

<server port="8704">0.0.0.0</server>

Label The label of the new Social instance.

Description A description of the published video to convey information that 
helps viewers find your videos in search results and understand 
what they’ll be watching. 

Tags Descriptive keywords you can add to your video to help people find 
your content. You can also add tags to change the appearance and 
format of your video on YouTube and on embedded players.

Category YouTube category in which the published content is included.
Content categories are used by YouTube to organize channels and 
videos, helping publishers to target specific audiences. 
Categories include: Autos & vehicles, comedy, education, 
entertainment, film & animation, people & blogs, pets & animals, 
science & technology, sports, travel & events.

Privacy Defines the privacy status applied to the published content. Privacy 
status options are: 
Private: Videos and playlists can only be seen by you and the 

users you choose. Private videos do not appear to 
other visitors of the Videos tab on your channel page 
and do not appear in YouTube search results.

Public: Videos can be seen by, and shared with, anyone 
using YouTube; they are posted on your channel 
when uploaded and appear in search results and 
related video lists.

Scheduled: Schedule a private video to go public at a specific 
time.

Unlisted: Videos and playlists can be seen and shared by 
anyone with the link. Unlisted videos do not appear 
to others who visit the Videos tab of your channel 
page and do not show up in YouTube search results 
unless added to a public playlist. 

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: Registration on the Youtube site uses the OAuth 2.0 authorization 
protocol, which requires you to configure your browser to allow pop-
ups.

Option Description
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<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</publishtoyoutube>

MantricsNode.xml Configuration
<publishtoyoutube slotCount="4">

<active>false</active>
<server port="8704">127.0.0.1</server>
<node port="8705">127.0.0.1</node>
<pool/>

</publishtoyoutube>

Social: Remove from Dailymotion
The Remove from Dailymotion workflow element enables you to delete text and/or video 
content (the instance) from the social network website Dailymotion.

Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

Fig. 5-89: Remove from Dailymotion Workflow Element

Fig. 5-90: Remove from Dailymotion Configuration Fields
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Configuration Files
The tag <removefromdailymotion> contains the configuration for this element.

MantricsServer.xml Configuration
<removefromdailymotion>

<server port="8702">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</removefromdailymotion>

MantricsNode.xml Configuration
<removefromdailymotion slotCount="4">

<active>false</active>
<server port="8702">127.0.0.1</server>
<node port="8703">127.0.0.1</node>
<pool/>

</removefromdailymotion>

Social: Remove from Facebook
The Remove from Facebook workflow element enables you to remove published material 
(text and/or video content - the instance) from the target Facebook sites.

Option Description

Name Sets a label for the element.

Color Enables the user to select a color in order to easily identify the 
element on the Dashboard page. Black is equivalent to no color.

Target Identifies the target material you want to remove from the 
Dailymotion website.

Remove Mode Defines the method used to remove the target material.
Options are: Instance, InstanceandPost, or Post.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

Configuration Files
The tag <removefromfacebook> contains the configuration for this element.

MantricsServer.xml Configuration
<removefromfacebook>

<server port="8688">0.0.0.0</server>

Fig. 5-91: Remove from Facebook Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Target The target Facebook page from which you want to remove the 
post. This option is required for security reasons as Momentum 
does not save the access token in the Instance metadata.

Remove Mode Enables you to select whether to remove only the instance, both 
instance and post, or only the post from the target page.
Options are: Instance, InstanceAndPost, Post.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-92: Remove from Facebook Configuration Fields
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Social: Remove from Twitter
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</removefromfacebook>

MantricsNode.xml Configuration
<removefromfacebook slotCount="4">

<active>false</active>
<server port="8688">127.0.0.1</server>
<node port="8689">127.0.0.1</node>
<pool/>

</removefromfacebook>

Social: Remove from Twitter
The Remove from Twitter workflow element enables you to delete text and/or video 
content (the instance) from the social network website Twitter.

Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

Fig. 5-93: Remove from Twitter Workflow Element

Fig. 5-94: Remove from Twitter Configuration Fields
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The tag <removefromtwitter> contains the configuration for this element.

MantricsServer.xml Configuration
<removefromtwitter>

<server port="8692">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</removefromtwitter>

MantricsNode.xml Configuration
<removefromtwitter slotCount="4">

<active>false</active>
<server port="8692">127.0.0.1</server>
<node port="8693">127.0.0.1</node>
<pool/>

</removefromtwitter>

Social: Remove from YouTube
The Remove from YouTube workflow element enables you to remove a video or playlist 
from the YouTube website.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Target The target Twitter profile from which you want to remove the 
tweet. This option is required for security reasons as Momentum 
does not save the access token in the Instance metadata.

Remove Mode Enables you to select whether to remove only the instance, both 
instance and tweet, or only the tweet.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-95: Remove from YouTube Workflow Element
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Element Settings Configuration
This element is available in the Automation > Social folder and has the following settings:

The tag <removefromyoutube> contains the configuration for this element.

MantricsServer.xml Configuration
<removefromyoutube>

<server port="8706">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<validationTimeoutInSec>30</validationTimeoutInSec>

</removefromyoutube>

MantricsNode.xml Configuration
<removefromyoutube slotCount="4">

<active>false</active>
<server port="8706">127.0.0.1</server>
<node port="8707">127.0.0.1</node>
<pool/>

</removefromyoutube>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Target The target material you want to remove from YouTube.

Remove Mode Enables you to select whether to remove only the instance, both 
instance and post, or only the post.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-96: Remove from YouTube Configuration Fields
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Miscellaneous Automation Workflow Elements
The remaining miscellaneous workflow elements are ungrouped and provide elements to 
automate different aspects of your workflows.

Th miscellaneous elements are:
• Add To Project
• End
• Etere Xml Exporter
• Go To
• Instance Switcher
• Key Segmentator
• Metadata Publisher
• Remove From Project
• Send Mail
• Send To...
• Set Metadata
• Set Priority
• Sleep
• Technical Metadata Retriever

Automation: Add to Project
The Add to Project workflow element enables you to associate an item of material with a 
specific project.

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Fig. 5-97: Add to Project Workflow Element
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The Add to Project element has a port Not Applicable to manage situations where the 
Material may already be included in the selected project, or the Material may not be a TITLE 
so the action cannot be applied.

Configuration Files
The tag <setproject> contains the configuration for this element.

MantricsServer.xml Configuration
<setproject>

<server port="8150">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</setproject>

MantricsNode.xml Configuration
<setproject slotCount="4">

<active>true</active>
<server port="8150">10.250.170.183</server>
<node port="8151">10.250.170.183</node>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Project Enables you to select a project from the available list of projects. 
You can create new projects in the Catalog page by selecting: 
Results Actions > Create... > Project

Remove Existing Parents Specifies if the selected project is the only project linked to the 
material. If activated, it removes any other existing links.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-98: Add to Project Configuration Fields
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<pool/>
</setproject>

Automation: End
The End workflow element enables you to mark the status of the connected job for each 
task in the workflow. This status is used to trigger corrective actions in the result of a task 
failure.

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files
The tag <end> contains the configuration for this element.

Fig. 5-99: End Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Result Specifies the status of the connected job for each task. The options 
are: Completed or Failed.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-100: End Configuration Fields
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Automation: Etere Xml Exporter
MantricsServer.xml Configuration
<end>

<server port="8154">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</end>

MantricsNode.xml Configuration
<end slotCount="4">

<active>true</active>
<server port="8154">10.250.170.183</server>
<node port="8155">10.250.170.183</node>
<pool/>

</end>

Automation: Etere Xml Exporter
The Etere Xml Exporter workflow element enables Momentum to generate XML files in a 
format suitable for import by the Etere system.

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Fig. 5-101: Etere Xml Exporter Workflow Element

Fig. 5-102: Etere Xml Exporter Configuration Fields
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Configuration Files
The tag <eterexmlexporter> contains the configuration for this element.

MantricsServer.xml Configuration
<etereXMLExporter>

<server port="8684">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</etereXMLExporter>

MantricsNode.xml Configuration
<eterexmlexporter slotCount="4">

<active>false</active>
<server port="8684">10.250.170.183</server>
<node port="8685">10.250.170.183</node>
<pool/>

</eterexmlexporter>

Automation: Go To
The Go To workflow element enables you to connect elements located on different 
workflow pages.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dst Sets the destination directory for the export. Type in a UNC path or 
set it using the browser.

Filename Sets the name of the exported XML file (or the name format, if using 
variables) and the file extension.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files
The tag <teleport> contains the configuration for this element.

MantricsServer.xml Configuration
<teleport>

<server port="8146">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</teleport>

Fig. 5-103: Go To Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

DestinationNode Enables you to select the target element in the DestinationNode 
dialog box, see Figure 5-105. 

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-104: Go To Configuration Fields
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MantricsNode.xml Configuration
<teleport slotCount="4">

<active>true</active>
<server port="8146">10.250.170.183</server>
<node port="8147">10.250.170.183</node>
<pool/>

</teleport>

Automation: Instance Switcher
The Instance Switcher workflow element enables you to select which instance of the 
material is sent through the workflow. For example, you can carry out a QC (quality check) 
on the original material instead of the low resolution proxy created in the previous element.

Fig. 5-105: DestinationNode Selection

Note: By default, the high quality (HQ) instance of the material is 
propagated by the Instance Switcher.

Fig. 5-106: Instance Switcher Workflow Element
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Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files
The tag <instanceswitcher> contains the configuration for this element.

MantricsServer.xml Configuration
<instanceswitcher>

<server port="8122">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</instanceswitcher>

MantricsNode.xml Configuration
<instanceswitcher slotCount="4">

<active>true</active>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Instance Type Sets which Instance to send through the workflow. The values are: 
HQ (high quality) or AUX (Auxiliary Instance, formats include e.g. txt, 
pdf, pac, doc, docx file).

Label Sets a specific instance for the AUX instance type, for example, 
wm9. Available values are retrieved from the file 
InstanceLabelConfig.xml.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-107: Instance Switcher Configuration Fields
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<server port="8122">10.250.170.183</server>
<node port="8123">10.250.170.183</node>
<pool/>

</instanceswitcher>

Automation: Key Segmentator
The Key Segmentator workflow element automatically creates key segments of a specific 
length. The segment starts from the first frame and each key segment is named using the 
name of the parent material in combination with the starting timecode of the key segment 
using an underscore character.

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files

Fig. 5-108: Key Segmentator Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Interval Specifies the length (in seconds) of each key segment.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-109: Key Segmentator Configuration Fields
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The tag <keysegmentator> contains the configuration for this element.

MantricsServer.xml Configuration
<keysegmentator>

<server port="8094">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</keysegmentator>

MantricsNode.xml Configuration
<keysegmentator slotCount="4">

<active>false</active>
<server port="8094">10.250.170.183</server>
<node port="8095">10.250.170.183</node>
<pool/>

</keysegmentator>

Configuring Metadata Publisher Templates
The Metadata Publisher workflow element uses templates to format the available metadata 
and create a report file. In a typical installation, this folder is located in the directory 
C:\Mantrics\MetadataPublisherTemplates.

The following templates provide an example of the structure of the final output file:
• DemoTXT.txt

• DemoXML.xml

• KeySegment.xml

The template file DemoXML.xml contains the following XML definition of the metadata 
sidecar:

<SidecarXML>

<TITLE_DESC>{MaterialInfo.Material Info.Title}</TITLE_DESC>

<HOUSEIDS>{MaterialInfo.Material Info.Keywords}</HOUSEIDS>

<PRODUCT_DESC>{MaterialInfo.Material
 Info.Description}</PRODUCT_DESC>

<PLAY_LENGTH>00:00:15:00</PLAY_LENGTH>

<START_TIME>00:00:00:00</START_TIME>

<END_TIME>00:00:15:00</END_TIME>

<FRAME_RATE>29.97</FRAME_RATE>

<FILE_SIZE>120315112</FILE_SIZE>

<DURATION>15</DURATION>

<SPOT_TYPE>NTSC_HD</SPOT_TYPE>

<MEDIA_DESCRIPTION>1080i</MEDIA_DESCRIPTION>

</SidecarXML>
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This template generates a simple XML file containing the metadata associated with a 
material instance. 

If a specific item of metadata is required, use its full name and write it as the variable name, 
for example: {Fullname}. The value of the metadata is then written in the output file. Using 
this technique, custom templates can create extremely detailed reports.

All the file formats that are text files can be used as models for a template, for example, 
HTML, XML, RTF and TXT files are all permitted as well as custom formats if they are 
described as a simple text file.

Automation: Metadata Publisher
The Metadata Publisher workflow element publishes a document containing a set of 
Sidecar XML metadata as specified in a default template file. The Metadata Publisher 
transfers the output file using either FTP or a Samba (SMB) connection to a shared folder.

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Note: The Full name is available on the Adm in > M etadata M asks page by 
selecting a Schema and activating the Advanced mode option in the 
description panel.

Fig. 5-110: Metadata Publisher Workflow Element

Fig. 5-111: Metadata Publisher Configuration Fields
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The tag <metadatapublisher> contains the configuration for this element.

MantricsServer.xml Configuration
<metadatapublisher>

<server port="8184">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</metadatapublisher>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Template Specifies the default template used to format the Sidecar XML 
metadata. In a typical installation, the metadata format templates 
are located in the folder: 
C:\Mantrics\MetadataPublisherTemplates.

Templates include DemoTXT.txt and DemoXML.xml

FileName Sets the name of the metadata file (or the name format, if using 
variables) and the file extension.

Overwrite Overwrites existing files, if checked.

Protocol Select the protocol used to transfer the published file from the 
options: FTP or SMB (Samba).

Host Displayed when you select: FTP Protocol.
Specifies the name of the FTP host where the publishing takes place 
(example format: ftp.<hostname>.com).

User Displayed when you select: FTP Protocol.
Sets the user name of the FTP account.

Password Displayed when you select: FTP Protocol.
Sets the password for the FTP account.

Port Displayed when you select: FTP Protocol.
Port ID for the FTP connection.

Dst Folder Either enter the path to the target directory for the FTP output.
When Protocol is set to SMB, the output file is created by way of 
Samba in the shared directory selected using the File Browser.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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MantricsNode.xml Configuration
<metadatapublisher slotCount="2">

<active>true</active>
<server port="8184">10.250.170.183</server>
<node port="8185">10.250.170.183</node>
<pool/>

</metadatapublisher>

Automation: Remove From Project
The Remove From Project workflow element enables you to remove the association a 
material has with a specific project. 

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Fig. 5-112: Remove From Project Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Remove All When enabled, removes the Material from all projects.

Fig. 5-113: Remove From Project Configuration Fields
147



Configuring the Automation Elements
Configuration Files
Configuration Files
The tag <removefromproject> contains the configuration for this element.

MantricsServer.xml Configuration
<removefromproject>

<server port="8214">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</removefromproject>

MantricsNode.xml Configuration
<removefromproject slotCount="4">

<active>true</active>
<server port="8214">10.250.170.183</server>
<node port="8215">10.250.170.183</node>
<pool/>

</removefromproject>

Automation: Send Mail
The Send Mail workflow element automatically generates and sends an email to the 
specified email addresses. 

Project Displayed only when Remove All is unchecked.
Enables you to select a project, in the available list of projects, from 
which you want to remove the Material. You can create new 
projects in the Catalog page by selecting: Results Actions > 
Create... > Project

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Fig. 5-114: Send Mail Workflow Element
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Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files
The tag <sendmail> contains the configuration for this element.

MantricsServer.xml Configuration
<sendmail>

<server port="8128">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<SmtpServer>smtp.emailaddress</SmtpServer>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Need instance Requires the instance of the propagated material to complete the 
operation, if activated.

To Sets the email address(es) to receive the email.

Subject Sets the subject of the email.

Body Sets the text sent in the body of the email.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-115: Send Mail Configuration Fields
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<SmtpServer_descr>SMTP Server</SmtpServer_descr>
<SmtpSSL>true</SmtpSSL>
<SmtpSSL_descr>SMTP SSL</SmtpSSL_descr>
<SmtpUser>user@emailaddress</SmtpUser>
<SmtpUser_descr>SMTP User</SmtpUser_descr>
<SmtpPwd>password</SmtpPwd>
<SmtpPwd_descr>SMTP Password</SmtpPwd_descr>
<SmtpAuthenticate>true</SmtpAuthenticate>
<SmtpAuthenticate_descr>SMTP Auth</SmtpAuthenticate_descr>
<Sender>operator@emailaddress</Sender>
<Sender_descr>Mail Sender</Sender_descr>

</sendmail>

Configure Send Mail in the <wfc> section <sendmail> of the file MantricsServer.xml as 
follows:

1 Replace the default text of the tag <SmtpServer> with the SMTP information for the 
required email server.

2 Set the default text in the tag <SmtpSSL> to true to use secure authentication.
3 Replace the default text of the tag <SmtpUser> with the user name of the sender 

email account.
4 Replace the default text of the tag <SmtpPwd> with the password of the sender email 

account.
5 Set the default text in the tag <SmtpAuthenticate> to true to enable SMTP 

authentication.
6 Replace the default text of the tag <Sender> with the description to appear in the 

sender field of the email.

MantricsNode.xml Configuration
<sendmail slotCount="4">

<active>true</active>
<server port="8128">10.250.170.183</server>
<node port="8129">10.250.170.183</node>
<pool/>

</sendmail>

Automation: Send To...
The Send To... workflow element enables you to submit material that is archived in the 
catalog to one or several workflows. You can use the Send To element as a trigger to start 
other workflows, for example, when using the Metadata Change Notifier.

Note: The tags using the descr word (for example, <Sm tpPwd_descr>) are 
optional, descriptive tags used by the system to identify the elements.
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Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Note: If a proxy is selected, the related HQ instance (parent) is sent to the 
workflow. If both the proxy and HQ instances are selected and sent, only 
the HQ instance is sent.

Fig. 5-116: Send To... Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Need instance Requires an instance of the propagated material to complete the 
operation, if activated.

ONLY ONE ACTIVE JOB Enables you to check whether a title already has an active job 
running on the branch following the Send To element. If active, 
multiple jobs for the title are forbidden until the first one ends and 
the task is propagated through the failed port.

Roles filter When checked, links the Send To element to a specific role that you 
can select in the Role field. If not checked, all roles can access the 
Send To element from the Actions on the Catalog page.

Fig. 5-117: Send To... Configuration Fields
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Configuration Files
The tag <sendto> contains the configuration for this element.

MantricsServer.xml Configuration
<sendto>

<server port="8124">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</sendto>

MantricsNode.xml Configuration
<sendto slotCount="4">

<active>true</active>
<server port="8124">10.250.170.183</server>
<node port="8125">10.250.170.183</node>
<pool/>

</sendto>

Automation: Set Metadata
The Set Metadata workflow element enables you to enables you to assign a new metadata 
value to the Material according to a specific category.

Role Sets the role that is permitted to use the element and restricts 
access to the element in the Actions menu of the Catalog page. See 
the Momentum Operator’s Guide for further information on Actions 
and how they work.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Fig. 5-118: Set Metadata Workflow Element
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Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files
The tag <setmetadata> contains the configuration for this element.

MantricsServer.xml Configuration
<setmetadata>

<server port="8138">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</setmetadata>

MantricsNode.xml Configuration
<setmetadata slotCount="4">

<active>true</active>
<server port="8138">10.250.170.183</server>
<node port="8139">10.250.170.183</node>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Need Instance Requires the Instance of the propagated material to complete the 
operation, if activated.

Metadata Sets the metadata category.

Value Sets the metadata value.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-119: Set Metadata Configuration Fields
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<pool/>
</setmetadata>

Automation: Set Priority
The Set Priority workflow element enables you to change the priority of a task or a job (a 
series of tasks applied to a material). The default priority value for a task is 5 (Low). 

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files

Fig. 5-120: Set Priority Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Priority Select the new priority value from the options: Low, Medium, High, 
Urgent, Immediate.

Priority Policy Select either: Entire Job or Next Task. to set whether the change of 
priority is applied only to the next task or to the entire job.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-121: Set Priority Configuration Fields
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The tag <setpriority> contains the configuration for this element.

MantricsServer.xml Configuration
<setpriority>

<server port="8162">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</setpriority>

MantricsNode.xml Configuration
<setpriority slotCount="4">

<active>true</active>
<server port="8162">10.250.170.183</server>
<node port="8163">10.250.170.183</node>
<pool/>

</setpriority>

Automation: Sleep
The Sleep workflow element keeps the task in a waiting state for a set duration.

Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Fig. 5-122: Sleep Workflow Element

Fig. 5-123: Sleep Configuration Fields
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The tag <sleep> contains the configuration for this element.

MantricsServer.xml Configuration
<sleep>

<server port="8106">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</sleep>

MantricsNode.xml Configuration
<sleep slotCount="4">

<active>true</active>
<server port="8106">10.250.170.183</server>
<node port="8107">10.250.170.183</node>
<pool/>

</sleep>

Automation: Technical Metadata Retriever
The Technical Metadata Retriever workflow element enables you to retrieve technical 
metadata (for example, width or height), by analyzing the header of a media file. The 
Metadata Retriever then uses this data to complete the appropriate metadata fields in 
Momentum. 

This workflow element is typically used to populate metadata when a media file is inserted 
in the Catalog by way of an API, without metadata.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

d/h/m/s Sets the unit used to express the duration from the options: days, 
hours, minutes, seconds.

Value Sets the duration of the sleep period in the selected unit.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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Element Settings Configuration
This element is available in the Automation folder and has the following settings:

Configuration Files
The tag <technicalMetadataRetriever> contains the configuration for this element.

MantricsServer.xml Configuration
<technicalMetadataRetriever>

<server port="8642">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</technicalMetadataRetriever>

Fig. 5-124: Technical Metadata Retriever Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Create Icon Forces Momentum to create an icon to represent the material, 
which, if imported by API, may not have an icon.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 5-125: Technical Metadata Retriever Configuration Fields
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MantricsNode.xml Configuration
<technicalmetadataretriever slotCount="4">

<active>true</active>
<server port="8642">10.250.170.183</server>
<node port="8643">10.250.170.183</node>
<pool/>

</technicalmetadataretriever>
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Configuring the Feature Extraction Workflow Element
The Feature Extraction workflow element enables you to extract specific features from 
media data sources for use in other areas of our workflow. The following Feature Extraction 
element is available:

• Scene Change Fast

The configuration details for this element are provided in the following section.

Scene Change Fast
The Scene Change Fast workflow element takes a Media asset as its input and processes 
the related media file frame-by-frame in order to detect the points at which a change of 
scene happens. The search analysis is based on detecting a variation in overall pixel 
brightness levels in the frames. The element uses this information to create as many 
Keysegments of a few seconds duration as scene change spots are detected. These 
Keysegments have mark-in points that match all the detected scene change points found in 
the Media asset.

Element Settings Configuration
The Scene Change Fast element has the following settings:

Fig. 6-126: Scene Change Fast Workflow Element
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MantricsServer.xml Configuration
<scenechange>

<server port="8170">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</scenechange>

MantricsNode.xml Configuration
<scenechange slotCount="4">

<active>false</active>
<server port="8170">10.250.170.183</server>
<node port="8171">10.250.170.183</node>
<pool/>

</scenechange>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Threshold Sets the sensitivity of the brightness analysis: the value ranges from 
0 to 100; the higher the threshold, the greater the sensitivity in 
detecting differences between consecutive frames, leading to the 
element generating more key segments.

Pool Sets the name of a pool associated with the element to share the 
processing load.

Fig. 6-127:  Scene Change Fast Element Configuration Fields
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Configuring the Ingest Workflow Element
The Ingest workflow elements enable you to choose from a variety of methods to ingest 
media into the Momentum environment from various media sources to trigger your 
workflows. The following Ingest elements are available:

• Grass Valley Ingest Elements:
• BXF Receiver
• Gateway Receiver
• Morpheus
• Pam-Evs
• sQ Sync
• XCache Receiver
• XMLDB IF Query

• Etere Receiver
• Wait for File
• Watchfolder
• Watchfolder FTP

The configuration details for these elements are provided in the following sections.

BXF Receiver

BXF Receiver
The BXF Receiver is one component of the set of BXF messaging elements in Momentum, 
with the others being BXF Morpheus Export and BXF Morpheus Query.

The BXF Receiver workflow element allows Momentum to ingest BXF format messages 
either from a Morpheus Playout Automation system or from another Momentum. The BXF 
Receiver ingests the BXF message, validates the message and then propagates a response 
from the appropriate, configurable output port.

BXF messages can be created by either the Morpheus BXF Notifier or the MAPP BXF 
Transfer Request Service. A transfer request from Morpheus might specify content that 
Morpheus is due to play on air, but which is not currently available to Morpheus, for 
example, missing material may not have been retrieved from an archive.

When Morpheus issues a BXF content transfer request message, the Momentum BXF 
Receiver will start a workflow task to confirm that media are in the correct format (if 
needed) and attempt to return the requested content. On receipt of a transfer request from 
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Morpheus, the BXF Receiver checks the MORPHEUS_ID value in the BXF message against 
the Momentum database. Depending on whether the material exists in the Momentum 
database, or not, the BXF Receiver propagates the task through the appropriately 
configured port of the element. 

In addition to the standard element configuration, you can configure the behavior and 
output ports of the BXF Receiver element in the default XML template located in the 
following directory:

C:\Mantrics\BxfReceiverTemplates\Default.xml

You can use this template to define whether the BXF Receiver will accept messages from 
both transfer request and notification services or to ignore (skip) certain notification 
messages. Furthermore, you can also define the receiver mode of the BXF Receiver 
element, by configuring the BXF Route to use either a watchfolder or socket. 

Element Settings Configuration
The BXF Receiver workflow element resides in the SAM folder of the Ingest group of 
elements and has the following settings:

Fig. 7-128: BXF Receiver Workflow Element

Fig. 7-129:  BXF Receiver Configuration Fields
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Bxf Route Select one of the pre-configured BXF communication routes. BXF 
Routes are defined in the Momentum Admin page.
The BXF Agent section of the BXF Route sets the receiver mode of 
the BXF Receiver. You can choose whether the element monitors a 
watchfolder for the arrival of BXF message files or whether it uses a 
socket connection to an IP address and port. 
To set up a list of available BXF Routes, select Admin > BXF Routes.

Filter Use to filter the file path of the XML sent to the BXF Receiver.
For example, consider the following file path as a source of an XML 
file: \\10.10.0.221\test\import.xml
If your filter was set to include the keywords: test, import the 
XML file would be processed by the BXF Receiver element. If your 
filter was set to test2, however, the XML file in the example above 
would not be processed.
Start typing in the filter field to display a list of available keywords. 
Use a comma ( , ) to separate each keyword used in the filter.

Template Specifies the BXF Receiver template selected from the list of 
available files stored in the folder: 
C:\Mantrics\BXFReceiverTemplates.
The default template (Default.xml) defines the following 
behavior of the BXF Receiver:
• SkipConfig - set the type of Notifier messages to skip, if any.
• TransferConfig - define how to manage unknown transfer request types, 

and configure the output ports for different transfer request scenarios. 
For example, you might send an Update Transfer request to the ok 
output port.

• NotifierConfig - define how to manage Title / Instance defaults and XML 
rules for notifications, and configure the output ports for different 
notification types. For example, you might send an Update Content 
request to the ok output port.

Send Ack to Morpheus When enabled, sends an ACK/NACK message to the originating 
service (Morpheus) for all messages received, as appropriate.

Archive When selected, Momentum will archive a copy of all messages 
involved in the specific task, including queries, query responses, 
import content messages. and all ACKs/NACKs.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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MantricsServer.xml Configuration
<bxfreceiver>

<server port="8202">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</bxfreceiver>

MantricsNode.xml Configuration
<bxfreceiver slotCount="4">

<active>false</active>
<server port="8202">10.250.170.183</server>
<node port="8203">10.250.170.183</node>
<pool/>

</bxfreceiver>

Configuring the BXF Receiver Message Template
The BXF Receiver workflow element allows Momentum to ingest BXF format messages 
either from a Morpheus Playout Automation system or from another Momentum. Based on 
the configuration of the BXF Receiver Message Template, the BXF Receiver element ingests 
the BXF message, validates the message and then propagates a response from the 
appropriate, configurable output port.

The configuration of the BXF Receiver template can be divided into the following sections:
• Generic settings
• Skip settings
• Transfer settings
• Notifier settings
• Query response settings

Configuring the Generic Settings in the BXF Receiver Template 
To configure the generic settings of the BXF Receiver Server:

1 In a text editor, open the file: C:\Mantrics\BxfReceiverTemplates\ Default.xml
2 Locate the section <BxfReceiverTemplate>:

<BxfReceiverTemplate>
<timeoutSec>3</timeoutSec>
<retriesCount>5</retriesCount>

These XML tags have the following functions
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Configuring the Skip Settings in the BXF Receiver Template
The <skipConfig> section of the BXF Receiver template enables you to choose to skip 
messages generated by the Metadata Change Notifier service.

To configure the Skip settings of the BXF Receiver:
1 In a text editor, open the file: C:\Mantrics\BxfReceiverTemplates\ Default.xml
2 In the section <SkipConfig>, set the available parameters as required:

<SkipConfig>
<SkipAdd>false</SkipAdd>
<SkipUpdate>false</SkipUpdate>
<SkipRemove>false</SkipRemove>
<SkipAddTransfer>false</SkipAddTransfer>
<SkipUpdateTransfer>false</SkipUpdateTransfer>
<SkipRemoveTransfer>false</SkipRemoveTransfer>
<SkipCompleteTransfer>false</SkipCompleteTransfer>
<SkipQuery>false</SkipQuery>

</skipconfig>

These XML tags have the following functions:

Tag Description

timeoutSec Sets the elapsed time (in seconds) after which a connection 
is considered to have timed out. Enable only if BXF Route is 
file-based and not connected by socket.

retryCount Sets the number of retry attempts to establish a connection. 
Enable only if BXF Route is file-based and not connected by 
socket.

Tag Description

SkipConfig Set to true or false (default).

Enables you to choose whether to skip messages 
generated by the Notifier service and if so, the type of 
messages to be skipped.

SkipAdd Set to true or false (default).

When true, skips all Import Content Add messages 
received from the Notifier.

SkipUpdate Set to true or false (default).

When true, skips all Import Content Update messages 
received from the Notifier.

SkipRemove Set to true or false (default).

When true, skips all Import Content Remove messages 
received from the Notifier.
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Configuring the Transfer Settings in the BXF Receiver Template
The transfer settings of the BXF Receiver configure the behavior of Momentum on receipt 
of BXF messages from the Morpheus Transfer Request Service.

To configure the Transfer settings of the BXF Receiver:
1 In a text editor, open the file: C:\Mantrics\BxfReceiverTemplates\ Default.xml
2 In the section <TransferConfig>, set the available parameters as required:

<TransferConfig>
<FailTransfersForNotExistingMaterial>false

</FailTransfersForNotExistingMaterial>
<SkipUnknownTypes>false</SkipUnknownTypes>
<CloseUnknownTypes>false</CloseUnknownTypes>
<TransferMetadataFilters>

<TransferMetadataFilter></TransferMetadataFilter
</TransferMetadataFilters>
<UnknownTypes>

<Type>PROGRAMME</Type>
</UnknownTypes>
<Defaults>

<Default>
<Label>channel</Label>
<Value>Bye</Value>
<Type>TEXT</Type>
</Default>
<Default>
<Label>MaterialType</Label>
<Value>PROGRAMME</Value>
<Type>TEXT</Type>
</Default>

</Defaults>
<XMLRules>

<XMLRule>
<xPath>//BxfMessage/BxfData/ContentTransfer/Content/Non
ProgramContent/Details/SpotType</xPath>

SkipAddTransfer Set to true or false (default).

When true, skips all Transfer Add messages.

SkipUpdateTransfer Set to true or false (default).

When true, skips all Transfer Update messages.

SkipRemoveTransfer Set to true or false (default).

When true, skips all Transfer Remove messages.

SkipCompleteTransfer Set to true or false (default).

When true, skips all Transfer Complete messages. 

SkipQuery Set to true or false (default).

When true, skips all Query messages.

Tag Description
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<targetMetadata>MaterialType</targetMetadata>
</XMLRule>
<XMLRule>
<xPath>//BxfMessage/BxfData/ContentTransfer/Content/Non
ProgramContent/ContentMetaData/PrivateInfor
mation/Owner</xPath>
<targetMetadata>channel</targetMetadata>
</XMLRule>

</XMLRules>
<CompleteTransfer_Port>ok</CompleteTransfer_Port>
<CompleteNotExistingTransfer_Port>failed

</CompleteNotExistingTransfer_Port>
<CompleteExpiredTransfer_Port>failed</CompleteExpiredTransfer_Port>
<CompleteCompletedTransfer_Port>failed

</CompleteCompletedTransfer_Port>
<AddTransferForExistingMaterialId_Port>ok

</AddTransferForExistingMaterialId_Port>
<AddTransferForNotExistingMaterialId_Port>failed

</AddTransferForNotExistingMaterialId_Port>
<AddExistingTransfer_Port>failed</AddExistingTransfer_Port>
<AddExistingTransferWithDifferentId_Port>failed

</AddExistingTransferWithDifferentId_Port>
<UpdateTransferForExistingMaterialId_Port>ok

</UpdateTransferForExistingMaterialId_Port>
<UpdateTransferForNotExistingMaterialId_Port>failed

</UpdateTransferForNotExistingMaterialId_Port>
<UpdateNotExistingTransfer_Port>failed

</UpdateNotExistingTransfer_Port>
<UpdateCompletedTransfer_Port>failed

</UpdateCompletedTransfer_Port>
<SkipTransferUpdate_Port>failed</SkipTransferUpdate_Port>
<RemoveTransfer_Port>ok</RemoveTransfer_Port>
<RemoveNotExistingTransfer_Port>failed

</RemoveNotExistingTransfer_Port>
</TransferConfig>

These XML transfer request tags have the following functions:

Tag Description

FailTransfersForNotExisting
Material

Set to true or false (default).
When true, Momentum sends a failed transfer message to 
Morpheus if the material is not found. In this event, the 
status of the failed transfer message is Failed and the 
statusDescription is Material doesn't exist

SkipUnknownTypes Set to true or false (default).
When true, skips all BXF messages with a type contained in 
the <UnknownTypes> list field.

CloseUnknownTypes Set to true or false (default).
When true, sends a NACK to complete all BXF messages with 
a type contained in the <UnknownTypes> list field.
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TransferMetadataFilters Can contain a list of Transfer Metadata Labels used to filter 
active transfers to identify a unique transfer request. If 
another transfer exists that matches the same filters, the new 
transfer is skipped, and a NACK is sent with a specific error 
message. The task is propagated to the port specified in the 
field <AddExistingTransferWithDifferentId_Port> of the 
BXF Receiver Template.
Each <TransferMetadataFilter> defines a Transfer 
Metadata Label to use as a filter. If multiple transfer 
metadata labels are listed, the filter must satisfy all 
conditions using AND logic.

UnknownTypes Use to group specific BXF message types to be treated as 
unknown by the BXF Receiver.
Each <Type> defines a BXF message type to be treated as 
Unknown by the BXF Receiver. For example, BXF message 
type PROGRAMME.
If no message types are defined as Unknown, all BXF 
message types are processed by the BXF Receiver.

Defaults Use to group the default settings of BXF message transfer 
requests received from Morpheus/MAPP database by the 
BXF Receiver.

XMLRules A collection of all the BXF metadata used to populate the 
data of each transfer request object listed on the Transfer 
page. Each <XMLRule> defines a single rule of the 
<XMLRules> list.

Output Port Configurations Use to configure the output ports. You can map a task, 
whether successful or not to a designated port.

Tag Description
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The following XML extract is an example of a Transfer-failed BXF message, generated when 
the material does not exist in Momentum:

<?xml version="1.0"?>
<BxfMessage xmlns="http://smpte-ra.org/schemas/2021/2008/BXF" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
originMessageId="urn:uuid:c4073c29-e93c-4d6d-8c40-7a8dc465e808" 
userName="Momentum" destination="Morpheus" originType="Automation" 
origin="Momentum" messageType="Information" dateTime="2019-04-
21T14:54:51.6Z" id="urn:uuid:cb58b2e5-1369-4da0-988f-24623fb6dcb9">

<BxfData action="add">
<ContentTransfer statusDescription="Material does not

exist" status="Failed" transferType="File transfer"
transferId="urn:uuid:
06b80cc2-5153-420a-8af4-2be2d2a51bae">
<Content>

<ProgramContent>
<ContentMetaData>

<ContentId>
<HouseNumber>test1</HouseNumber>
</ContentId>
<UsagePolicy>
<FirstAirDate>

2017-05-07T15:21:00.0Z</FirstAirDate>
</UsagePolicy>
<PrivateInformation/>

</ContentMetaData>
</ProgramContent>

</Content>
</ContentTransfer>

</BxfData>
</BxfMessage>

Configuring the Notifier Settings in the Message Template 
To configure the Notifier settings of the BXF Receiver:

1 In a text editor, open the file: C:\Mantrics\BxfReceiverTemplates\ Default.xml
2 In the section <NotifierConfig>, set the available parameters as required:

<NotifierConfig>
<Title>

<TitleId/>
<TitleSchema/>

</Title>
<UseMorpheusIdAsTitleId>false</UseMorpheusIdAsTitleId>
<UseLongFileIdAsTitleId>false</UseLongFileIdAsTitleId>
<DefaultTitleSchema>BasicMetadata</DefaultTitleSchema>
<CreateThumbForSegments>true</CreateThumbForSegments>
<TitleDefaults>

<Default> 
<Label></Label> <Value></Value> <Type></Type> 

</Default>
</TitleDefaults>
<TitleXMLRules>
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<XMLRule> 
<xPath></xPath> <targetMetadata>
</targetMetadata> 

</XMLRule> 
</TitleXMLRules>
<InstanceDefaults>

<Default> 
<Label></Label> <Value></Value> <Type></Type> 

</Default>
</InstanceDefaults>
<InstanceXMLRules>

<XMLRule> <xPath></xPath> <targetMetadata>
</targetMetadata> </XMLRule>

</InstanceXMLRules>
<VideoServers>

<VideoServer> <DeviceId></DeviceId> 
<UncPath></UncPath> <Label></Label> 
<InstanceSchema></InstanceSchema> 
<Extension></Extension> <Type></Type></VideoServer>

</VideoServers>
<AddItem_Port>ok</AddItem_Port>
<AddExistingItem_Port>failed

</AddExistingItem_Port>
<UpdateItem_Port>ok</UpdateItem_Port>
<UpdateNotExistingItem_Port>failed

</UpdateNotExistingItem_Port>
<RemoveItem_Port>ok</RemoveItem_Port>
<RemoveNotExistingItem_Port>failed

</RemoveNotExistingItem_Port>
<InvalidMessage_Port>failed</InvalidMessage_Port>

</NotifierConfig>

These XML tags have the following functions:

Tag Description

Title Defines a list to associate a Title ID and Title Schema to the 
Notifier message.

TitleId The value defines an XPath used to locate the Title ID in the 
message.

TitleSchema The value specifies an existing schema name that is valid for 
a title.

UseMorpheusIdAsTitleId Set to true or false (default).
When true, recovers the Title ID from the Morpheus ID if the 
Title ID was not recovered using the XPath.

UseLongFileIdAsTitleId Set to true or false (default).
When true, recovers the Title ID from the Long File ID if the 
Title ID was not recovered using the XPath or Morpheus ID. 

DefaultTitleSchema Defines the default schema for the Title; if empty, the default 
schema BasicMetadata is used. 

CreateThumbForSegments Set to true or false (default).
When true, it creates an icon for all the segments added 
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TitleDefaults Collects all the values for the Title that are used by default to 
fill missing values in the BXF message. Momentum uses 
these values in the <XPath> of an <XMLRule>.

TitleXMLRules A collection of all the BXF metadata used to populate the 
data of each Title object listed by the Notifier. Each 
<XMLRule> defines a single rule of the <TitleXMLRules> 
list.
For example:
<TitleXMLRules>

<XMLRule>
<xPath>//BxfMessage/BxfData/
Content/ProgramContent/
ContentMetaData/ItemInfo/Notes
</xPath>

<targetMetadata>MomentumCore.MomentumCore.
NOTES
</targetMetadata>
</XMLRule>

</TitleXMLRules>

Where the <xPath> specifies the BXF data for a single 
<XMLRule>. and the tag <targetMetadata> specifies the 
metadata of the database that is going to be set using the 
value of the <xPath> data.

InstanceDefaults Collects all the values for the Instance that are used by 
default to fill missing values in the BXF message. Momentum 
uses these values in the <XPath> of an <XMLRule>.

InstanceXMLRules A collection of all the BXF metadata used to populate the 
data of each Instance object listed by the Notifier. Each 
<XMLRule> defines a single rule of the 
<InstanceXMLRules> list.
Where the <xPath> specifies the BXF data for a single 
<XMLRule>. and the tag <targetMetadata> specifies the 
metadata of the database that is going to be set using the 
value of the <xPath> data.

Tag Description
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Configuring the Query Response Settings in the Message Template
To configure the Query Response settings of the BXF Receiver:

1 In a text editor, open the file: C:\Mantrics\BxfReceiverTemplates\Default.xml
2 In the section <QueryResponseConfig>, set the available parameters as required:

<QueryResponseConfig>
<TimeoutSec>20</TimeoutSec>

<VideoServers>
<VideoServer> <DeviceId></DeviceId> 
<UncPath></UncPath> <Label></Label> 
<InstanceSchema></InstanceSchema> 
<Extension></Extension> <Type></Type></VideoServer>

</VideoServers>
<BXFMetadataList>

<BXFMetadata>
<Label></Label>
<XPath></XPath>
<Value></Value>
<Kind></Kind>

</BXFMetadata>

VideoServers Collects the list of video servers available to associate the 
various devices, when the action is Add, with each 
<VideoServer> tag specifying a single video server; to 
include the <DeviceID>, <UncPath>, <Label>, 
<InstanceSchema>, <Extension> and <Type> to identify 
the video server. Permitted values for the <Type> field are: 
VIDEO (default), AUDIO, SUBTITLE, and IMAGE.
For example:
<VideoServer>

<DeviceId>QUANTUM</DeviceId>

<UncPath>\\10.10.0.221\video\UsersTestArea\
Gateway Receiver\HQRepository\</UncPath>
<Type>VIDEO</Type>

</VideoServer>

AddIfDoesNotExist Set to true or false (default).
When true, if an Import content message with an Update 
action is received and the material does not exist, then it 
treats the message as an import content message with an 
Add action.

UpdateIfExists Set to true or false (default).
When true, if an Import content message with an Add 
action is received and the material already exists, then it 
treats the message as an import content message with an 
Update action.

Output Port Configurations Use to configure the output ports. You can map an action, 
whether successful or not to a designated port.

Tag Description
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</BXFMetadataList>
<CustomParametersList>

<BXFMetadata>
<Label></Label>
<XPath></XPath>
<Value></Value>
<Kind></Kind>

</BXFMetadata>
</CustomParametersList>

</QueryResponseConfig>
<SendAck>false</SendAck>

These XML tags have the following functions:

Tag Description

TimeoutSec Sets the elapsed time (in seconds) after which a 
connection is considered to have timed out. Enable only if 
BXF Route is file-based and not connected by socket.

VideoServers Collects the list of video servers available to associate the 
various devices, when the action is Add, with each 
<VideoServer> tag specifying a single video server; to 
include the <DeviceID>, <UncPath>, <Label>, 
<InstanceSchema>, <Extension> and <Type> to 
identify the video server. Permitted values for the <Type> 
field are: VIDEO (default), AUDIO, SUBTITLE, and IMAGE.

BXFMetadataList Contains a list of the generic fields contained in the 
generated BXF message to be exported, Every field has a 
default value but only some fields are mandatory for the 
creation of the message. If the <BXFMetadataList> list is 
empty, BXF Export uses the default values: Label Value 
Kind.

Collects all the metadata to be included in the BXF 
message being exported from Momentum.

The tag <Label> is used to mark the metadata in the BXF 
file. The value is specified using the extended ID of the 
metadata in the Momentum system and can be retrieved 
in the Admin page Metadata, in the Metadata ID field.

The tag <Value> is the value given to the metadata 
specified in <Label>. The tag <Kind> specifies whether 
the metadata is taken from the Title or the Instance of the 
related material.
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Save the file: C:\Mantrics\BxfReceiverTemplates\Default.xml to store the new 
settings.

See the Momentum Operator’s Guide for information on configuring the BXF routes needed 
for the workflow elements.

Configuring the BXF Messages Generator
Two utilities are provided to generate BXF messages to trigger workflows on a time basis, 
launched through Windows Task Scheduler:

BxfAddMessagesGenerator.exe

and
BxfDeleteMessagesGenerator.exe

By default the executable files are located in the folder:
C:\Program Files\Mantrics S.r.L\Momentum BXF Receiver

Both utilities can be launched as part of a scheduled task.

BxfAddMessagesGenerator
This program filters one or more video files in a specific folder to create a BXF Add message 
for each one that matches the criteria specified using the BxfAddMessagesGenerator.exe 
parameters as follows:

• Watchfolder: Specifies the path where the video files are located.
• Extension: Specifies the file extension that identifies the video files for 

which the BXF message has to be created.
• Number of Days: Specifies the number of days after which the BXF file has to be 

created. The Last Modified Date of the files is checked and the 
files having Last Modified Date less than Number of Days + 
Current Date trigger the creation of the message.

• Destination Folder: Specifies the folder where the created BFX files are stored.
• Suffix: Specifies a suffix that is added to the HouseNumber 

metadata, usually the HouseNumber is equal to the FileName, 
using a suffix it becomes equal to FileName_Suffix. This 
parameter is not mandatory and can be omitted.

CustomParametersList Collects the metadata specific to the materials belonging 
to any custom parameters that have to be exported from 
Momentum. The tags <Label>, <Value>, <Kind> and 
<Xpath> of the list are the same as described above for 
BXFMetadataList.

SendAck Set to true or false (default).

When set to true allows Momentum to send an ACK/
NACK to the originating service for all BXF messages 
received (excluding ACKs/NACKs)

Tag Description
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BxfDeleteMessagesGenerator
This program filters the materials of the Momentum database to match the criteria given by 
its parameters to create for each one a Delete BXF message using the 
BxfDeleteMessagesGenerator.exe parameters as follows:

• Destination folder: Specifies the folder where the created BFX files are stored.
• Number of Days: Specifies the number or days after which the BXF Message 

has to be created. A query in the Momentum system 
database is run then materials having a value of Creation Date 
that is older than Number of Days + Current Date, trigger the 
creation of the BXF message. Into the BXF message is 
specified the House Number and if the material is a 
Programme or not.

You can use the configuration file 
C:\Mantrics\BxfDeleteMessagesGeneratorConfig.xml to pass further parameters to 
BxfDeleteMessagesGenerator.exe. The metadata parameters passed to the executable 
are used to delete material matching the parameter values.

The structure of the configuration file BxfDeleteMessagesGeneratorConfig.xml is as 
follows:

<BxfDeleteMessagesGeneratorConfig>
<BxfMetadataList>
<BxfMetadata>

<Value>ToBeDeleted</Value>
<Label>Description</Label>

<CategoryId>86C9B05827E14635A250B701FE53DACF</CategoryId>
<TypedefId>185ECB5C3A1A411997035C28BE43B80B</TypedefId>
<TypeId>10F266181FB84CF8A16A9BC313A8428D</TypeId>

</BxfMetadata>
</BxfMetadataList>
<DestinationFolder></DestinationFolder>
<NumberOfDays></NumberOfDays>
</BxfDeleteMessagesGeneratorConfig>

The tags have the following functions:

Tag Description

BxfMetadataList Collects all the metadata that has to be used to find the 
matching materials.

BxfMetadata Collects the parameters describing a single item of metadata 
in the list.

Value Specifies the matching value of the metadata.

Label Specifies the label linked to the metadata (optional).

MetadataID Specifies which metadata to use for the match. You can 
retrieve the MetadataID value from the Admin > Metadata 
panel.
The value of the Metadata parameter has the format:
CategoryID1/CategoryID2:TypeDefID:TypeID

CategoryID Specifies the category of material to match. 
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Gateway Receiver
The XML Gateway Receiver workflow element is an entry point that uses a Gateway XML 
document as a source for ingesting material into the workflow. It resides in the SAM folder 
in the Ingest group of elements. This element has the following settings

Element Settings Configuration
The Gateway Receiver workflow element resides in the Grass Valley folder of the Ingest 
group of elements and has the following settings:

TypeDefID Specifies the type definition of the material to match.

TypeID Specifies the type of material to match.

DestinationFolder and 
NumberOfDays 

The same values described above as the mandatory 
parameters used to launch the application

Note: The value used in the configuration file always overrides the parameters 
passed by the command line.

Tag Description

Note: It is recommended to use the workflow element BXF Receiver in 
preference to the Gateway Receiver as it is planned to deprecate this 
element in Momentum version 5.1.

Fig. 7-130: Gateway Receiver Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Mode Sets the connection mode (Watch Directory or Socket) that is 
applied to the receipt of XML messages. Select from the options: 
DirWatcher or Socket.
Select the Socket mode to avoid latency when communicating 
across systems.

Priority Sets the priority of the tasks created on this element to either: Low, 
Medium, High, Urgent or Immediate.

Schema Sets the category of metadata that can be applied to the material 
(see the Momentum Operator’s Guide details).

XML Dir Sets the path of the folder to be monitored for the arrival of new 
XML documents.

Recurse Subdirs Activates the automatic monitoring of the subdirectories of the 
specified directory.

Delete After Ingest Automatically deletes the original file once the ingest process is 
finished, if activated.

Fig. 7-131:  Gateway Receiver Configuration Fields
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Morpheus
The Morpheus workflow element is an entry point that enables Momentum to receive 
content from the Morpheus Automation system through the Morpheus Server application. 
This element has the following settings:

Element Settings Configuration
The Morpheus workflow element resides in the Grass Valley folder of the Ingest group of 
elements and has the following settings:

Template A collection of all the XML files stored in the folder 
C:\Mantrics\XMLGatewayReceiverTemplates. Each file acts as 
a template which lists the mandatory fields for a successful ingest of 
the material. The fields specified in a template are checked against 
title’s metadata and key segments’ metadata.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Note: It is recommended to use the workflow element BXF Receiver in 
preference to the Morpheus element as it is planned to deprecate this 
element in Momentum version 5.1.

Fig. 7-132: Morpheus Workflow Element
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PAM-EVS
The Pam-EVS workflow element is an entry point that enables Momentum to ingest files 
received from an EVS Production Asset Manager (PAM) system.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label of the instance. The available values are contained in 
the InstanceLabelsConfig.xml file.

DEVICE_ID Variable to contain the identifier of the Morpheus source system.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: To use this element, the file M orpheusServerConfig.xm l and 
ICEconfig.xm l must also be configured, as described in the following 
sections.

Fig. 7-133:  Morpheus Configuration Fields

Fig. 7-134: PAM-EVS Workflow Element
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Element Settings Configuration
The PAM-EVS workflow element resides in the Grass Valley folder of the Ingest group of 
elements and has the following settings:

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label of the instance. The available values are contained in 
the InstanceLabelConfig.xml file.

Priority Sets the priority of the tasks created on this element to either: Low, 
Medium, High, Urgent or Immediate.

Mode Sets the connection mode (Watch Directory or Socket) that is 
applied to the receipt of files. Select from the options: DirWatcher or 
Socket.
Select the Socket mode to avoid latency when communicating 
across systems.

Watch Dir Displayed only when the mode DirWatcher is selected.
Sets the path of the folder to be monitored for the arrival of new 
files.

Fig. 7-135:  PAM-EVS Configuration Fields
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sQ Sync
The sQ Sync workflow element provides an interface to an sQ Server environment by 
enabling Momentum to listen for the sQ events: ClipCreated, ClipModified and 
ClipDeleted generated from the sQ environment. The detected event then triggers an 
appropriate workflow.

When a clip is created in the sQ database, the sQ Sync workflow element captures the 
ClipCreated notification and creates a Momentum TITLE with a TITLE ID taken from the Clip 
GUID value, contained in the sQ database.

The sQ Sync element is able to manage intra-zone cloning of clips. You can create multiple 
instances of sQ clips resulting from the sQ cloning mechanism. When both the source sQ 
clip and its clone  the same clipGUID sQ metadata, then two MEDIAASSETS are created in 
Momentum that are children of the same Momentum TITLE.

With intra-zone cloning, the cloned clip will have the same clipGUID as the source.

Extension Displayed only when the mode DirWatcher is selected.
Set an optional filter to select only files with a specific extension. 
This is set to ingest all files received in the watch folder (*.*) by 
default.

Timeout (Sec) Displayed only when the mode DirWatcher is selected.
Sets the time elapsed (in seconds) between two attempts to verify 
whether a media file is available.

Retries Count Displayed only when the mode DirWatcher is selected.
Sets a number of attempts to verify whether a media file is available.

Filter Displayed only when the mode DirWatcher is selected.
Use to filter specific messages based on attributes contained in the 
filename. Start typing in the filter field to display a list of available 
keywords. Use a period (.) to separate each keyword in the filter.
For example, entering the keyword {MaterialID} results in the 
application only processing files where the filename contains the 
MaterialID.

Conversion Script Specify a target script to convert the ingested EVS PAM file(s) to a 
suitable XML format for Momentum.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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Element Settings Configuration
The sQ Sync workflow element resides in the Grass Valley folder of the Ingest group of 
elements and has the following settings:

Fig. 7-136: sQ Sync Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

SQ Title Schema TBA

SQ Instance Schema TBA 

sQ Zone Target sQ Zone ID targeted by the sQ Sync workflow element.

Listener Status Shows the current status of the sQ Sync element as to whether it is 
connected to (listening) or disconnected from (not listening) the sQ 
ISA Manager. 

Fig. 7-137:  sQ Sync  Configuration Fields
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The sQ Sync workflow element propagates a task, corresponding to an sQ event, through 
the appropriate output port:

• Clip Created
• Clip Modified
• Clip Deleted
• failed 

XCache Receiver
The XCache Receiver workflow element manages the ingest of XCache messages. For an 
overview of how the element works, see the Momentum Operator’s Guide. 

Element Settings Configuration
The XCache Receiver workflow element resides in the Grass Valley folder of the Ingest 
group of elements and has the following settings:

Priority Sets the priority of the tasks created by this element to either: Low, 
Medium, High, Urgent or Immediate.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Note: It is planned to deprecate the XCache Receiver workflow element from 
Momentum version 5.1. It is recommended to use the BXF Receiver 
functions in preference.

Fig. 7-138: XCache Receiver Workflow Element
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In addition to the standard ports, the XCache Receiver element includes the following 
output ports: 

• TransferRequest
• DeleteInstance

Configuring the XCache Receiver

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Delete After Ingest Automatically deletes the original file once the ingest process is 
finished, if activated.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Priority Sets the priority of the tasks created by this element to either: Low, 
Medium, High, Urgent or Immediate.

XML Dir Specifies the path of the folder to be monitored for the arrival of 
new XML messages.

Recurse Subdirs Activates automatic monitoring of the subdirectories of the 
specified directory.

Fig. 7-139:  XCache Receiver Configuration Fields

Note: It is planned to deprecate the XCache Receiver workflow element from 
Momentum version 5.1. It is recommended to use the BXF Receiver 
functions in preference.
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To configure the XCache Receiver, you need to modify the file 
C:\Mantrics\XCacheReceiverConfig.xml This file has the following structure:

<XCacheReceiverConfig>
<syncOnStart>false</syncOnStart>
<timeoutSec>3</timeoutSec>
<retryCount>5</retryCount>
<TransferRequestConfig>

<completedXmlFolder></completedXmlFolder>
<failedXmlFolder></failedXmlFolder>
<RequestTypeMapping allow="false">

<CatId/>
<TypedefId/>
<TypeId/>

</RequestTypeMapping>
</TransferRequestConfig>
<DeleteInstanceConfig>

<DeviceIdIgnore>true</DeviceIdIgnore>
<completedXmlFolder>\\10.10.0.221\video\UsersArea\user\
TEST_XML_XCACHE\completed\</completedXmlFolder>
<failedXmlFolder>\\10.10.0.221\video\UsersArea\user\
TEST_XML_XCACHE\completed\Failed\</failedXmlFolder>

</DeleteInstanceConfig>
</XCacheReceiverConfig>

This section contains the following tags:

Option Description

syncOnStart Has two possible values: true or false. If set to true, when the service 
restarts, all the files in the source folder are considered to be new 
files and are analyzed.

timeoutSec  Set the time elapsed between two consecutive accesses to 
determine if the XML file is complete or still transferring.

retryCount Set a number of maximum accesses to determine if the XML file is 
complete or still transferring.

TransferRequestConfig Contains all the information required to manage the Transfer 
Request XML message:

completedXmlFolder Specifies the folder where the XML files are copied after being 
processed successfully.

failedXmlFolder Specifies the folder where the XML files are copied if they cannot be 
correctly processed.

RequestTypeMapping The attribute Allow can be set to true or false and when set to true, 
activates the mapping of the type of the request to a specific item 
of metadata for the material.

CatId, TypedefId and 
TypeId

Specify the metadata to be mapped.

DeleteInstanceConfig Contains the information required to manage the Delete XML 
message.
187



Configuring the Ingest Elements
XMLDB IF Query
XMLDB IF Query
The XMLDB IF Query workflow element is used to query the Morpheus database to check 
whether a material with a LONG_FILE_ID is present, using the XML DB IF adapter. 

You can use this element to confirm, at an early point in a workflow, whether a media asset 
is already present in the Morpheus database, and if so, potentially bypassing the need to 
transform media.

Element Settings Configuration
The XMLDB IF Query workflow element resides in the Grass Valley folder of the Ingest group 
of elements and has the following settings:

DeviceIdIgnore Can be set to true or false and specifies if the DeviceId can be 
ignored.

completedXmlFolder Specifies the directory where the XML files are copied after being 
processed successfully.

failedXmlFolder Specifies the directory where the XML files are copied if they cannot 
be correctly processed.

Option Description

Note: It is recommended to use the workflow element BXF Query in 
preference to the XMLDB IF Query as it is planned to deprecate this 
element in Momentum version 5.1.

Fig. 7-140:  XMLDB IF Query Element
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The XMLDB IF Query element includes the following output ports: 
• ID Found
• ID Not Found
• failed

Configuring XMLDB IF Query

The XMLDB IF Query feature is used to query the MAPP database to check whether a 
material with a LONG_FILE_ID is present, using the XML DB IF adapter.

To configure the XMLDB IF Query, follow the rules and guidelines described for the 
Momentum Farm (see Configuring the Momentum Farm), then complete the setup with 
the specific configuration of the file MantricsNode.xml as follows:

Configuring XMLDB IF Query in MantricsNode.xml
The tag <xmldbifquery> contains the following specific tags:

<morpheusIP>10.10.0.100</morpheusIP>
<morpheusPort>8000</morpheusPort>

These tags have the following functions:
• morpheusIP: Defines the IP address of the Morpheus server.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on 
the Dashboard page. Black is equivalent to no color.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 7-141:  XMLDB IF Query Configuration Fields

Note: It is planned to deprecate the XMLDB IF Query workflow element from 
Momentum version 5.1. It is recommended to use the BXF Query 
functions in preference.
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• morpheusPort: Defines the port used to connect to the Morpheus server.

Configuring Communication with Morpheus and Other Devices
The configuration file ICEConfig.xml enables Momentum to communicate with a 
Morpheus Playout Automation system and other devices in the playout environment using 
the Morpheus API. 

To enable communication between Momentum, Morpheus and other devices in the 
Morpheus playout environment:

1 Open the configuration file C:\Mantrics\IceConfig.xml in a text editor.
2 Locate the section <Host> to configure parameter to enable communication with the 

Morpheus Playout Automation system using the Morpheus API:

<IceConfig xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema">

<Host>https://ice-host:8081/</Host>
<UserName>user</UserName>
<Password>password</Password>
<FakeStatus>false</FakeStatus>
<UseHTTPAuthentication>false</UseHTTPAuthentication>
<Devices> </Devices>
<DualReview/>

</IceConfig>

These tags have the following functions:
• Host: Defines the Morpheus hostname and port.
• UserName: Defines the user name to logon to the Morpheus 

server.
• Password: Defines the password for the above user to logon to 

the Morpheus server.
• FakeStatus: Always set to false. Used to define the status of the 

ICE API.
• UseHTTPAuthentication: Currently Momentum uses authentication by Cookie 

as default. When set to true enables basic HTTP 
Authentication rather than authentication by cookie 
(false)

• Devices: Defines additional devices in the Morpheus 
environment

• DualReview: Defines the media asset label pairs to enable the 
simultaneous baseband preview from two servers 
using the Morpheus API.

3 Locate the section <Devices> to configure additional devices in the Morpheus 
environment, for example the Harmonic Omneon MediaGrid, etc.
<Devices>

<IceDevice>
<System>SystemName</System>
<Device>OMN\DEV</Device>

<SendMediaFolder>false</SendMediaFolder>
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<RootFolder>\\storage\some\path</RootFolder>
<RoleName>ROLE_NAME</RoleName>
</IceDevice>

</Devices>

These tags have the following functions:
• Devices: Groups other devices used in the Morpheus playback 

environment.
• IceDevice: Defines each individual device in the Morpheus 

environment.
• System: Defines the system name used to communicate with the 

Morpheus API.
• Device: Defines the individual device name used to communicate 

with the Morpheus API.
• SendMediaFolder: Optional parameter, set to true (default) or false. When 

true, the REST API is called by sending the folder path 
together with the filename of the media to be played.

• RootFolder: Optional parameter to hide the device in the Baseband 
player drop-down if the selected media asset is not under 
this path, for example, media assets can be located in 
subfolders.

• RoleName: Optional parameter to hide the device in the Baseband 
player drop-down if the user has not been assigned the 
specified role.

4 Locate the section <DualReview> to configure the Media asset label pairs and enable 
the simultaneous baseband preview from two server ports using the Morpheus API, for 
example:
<DualReview>

<Labels>
<Label>HQ</Label>
<Label>MXF</Label>

</Labels>
<Labels>

<Label>DOM_AIR_A</Label>
<Label>DOM_AIR_B</Label>

</Labels>
<Labels>

<Label>INT_AIR_A</Label>
<Label>INT_AIR_B</Label>

</Labels>
</DualReview>

5 Save your changes to ICEConfig.xml.

Configuring Dual Review Using the Morpheus API
The Momentum dual-review function enables you to perform a frame-to-frame 
comparison of an MXF media asset on one Omneon server port with an HQ media asset on 
another Omneon server port in the Momentum Logger page.
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To activate dual review of material files:
1 Open the configuration file C:\Mantrics\IceConfig.xml in a text editor.
2 Configure the MediaAsset label pairs in C:\Mantrics\IceConfig.xml in the section 

<DualReview>. For example:

<DualReview>
<Labels>

<Label>HQ</Label>
<Label>MXF</Label>

</Labels>
<Labels>

<Label>DOM_AIR_A</Label>
<Label>DOM_AIR_B</Label>

</Labels>
<Labels>

<Label>INT_AIR_A</Label>
<Label>INT_AIR_B</Label>

</Labels>
</DualReview>

These tags have the following functions:
• DualReview: Groups other devices used in the Morpheus playback 

environment.
• Labels: Defines each individual device in the Morpheus environment.
• Label: Defines the system name used to communicate with the 

Morpheus API.

3 Set the name of a UserAction workflow element to start with the prefix: _Dual
4 Save your changes to ICEConfig.xml.

When using the dual review function, it is important to note the following points:
• When a user accepts a dual review task in the ToDo page, they will be redirected to 

the Logger page.
• When the task has been previously switched to a specific Media Asset, the system 

will select the other media asset according to the configuration defined in 
ICEConfig.xml

• The user is then presented a dialog to select the specific SDI device for the desired 
label, see Figure 7-142:
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• If the <DualReview> section of ICEconfig.xml is incorrectly configured, the user 
is prompted to contact the Momentum administrator:

• If the current material has no MediaAsset with the label specified in the Labels set, 
the user is warned that the other MediaAsset could not be found.

Etere Receiver
The Etere Receiver workflow element enables Momentum to analyze XML files published 
by the Etere system. Each Etere XML file can specify HQ, or LQ paths and segmentation of 
the related material, so it is not required to ingest the media asset, provided that 
Momentum can access the network locations specified in the HQ and LQ paths.

Momentum parses the content of the Etere XML file and at the first occurrence of .MXF or 
.MP4 in its content, Momentum uses the related tag values to initialize the path for the HQ 
and LQ of the new Title. This element has the following settings:

Fig. 7-142: Selecting the SDI Device for Dual Review in the Logger Page

Fig. 7-143: Misconfiguration of the Dual Review Function

Fig. 7-144: Media Asset Not Found for Dual Review
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Element Settings Configuration
The Etere Receiver workflow element resides in the Ingest group of elements and has the 
following settings:

Fig. 7-145:  Etere Receiver Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

DeleteAfterIngest Deletes the original file automatically on completion of the ingest 
process, if activated.

Fig. 7-146: Etere Receiver Configuration Fields
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Wait for File
The Wait For File workflow element enables you to insert a watchfolder function into a 
workflow as a intermediate workflow step so that Momentum pauses the processing of a 
task until an expected file arrives in the target Watch directory. This enables you to replace a 
MediaAsset or integrate a new MediaAsset into an existing MediaAsset.

When a Title arrives at a Wait for file element, you can configure the element to act in a 
similar way to a Watchfolder element, by monitoring a folder for a file with a specific 
naming convention (e.g. {MATERIALID}-fixed.mxf). If the Label parameter is the same as 
the input MediaAsset then it can replace the existing MediaAsset, alternatively, it could add 
the new MediaAsset to the Title.

Label Sets the label of the instance. Available values are contained in the 
file: InstanceLabelConfig.xml.

Priority Sets the priority of the tasks created by this element to either: Low, 
Medium, High, Urgent or Immediate.

Schema Sets the category of metadata that can be applied to the material 
(see the Momentum Operator’s Guide for details).

XML Dir Specifies the folder where the Etere XML files are expected.

Recurse Subdirs Activates automatic monitoring of the subdirectories below the 
specified directory.

Media Storage Root Specifies a path value that will be matched to the value in the XML 
file as the path of the HQ file. A mismatch between the two values 
causes a failure of the task.
If this field is left empty, then the value in the XML file is used as the 
HQ path of the new Title.

Proxy Storage Root Specifies a path value that will be matched to the value in the XML 
file as the path of the LQ file. A mismatch between the two values 
causes a failure of the task.
If this field is left empty, then the value in the XML file is used as the 
LQ path of the new Title.

XML Archive Dir Archives the ingested Etere XML file to a specific target directory.

Owner Specifies the owner of the element.

Resource Specifies the resource for the element. This parameter is for use 
with the dashboard.

Workflow Name This option specifies the name of the workflow to which the 
element is connected.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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Element Settings Configuration
The Wait for File workflow element resides in the Ingest group of elements and has the 
following settings:

Fig. 7-147:  Wait for File Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label of the instance. Available values are contained in the 
file: InstanceLabelConfig.xml.

Watch dir Sets the path of the directory to be monitored for the arrival of new 
files.

Fig. 7-148:  Wait for File Configuration Fields
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Schema Sets the category of metadata that can be applied to the material 
from: AudioInstance, DivaInstance, ImageInstance, Instance, Media, 
MomentumInstance, SocialInstance, SQInstance, SubtitleInstance.

Filename Sets the name of the MediaAsset file (or the name format, if using 
variables) and the file extension.

Copy in HQ Repository When enabled, saves a copy of the ingested file to the default 
directory specified in the HQ Repository field.

HQ Repository Displayed only when Copy in HQ Repository is selected.
Sets the default location to which the received files are copied, 
identifying them as High Quality.

Mode Defines how to manage the received files. You can select either 
Manual to mange the file through a manual process, or FTP to send 
the received file to another server using FTP. 

FTP host Displayed only when you select Mode FTP.
Sets the IP address of the target FTP server.

FTP user Displayed only when you select Mode FTP.
Sets the user name for the FTP process.

FTP password Displayed only when you select Mode FTP.
Sets the password for the FTP process.

FTP polling (sec) Displayed only when you select Mode FTP.
Sets the FTP polling rate in seconds.

Timeout (sec) The Timeout parameter is linked to the Retries Count parameter 
and is the time Momentum waits to confirm that the transfer of the 
monitored file has completed.
For example, if you set the Timeout to five seconds and the Retries 
Count to three, Momentum will check the size of the file three times 
to confirm that there is no change in size, and the interval between 
each check will be five seconds.
If the file size does not change during these attempts, Momentum 
concludes that the transfer of the monitored file is complete.

File timeout (sec) A configurable timeout to set the delay you want to wait for a file to 
appear in the watchfolder.
For example, if set to 60 seconds, when the task progresses to 
processing status, Momentum waits 60 seconds for the completed 
file; if this time is exceeded, the task exits through the failed port 
and generates a timeout overcome message. 
If the File timeout is set to zero, there is no limit to the length of time 
that Momentum would wait for the file to appear.

Retries count Sets a number of attempts to verify whether a media file is available.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow.The 
default setting is False (unchecked).

Option Description
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Watchfolder Workflow Elements

Overview
The Watchfolder server and its associated workflow elements Watchfolder and 
Watchfolder FTP are the major components employed by Momentum to ingest material 
into the system from external sources.

You will need to complete the following stages to ensure that your watchfolders are 
configured and running correctly:

• Configure the Momentum Server and Node components to activate the Watchfolder 
functions in:
• MantricsServer.xml

• MantricsNode.xml

• Define the ingest configuration for media asset and auxiliary files in:
• MantricsConfig.xml

•  Configure the Watchfolder templates using the Momentum Admin page.
• Select: Admin > Watch Folders
• Creates Watchfolder templates in C:\Mantrics\WatchfolderTemplates
• Default Watchfolder template: WatchfolderDefault.xml
• Other customized Watchfolder templates saved in this folder under different 

names.
• Configure the settings of the individual Watchfolder workflow elements and link to the 

target Watchfolder template.
• Define the output ports of the Watchfolder workflow element and assign the ports for 

ingest, re-ingest and update in the Watchfolder template.
• Make sure that the Watchfolder service is running on the Windows application server.

• When the basic configuration is complete, navigate to the window Control Panel 
> System and Security > Administrative Tools > Services and start the following 
Momentum manual service: Momentum WatchFolder

XML Configuration Files with Watchfolder Components
The following Momentum XML files include elements that must be defined for the correct 
functioning of the Watchfolders. The XML files are available in the default installation 
folders:

DeleteAfterIngest Displayed only when you select Copy in HQ Repository.
Deletes the original file automatically on completion of the receipt 
process, if selected.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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• C:\Mantrics

• C:\Mantrics\WatchfolderTemplates

Configuring the WatchFolder Server and Node Components
The Watchfolder Server is the key component for the ingest of material files into 
Momentum.

Before configuring the WatchFolder Server template XML files, you must first configure the 
WatchFolder Server <start> sections in both configuration files: MantricsServer.xml and 
MantricsNode.xml used to start the server and node components.

Watchfolder Configuration in MantricsServer.xml
In the file MantricsServer.xml file, locate the <start> subsection under the <wfc> 
section and set the active tag to true as shown below:

<start>
<server port="8136">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<TitleDeletionOnReIngest>false</TitleDeletionOnReIngest>

</start>

These elements set the server-side communications for the Watchfolder server.

Watchfolder Configuration in MantricsNode.xml 
In the file MantricsNode.xml, locate the <start> subsection under the 
<workflowNodeConfig> section and set the active tag to true as shown below:

<start slotCount="50">
<active>true</active>
<server port="8136">127.0.0.1</server>
<node port="8137">127.0.0.1</node>

XML File Description

Folder: C:\Mantrics

MantricsNode.xml Defines the node-side parameters to allow the watchfolder 
service to communicate with connected Momentum nodes.

MantricsServer.xml Defines the server-side parameters to allow the watchfolder 
service to communicate with the Momentum server.

MantricsConfig.xml Defines the fundamental ingest criteria (paths, file extensions, 
etc.) for media and auxiliary files.

WatchfolderDefault.xml

Or other user-defined name.
Watchfolder template defines the files, processed metadata 
and output port usage for the watchfolder element to which 
the template is assigned. In addition, defines the 
synchronization parameters, and Instance configurations.
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<pool />
</start>

These elements set the node-side communications for the Watchfolder server.

Watchfolder
The Watchfolder workflow element enables you to define how Momentum monitors for 
incoming files to ingest. When a Watchfolder element is running, it waits for a period of 
time (usually a few seconds) to ensure that the incoming file has transferred completely. 

Element Settings Configuration
TheWatchfolder workflow element resides in the Ingest group of elements and has the 
following settings:

Fig. 7-149:  Watchfolder Element

Fig. 7-150:  Watchfolder Configuration Fields
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The output ports of the Watchfolder workflow element are configured in the target 
Watchfolder template.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Delete After Ingest Automatically deletes the original file once the ingest process is 
finished, if activated.

HQ Repository Sets the default repository to which the ingested files are copied, 
identifying them as High Quality. This setting is used only when 
the tag <HQRepository> in the <File> section of the Watchfolder 
Template is left empty.

Priority Sets the priority of the tasks created by this element to either: 
Low, Medium, High, Urgent or Immediate.

Watch Dir Sets the path of the directory to be monitored for the arrival of 
new files. You can enter any UNC path into this field. Alternatively, 
use the browse button to select from a list of pre-configured 
target watch directories. 
You can configure the default list of target watch directories in the 
configuration file: MantricsConfig.xml in the section 
<IngestRootDirs>

Ext Sets a filter on the file extension. Special characters are available, 
for example, *.mov. Multiple values can be typed using a comma 
to separate them, for example, *.mov,*.avi. Do not leave a space 
between the commas.

Recurse Subdirs Activates the automatic monitoring of the subdirectories under 
the specified directory.

Check Last Access 
Time

Default option to stop the watchfolder element from checking the 
time at which the target Samba watchfolder was last accessed for 
the presence of an inbound file (the default setting is true to 
check the last access time of the target folder.) Set to false to 
switch off checking the last access time of a Samba watchfolder.

Timeout Defines the number of seconds after which a new attempt is 
made to determine whether the transfer of a file into a 
watchfolder is finished and ready for ingest.

Retries Count Sets the number of attempts to verify whether a media file is 
available in a watchfolder.

Template Select the target watchfolder template assigned to the element. 
The templates are stored by default in: 
C:\Mantrics\WatchfolderTemplates

Pool  Sets the name of a pool associated with the element to balance 
the processing load.
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WatchFolder FTP
The Watchfolder FTP workflow element enables you to define a directory that Momentum 
will monitor for incoming files using the FTP protocol.

Fig. 7-151:  Overview of Instance Metadata Schema 

Fig. 7-152:  Watchfolder FTP Element
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Element Settings Configuration
The Watchfolder FTP workflow element resides in the Ingest group of elements and has the 
following settings:

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Delete After Ingest Automatically deletes the original file once the ingest process is 
finished, if activated.

HQRepository Sets the default repository to which the ingested files are copied, 
identifying them as High Quality. This setting is used only when 
the tag <HQRepository> in the <File> section of the Watchfolder 
Template is left empty.

Priority Sets the priority of the tasks created by this element to either: 
Low, Medium, High, Urgent or Immediate.

Host Identifies the FTP host using its IP address.

User Sets the user name for logging on to the FTP host server.

Password Sets the password for logging on to the FTP host server.

Watch Dir Sets the path of the directory to be monitored for the arrival of 
new files. You can enter any UNC path into this field. 

Ext Sets a filter on the file extension.

Fig. 7-153:  Watchfolder FTP Configuration Fields
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The output ports of the Watchfolder FTP workflow element are configured in the target 
Watchfolder template.

Adding Ports to a Watchfolder Element
The standard watchfolder workflow element includes two ports by default ok and failed, 
see Figure 7-154.

Add a new port to the Watchfolder element as follows:
1 Click Add port: 

This adds a new port with the default port name label.
2 Hover the cursor over the new port to change the port label and click: , see Figure 7-

155.

This opens the Edit port dialog, see Figure 7-156.

Recurse Subdirs Activates the automatic monitoring of the subdirectories under 
the specified directory.

Polling Time (ms) Sets the interval, in milliseconds, between two access attempts 
when polling a target FTP Watchfolder directory. For example, 
180000 (three minutes).

Template Select the target watchfolder template assigned to the element. 
The templates are stored by default in: 
C:\Mantrics\WatchfolderTemplates

Pool Sets the name of a pool associated with the element to balance 
the processing load.

Option Description

Fig. 7-154: Watchfolder Workflow Element Ports

Click to Add More Output Ports

Fig. 7-155: Relabeling a New Watchfolder Port

Click to Edit the Label of the New Port
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3 Enter an appropriate label, describing the function of the port in the Label field.
4 If necessary, use the Scope drop-down menu to set conditions on the task that can be 

output by way of the new port.
The drop-down opens a search dialog that enables you to define a query, or use a 
saved query, to restrict the scope of the new port. For example, you might set the scope 
of the port to allow only the ingest of individual audio files, or captions, or enable XML 
sidecar data to update existing metadata.

5 Click Ok to save your port changes to the Watchfolder workflow element.

Modifying the Security Properties of the Configuration File
Momentum requires that its processes have free access to the configuration files. To avoid 
any access problems, the Security Properties of each file can be modified as follows:

1 At the end of the configuration procedure, navigate to C:\Mantrics.
2 Right click the following file and open the Properties panel:

WatchFolderServerConfig.xml

3 Select the Security tab.
4 From the Group or User names list, select Users.
5 Click Edit.
6 From the Group or User name list, select Users.
7 In the Permission for Users section, select the Full Control Allow option.
8 Click Apply, then OK and OK again.

Defining the Ingest Configuration in MantricsConfig
The details of the type and source of files that Momentum is able to ingest are defined in 
the file: MantricsConfig.xml.

To define the Ingest parameters for media asset files, open MantricsConfig.xml in a text 
editor and locate the section <IngestConfig>:

<IngestConfig showSystemFiles="false" showHiddenFiles="false">
<IngestTabs>

<RemoteFile>true</RemoteFile>
<RemoteDir>true</RemoteDir>
<CartMachine>false</CartMachine>
<Tape>false</Tape>
<Live>false</Live>

Fig. 7-156: Watchfolder Port Edit Port Dialog
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<Delayed>false</Delayed>
</IngestTabs>
<VideoFilePattern>

<Ext>*.*</Ext>
</VideoFilePattern>
<AudioFilePattern>

<Ext>*.*</Ext>
</AudioFilePattern>
<IgnoreFileList>

<FileName>Thumbs.db</FileName>
</IgnoreFileList>
<IngestRootDirs>

<IngestRootDir>\\ingest_hostname\TestMaterials
</IngestRootDir>

</IngestRootDirs>
</IngestConfig>

These tags enable you to specify the general behavior of the watchfolder process and have 
the following functions:

Element Description

IngestConfig Groups key parameters for the ingest of media files, including 
permitted sources, filename patterns, root directories, etc. 
Includes the attributes: showSystemFiles (true or false) and 
showHiddenFiles (true or false).

IngestTabs Groups possible permitted ingest sources.

RemoteFile Allow/disallow ingest of remote files (true or false).

RemoteDir Allow/disallow ingest from a remote directory (true or false).

CartMachine Allow/disallow ingest from Cart (cartridge) Machine (true or false).

Tape Allow/disallow ingest from Tape (true or false).

Live Allow/disallow ingest in real-time (true or false).

Delayed Allow/disallow delayed ingest (true or false).

VideoFilePattern Defines a filter on video filenames that can be ingested, for 
example <ext>*.*</ext> or <ext>*.mxf</ext>.

AudioFilePattern Defines a filter on audio filenames that can be ingested, for 
example <ext>*.*</ext>.

IgnoreFileList Groups files to exclude from ingest.

FileName: Defines each individual file to be excluded from ingest, for 
example: <FileName>Thumbs.db</FileName>

IngestRootDirs Groups root directories to use as a source of media files to 
ingest into Momentum.

IngestRootDir Defines a root directory as a source of media files for ingest. 
You can enter one or more UNC paths as required. For example: 
<IngestRootDir>\\<ingest_hostname>\TestMaterial</

ingestRootDir>.
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To define the Ingest parameters for auxiliary files (non-media files, e.g., TXT, PDF, etc.) open 
MantricsConfig.xml and locate the section <AuxConfig>:

<AuxConfig showSystemFiles="false" showHiddenFiles="false">
<IngestRootDirs>

<IngestRootDir>\\ingest_hostname\TestMaterials
</IngestRootDir>

</IngestRootDirs>
<IgnoreFileList>

<FileName>Thumbs.db</FileName>
</IgnoreFileList>

</AuxConfig>
.
.
.
<AuxiliaryFilesRepository>C:\FILES\Auxiliary\input
</AuxiliaryFilesRepository>

These tags enable you to specify the general behavior of the watchfolder process and have 
the following functions:

Using the Watchfolder Configuration Tool
Each Watchfolder workflow element is associated with a watchfolder template that defines 
the generic settings, file rules, title and instance parameters and output ports used by the 
Watchfolder to ingest media asset and auxiliary files. Momentum provides an Admin page 

Element Description

AuxConfig Groups key parameters for the ingest of auxiliary (non-
media) files, including root directories, etc. Includes the 
attributes: showSystemFiles (true or false) and 
showHiddenfiles (true or false).

IngestRootDirs Groups root directories to use as a source of auxiliary files for 
ingest.

IngestRootDir Groups root directories to use as a source of auxiliary files for 
ingest.
Defines a root directory as a source of auxiliary files for ingest. 
You can enter one or more UNC paths as required. For 
example:
<IngestRootDir>\\<ingest_hostname>\TestMaterial<
/ingestRootDir>.

IgnoreFileList Groups auxiliary files to exclude from ingest.

FileName Defines each individual file to be excluded from ingest, for 
example: <FileName>Thumbs.db</FileName>

AuxiliaryFilesRepository Defines a target folder in which Momentum saves any 
uploaded auxiliary files.
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to configure the Watchfolder templates, removing the need to open and manually edit the 
default XML watchfolder template directly.

Once you have configured your desired watchfolder templates, you can assign the 
appropriate template to a Watchfolder workflow element when defining the settings for 
that element, see Watchfolder Workflow Elements, on page 198.

Creating a New Watchfolder Template
You can configure the Watchfolder template in the Watch Folders page of the Momentum 
Admin menu as follows:

1 Select: More > Admin > Watch Folders
The Watchfolder Configuration page comprises two panes (see Figure 7-157) as follows:

• the Templates pane lists all watchfolder templates currently available in the folder: 
C:\Mantrics\WatchfolderTemplates

• the Configuration pane on the right enables you to modify and save a selected 
watchfolder template.

2 Either click one of the existing templates in the Templates pane to make changes to 
the configuration or click  to create a new watchfolder template.

3 If you chose to create a new template, enter a name for the template (without a file 
extension) in the Name field of the Create template dialog box, then click OK, see 
Figure 7-158:

Fig. 7-157:  Watchfolder Template Configuration

Available Templates Pane Watchfolder Template 
Configuration Pane
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This action creates a minimally configured watchfolder XML template in the folder:
C:\Mantrics\WatchfolderTemplates

The newly created template contains the following basic elements:

4 Continue to add the various watchfolder parameters in the Watch Folders page of the 
Momentum Admin section.
Continue as you would for modifying an existing template as described in Modifying an 
Existing Watchfolder Template, on page 210.

5 On completion, click Save to save your watchfolder settings to the Momentum 
database.
During the save process, any invalid fields are highlighted in red if they fail the 
validation checks and your changes are not saved. Momentum will focus on the invalid 
field or fields, which you will need to correct and then re-save the template.

Modifying an Existing Watchfolder Template
Modify an existing Watchfolder template in the Watch Folders page of the Momentum 
Admin menu as follows:

1 Select: More > Admin > Watch Folders
2 Select the template to modify from the list of available templates in the Templates 

pane.
This loads the current configuration of the template into the template Configuration 
pane, see Figure 7-160.

Fig. 7-158: Create Watchfolder Template Dialog

Fig. 7-159: XML Content of Basic Watchfolder Template - Watchfolder Template Dialog
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3 Modify the watchfolder template settings according to the details in the table on the 
following page.
A schematic overview of the various sections in the configuration dialog is shown in 
Figure 7-170 on page 224.

4 On completion, click Save to save the watchfolder template changes to the 
Momentum database.
During the save process, any invalid fields are highlighted in red if they fail the 
validation checks and your changes are not saved. Momentum will focus on the invalid 
field or fields, which you will need to correct and then re-save the template.

Note: The watchfolder mode is preconfigured for Manual checking.

Fig. 7-160: Watchfolder Template Configuration Initial Dialog

Parameter Options Description

Watchfolder Generic Settings (See Figure 7-161)

SyncOnStart mode everything Synchronizes the content of the watchfolders on 
starting the watchfolder service to prevent the loss 
of files that might become available when the 
watchfolder service is not running.
This ensures that any files added to the watchfolder 
during the period that the service was inactive are 
considered as new and are re-ingested.

None Will not synchronize the watchfolder on start-up or 
restart.

specificCheck Set an offset for how far back in time the 
SyncOnStart function should check the 
watchfolder on start-up or re-start (in days, hours or 
minutes).

Offset Days, Hours, Minutes Active when SyncOnStart mode is set to 
specificCheck.

Defines how far back in time the SyncOnStart 
function checks the source material folder when 
the watchfolder service is started or restarted.

Watchfolder File Rule > Generic Settings (See Figure 7-162)
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File rule section N/A Section to define a list of rules, with each file rule 
defining the type of file or files that can be 
processed by the watchfolder element to which the 
template is assigned. Click  to add more 
file rules.
For example, you might set one file rule to match 
MOV files, one for MP4 files, another for MXF files 
and so on.

Is metadata file True or false (default) Specifies whether the expected target file is a 
media asset file (false (unselected)) or is a 
metadata-only, XML sidecar file (true (selected)).
When set to true, displays the xPath field in the 
Title configuration section, and the Instance 
Segmentation sections, see below.

HQ repository Text string 
UNC Path to HQ repository

Option to override the default HQ Repository if 
defined in the Settings dialog of a Watchfolder 
workflow element. In every File rule section of the 
watchfolder template this field specifies the HQ 
repository related to the files processed by the 
specific section of the template. 
This means that the HQRepository specified in the 
Settings of the watchfolder element is a default 
repository and consequently it is used only if the 
HQ repository field in the template is empty.

File name matches 
Subsection

N/A Subsection defining attributes to match the target 
filename either according to a regular expression or 
to a file extension / extensions.

• Matching by extensions (default) Match the incoming file by file extension.

regular expression Match the incoming file by regular expression.

• Regular expression Regular expression text 
string

Displayed only when the Matching by field is set to 
regular expression.
Defines a regular expression used to match files to 
ingest using this template. For example: \.(.wmf)$, 
\w+_\w{2}\.mxf, etc.

• Extensions Text string Displayed only when the Matching by field is set 
to extensions.

Defines a list of file extensions, separated by 
commas, used to match files to ingest using this 
template. For example: .wmf, .mxf,

• Case sensitive True or false (default) Specifies the case-sensitivity of the regular 
expression. If set to true, the same result is 
obtained using the regular expression: 
'.[Mm][Xx][Ff]'

Parameter Options Description
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Skip technical analysis True or false (default) Attribute to ingest generic files but skip the 
technical analysis. If set to true, the watchfolder 
will not perform a basic information check on the 
target file.

Watchfolder File Rule > Title Configuration > Generic Settings (See Figure 7-163)

Schema Timeline, Keysegment, 
MaterialInfo, Project, 
Basicmetadata, Media, 
AudioTrack, Delivery, 
MomentumInstance, Sport, 
MomentumCore, Movie, 
Promo, Commercial, 
Junction, Programme, 
SubtitleInstance, 
SQInstance, DivaInstance, 
SocialInstance, 
AudioInstance, 
ImageInstance, 
FlashnetInstance

Sets the category of metadata that the Watchfolder 
can apply to the ingested material on Title creation. 
The default Title schema is Basicmetadata.

Title ID Subsection N/A Section to specify or generate an identifier (ID) for 
the Title created on ingest, using the following 
attributes:

File name rule create new GUID (default) Rule to create a new GUID as the Title ID on ingest.

equals file name Rule to create a Title ID that is the same as the 
ingested file name.

apply regular expression Rule to create a Title ID based on a regular 
expression.

Regular expression Regular expression text 
string
Default: ([^\]+).w+

Displayed only when the File name rule field is set 
to apply regular expression.
Defines a regular expression to generate the Title ID 
from the original filename and extension. You can 
match the regular expression to the Title filename 
and generate the TitleID using tokens. For example, 
you might use the expression "(\w+)_(\w{2})\.mxf" 
and assign the tokens (\w+) and (\w{2}) to $1 and 
$2 respectively to generate the TitleID.

Replace Default: $1 Displayed only when the File name rule field is set 
to apply regular expression.
Specify any variables to which tokens in the regular 
expression are assigned to replace elements in the 
Title ID.

Parameter Options Description
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Case as original
upper case (default)
lower case

Displayed only when the File name rule field is set 
to apply regular expression or equals file name.
Defines whether the case of the regular expression 
is significant. Select as original to ignore the case 
and use the case in the source string. Alternatively, 
set to either upper case or lower case as required.

xPath
(Metadata Only Files)

Text string; XPath Displayed only when the Is metadata file 
checkbox is set to true (checked).
Defines the root XPath of the Title metadata. For 
example: //BaseMetadata/Media/Titles

Delete if reingested True or false (default) Deletes a Title if it is re-ingested. 
If set to false, only the instance and proxy are 
deleted on a re-ingest.
If set to true, the existing Title, all Instances and 
proxies, thumbs, icons, sidecar XML and key 
segments are deleted before the new Title is re-
ingested.

Watchfolder File Rule > Title Configuration > Title Metadata (See Figure 7-164 and Figure 7-165)

Title metadata Subsection N/A Section to define a list of metadata associated with 
the ingested Title.

Metadata value Subsection N/A Click  to add list of metadata to the 
ingested Title.
You can add as many items of metadata as required 
using the available fields.

Metadata ID Drop-down menu. Defines a metadata ID to match, for example: 
"Core.Description" or "XYZ.SOM"

Use xPath
(Metadata Only Files)

True or false (default) Only available when Is metadata file is set to true.
Specifies whether to use the XPath of the metadata 
in the source file. When set to true, uses the XPath 
of the metadata in the source file

Value Text string Defines a value for the metadata. For example: 
{Instance/Core.Description}

Default
(Metadata Only Files)

Text string Only available when Is metadata file is set to true.
Defines a default value for the metadata. For 
example: HasNoMetadata

Watchfolder File Rule > Title Configuration > Title Segmentation (Metadata Sidecar Files Only) 
(see Figure 7-166) 

Segmentation Subsection N/A Section to define segmentation metadata 
supplied in metadata-only sidecar files.

Segment xPath Text string; XPath Defines the root XPath specifying the 
keysegment metadata. For example: //
metadata/tech/tcodes/segments/segment

Parameter Options Description
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Id pattern Text string; expression Defines the keysegment ID naming pattern, for 
example: {MATERIALID}-##

Create thumbnail True or false (default) When set to true, generates a thumbnail for the 
keysegment.

SOM xPath Text string; XPath Defines the XPath specifying the start of media 
(SOM) metadata, the timecode at which to start a 
keysegment. For example: ./segmentSOM

Duration xPath Text string; XPath Defines the XPath specifying the duration 
metadata for the keysegment. For example: ./
segmentDuration

Watchfolder File Rule > Title Configuration > Title Segmentation > Segment metadata 
(Metadata Sidecar Files Only) (see Figure 7-166)

Metadata value N/A Click  to define a list of segment 
metadata.
You can add as many items of metadata as required 
using the available fields.

Metadata ID Drop-down menu. The 
values are loaded according 
to the Schema value 
selected in the Title 
Configuration section.

Defines a metadata ID to match, for example: Title, 
Description, Timecode IN, MORPHEUS_ID, etc.

Use xPath True or false (default) Specifies whether to use the XPath of the metadata 
in the target file (set true or false.)

Value Text string Defines the metadata value, which can be an XPath. 

Default Text string Defines a default value for the metadata.

Watchfolder File Rule > Title Configuration > Title Behaviours (See Figure 7-167)

Behaviours Subsection N/A Section to define the behavior of the ingested Title.

Allows update True or false (default) When set to true (default), allows the existing 
instance to be updated by the ingested Title.

Allows reingest True or false (default) When set to true (default), allows deletion of the 
existing Title and re-ingest of the file.

Is update if Text string; expression Defines an additional search to assess whether the 
Title is to be updated or re-ingested. For example: 
Core.Description=’HasNoMetadata’

Watchfolder File Rule > Title Configuration > Title Ports (See Figure 7-167)

Ports Subsection N/A Section to define the watchfolder ports for different 
ingest results.

Ingest port Text string Defines the output port for successful ingest of a 
Title.

Reingest port Text string Defines the output port for re-ingest of a Title.

Parameter Options Description
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Update port Text string Defines the output port for successful update of a 
Title.

Watchfolder File Rule > Title Configuration > Instance Rules (See Figure 7-168)

Instance rules Subsection N/A This section enables you to define an association 
between material named using certain rules and 
specific metadata schema. The process can use one 
or more regular expressions to identify and select a 
subgroup of material items and then associate 
them with a specific metadata schema.
You can use a single watchfolder to apply different 
metadata schemas to the ingested material.

Instance rule Subsection N/A Click  to add fields to define instance 
rules for the ingested Title. You can add as many 
instance rules as required.
Each Instance rule groups parameters to generate 
an Instance for the target Title, with the following 
attributes.

Schema Timeline, Keysegment, 
MaterialInfo, Project, 
Basicmetadata, Media, 
AudioTrack, Delivery, 
MomentumInstance, Sport, 
MomentumCore, Movie, 
Promo, Commercial, 
Junction, Programme, 
SubtitleInstance, 
SQInstance, DivaInstance, 
SocialInstance, 
AudioInstance, 
ImageInstance, 
FlashnetInstance

Defines the metadata template (schema) that the 
Watchfolder can apply to an Instance, see Figure 7-
151 on page 202 for a schematic overview.

File name rule create new GUID (default) Rule to create a new GUID as the Instance ID on 
ingest.

equals file name Rule to create an Instance ID that is the same as the 
ingested file name.

apply regular expression Rule to create a Instance ID based on a regular 
expression.

Regular expression Regular expression text 
string
Default: ([^\]+).w+

Displayed only when the File name rule field is set 
to apply regular expression.
Defines a regular expression to generate the 
Instance from the original filename and extension. 
You can match the regular expression to the Title 
filename and generate the Instance using tokens. 
For example, you might use the expression 
"([^\]+).w+" and assign the token (\w+) to $1 to 
generate the Instance.

Parameter Options Description
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Replace Default: $1 Displayed only when the File name rule field is set 
to apply regular expression.
Specify any variables to which tokens in the regular 
expression are assigned to replace elements in the 
Instance file name.

Case as original (default)
upper case
lower case

Displayed only when the File name rule field is set 
to apply regular expression or equals file name.
Defines whether the case of the regular expression 
is significant. Select as original to ignore the case 
and use the case in the source string. Alternatively, 
set to either upper case or lower case as required.

xPath
(Metadata Only Files)

Text string; XPath Displayed only when the Is metadata file 
checkbox is set to true (checked).
Defines the root XPath of the Title metadata. For 
example: //BaseMetadata/Media/Titles

Type undefined (default), AUDIO, 
DIVA, FLASHNET, GENERIC, 
IMAGE, SOCIAL, SQ, 
SUBTITLE, VIDEO

Defines the type of Instance created at ingest.

Watchfolder File Rule > Title Configuration > Instance Rule > Metadata List (See Figure 7-168)

Metadata List Subsection N/A Defines a list of optional segmentation metadata 
that can be recovered as an XPath.

Add metadata value N/A Click  to add items of metadata 
to the Instance.
Each added metadata value defines a list of 
metadata that can match an XPath or regular 
expression in the target file, or can be taken from 
other metadata or fixed values.

Metadata value Subsection N/A You can add as many items of metadata as required 
using the Metadata ID and Value fields.

Metadata ID Drop-down menu. The 
values are loaded according 
to the Schema value 
selected in the Instance 
Rule section.

Defines a metadata ID to match, for example: 
"Core.Title" or "XYZ.SOM"

Use xPath
(Metadata Only Files)

True or false (default) Specifies whether to use the XPath of the metadata 
in the target file.

Value Text string Defines the metadata value, which can be an XPath. 

Default
(Metadata Only Files)

Text string Defines a default value for the metadata.

Watchfolder File Rule > Title Configuration > Instance Segmentation (Metadata Sidecar Files Only) (See 
Figure 7-169)

Parameter Options Description
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Segment xPath Text string; XPath Defines the root XPath specifying the keysegment 
metadata. For example: //metadata/tech/tcodes/
segments/segment

Id pattern Text string; expression Defines the keysegment ID naming pattern, for 
example: {MATERIALID}-##

Create thumbnail True or false (default) When set to true, generates a thumbnail for the 
keysegment.

SOM xPath Text string; XPath Defines the XPath specifying the start of media 
(SOM) metadata, the timecode at which to start a 
keysegment. For example: ./segmentSOM

Duration xPath Text string; XPath Defines the XPath specifying the duration 
metadata for the keysegment. For example: ./
segmentDuration

Watchfolder File Rule - Title Configuration - Instance Segmentation - Segment metadata 
(Metadata Sidecar Files Only) (See Figure 7-169)

Metadata value Subsection N/A Click  to add items of metadata to 
the ingested Title.
You can add as many items of metadata as required 
using the Metadata ID and Value fields.

Metadata ID Drop-down menu. The 
values are loaded according 
to the Schema value 
selected in the Instance 
Rule section.

Defines a metadata ID to match, for example: 
"Core.Title" or "XYZ.SOM"

Use xPath True or false (default) Specifies whether to use the XPath of the metadata 
in the target file (set true or false.)

Value Text string Defines the metadata value, which can be an XPath. 

Default Text string Defines a default value for the metadata.

Watchfolder File Rule > Title Configuration > Instance Rule > Behaviors (See Figure 7-168)

Behaviors Subsection N/A Section to define the behavior of the ingested Title.

Allows update True (default) or false When set to true (selected), allows the existing 
instance to be updated by the ingested instance.

Allows reingest True (default) or false When set to true (selected), allows deletion of the 
existing instance and re-ingest of the file.

Is update if Text string; expression Defines an additional search to assess whether the 
instance is to be updated or re-ingested. For 
example: Core.Description=’HasNoMetadata’

Watchfolder File Rule > Title Configuration > Instance Rule > Ports (See Figure 7-168)

Ports Subsection N/A Section to define the watchfolder ports for different 
ingest results.

Ingest port Text string Defines the output port for successful ingest of the 
Instance.

Parameter Options Description
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The following series of figures (Figure 7-161 to Figure 7-169) referred to in the previous 
table, are included to illustrate the various sections of the Watchfolder template 
configuration dialog as the complexity of the configuration expands.

Reingest port Text string Defines the output port for re-ingest of the 
Instance.

Update port Text string Defines the output port for successful update of 
the Instance.

Parameter Options Description

Note: You can use the keywords {W atchPath} and {W atchDir} in the 
metadata list of a Watchfolder template to use the values of these 
variables to set metadata for the Title or Instance. These two keywords 
can be used only in the watchfolder templates.

Fig. 7-161: Watchfolder Template Configuration - Generic Settings

Fig. 7-162: Watchfolder Template Configuration - File Rule Generic Settings
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Fig. 7-163: Watchfolder Template Configuration - File Rule Title Generic Settings

7-164: Watchfolder Template Configuration - File Rule Title Metadata (Media Files)

Click to Add 
New Item of 
Title Metadata 
to List

Fig. 7-165: Watchfolder Template Configuration - File Rule Title Metadata (Metadata Only Files)

Fields for 
Metadata 
Only Files
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Fig. 7-166: Watchfolder Template Configuration - File Rule Title Segmentation (Metadata Only Files)

Fig. 7-167: Watchfolder Template Configuration - File Rule Title Behaviors and Ports
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Fig. 7-168: Watchfolder Template Configuration - File Rule Title Instance Rule Settings (Media Files)
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Fig. 7-169: Watchfolder Template Configuration - File Rule Title Instance Rule Settings (Segmentation 
for Media Files Only)
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Fig. 7-170:  Overview of Watchfolder Template Configuration Components
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Configuring the Logical Operator Workflow Elements
The Logical Operator workflow elements enable you to insert logic decisional elements into 
your workflow to act on the tasks passing through your workflow. The following logical 
operators are available:

• Decisional
• Parallel Gateway
• Search Evaluator

The configuration details for these elements are provided in the following sections.

Decisional
The Decisional workflow element enables you to compare a specified condition against a 
selected type of metadata.

Element Settings Configuration
The Decisional element has the following settings:

Fig. 8-171: Decisional Workflow Element
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The Decisional workflow element includes the following specific output ports:
• Verified: The metadata matches the defined condition.
• Not Verified: The metadata does not match the defined condition.
• Not Applicable: The condition is not valid for the specified metadata.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Need instance If checked, requires the HQ instance of the propagated material to 
complete the operation and raises an alert if the HQ instance is not 
available.

Metadata Sets which type of metadata is compared.

Relational operator Sets the decisional condition from the options: equal to, greater 
than, less than or not equal to.

Value Sets the value against which the metadata is matched using the 
condition set in the Regional operator field.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 8-172:  Decsional Element Configuration Fields
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Configuration Files

MantricsServer.xml Configuration
<decisional>

<server port="8142">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</decisional>

MantricsNode.xml Configuration
<decisional slotCount="4">

<active>true</active>
<server port="8142">10.250.170.183</server>
<node port="8143">10.250.170.183</node>
<pool/>

</decisional>

Parallel Gateway
The Parallel Gateway workflow element enables you to compare a specified condition 
against a selected type of metadata.

Element Settings Configuration
The Parallel Gateway element has the following settings:

Fig. 8-173: Parallel Gateway Workflow Element
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The Parallel Gateway workflow element includes the following specific output port:
• Threshold: This port is active if the Processing Threshold checkbox is checked. The 

processing time threshold is calculated as Number of Checks x Waiting 
Time. If a time greater than this value elapses, and the processed task 
cannot be moved through the OK port (because there are still active 
jobs connected to the input port of the Parallel Gateway involving the 
material of the task in processing status) then the task moves through 
the port Threshold, freeing a processing slot on the Gateway.

Configuration Files

MantricsServer.xml Configuration
<parallelgateway>
<server port="8144">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
</parallelgateway>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Processing Threshold Enables a waiting threshold for a task in processing status. 

Number of Checks Available only if Processing Threshold is selected.
Sets how many times to run the check as to whether the task can be 
moved through the ok port.

Waiting Time (Sec) Available only if Processing Threshold is selected.
Sets the delay (in seconds) between two consecutive checks. 

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 8-174:  Parallel Gateway Element Configuration Fields
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MantricsNode.xml Configuration
<parallelgateway slotCount="4">

<active>false</active>
<server port="8144">10.250.170.183</server>
<node port="8145">10.250.170.183</node>
<pool/>

</parallelgateway>

Search Evaluator
The Search Evaluator workflow element enables you to define a search filter to check 
whether the task material matches a defined search criteria. This element can be used, for 
example, to validate the task material. You can define the search filter either for the title 
only, for the instance only or for both the title and instance. 

Element Settings Configuration
The Search Evaluator element has the following settings:

Fig. 8-175: Search Evaluator Workflow Element

Fig. 8-176:  Search Evaluator Element Configuration Fields
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Evaluate On Specify a search filter for the title only, for the instance only or for 
both the title and instance.

Title Criteria Only displayed if Evaluate On is set to Title Only or Title and 
Instance, see Figure 8-177.
Define the search query against which Momentum compares the 
Title. The Test Search button will display the results of your 
proposed search query in a pop-up window. 
For more detailed information, see the Momentum Operator’s 
Guide.

Instance Criteria Only displayed if Evaluate On set to Instance Only or Title and 
Instance, see Figure 8-177.
Define the search query against which Momentum compares the 
Instance. The Test Search button will display the results of your 
proposed search query in a pop-up window.
For more detailed information on defining Search Queries, see the 
Momentum Operator’s Guide.

Wait for verified criteria If selected the task remains in waiting status as long as the selected 
criteria are not verified.

Wait for (minutes) Displayed when the checkbox Wait for verified critieria is 
selected.
If greater than zero (0), the status of the task will change from 
waiting to processing after the waiting period (in minutes) even if 
the selected search criteria are not verified.
The timeout restarts if the Momentum server is restarted.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 8-177: Search Evaluator Query Definition Panel
232



Momentum
Operator’s Guide
The match is done not more than once every 30 seconds per task, unless some metadata of 
the TITLE or INSTANCE materials of the task don't change.

 If Wait for (minutes) parameter is greater than zero then the task remains in waiting status 
for at max the selected minutes since the first time it is evaluated (the timeout restarts in 
case the Server is restarted).

The Search Evaluator element includes the following specific ports:
• Verified: Tasks are propagated through this port when the target task material 

matches the search filter.
• Not Verified: Tasks are propagated through this port when the target task material 

does not match the search filter.

Configuration Files

MantricsServer.xml Configuration
<searchevaluator>

<server port="8216">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</searchevaluator>

MantricsNode.xml Configuration
<searchevaluator slotCount="4">

<active>true</active>
<server port="8216">10.250.170.183</server>
<node port="8217">10.250.170.183</node>
<pool/>

</searchevaluator>
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Configuring the Quality Control Workflow Elements
The Quality Control workflow elements enable you to insert quality control elements into 
your workflow to check the quality of media files passing through your workflow. The 
following QC elements are available:

• Dalet ICR UQC
• Emotion systems Eff
• Internal QC
• Interra Systems Baton
• Tektronix Aurora
• Tektronix Cerify
• Telestream VantageQC
• Telestream VidChecker
• Venera Pulsar

The configuration of quality control devices follows the same rules and guidelines as the 
Momentum Farm (see Configuring the Momentum Farm, on page 22). The configuration 
details for these elements are provided in the following sections.

Dalet ICR UQC
The ICR UQC workflow element submits video or audio material to the iCR system for 
quality control. 

Element Settings Configuration
This element is available in the Quality Control > Dalet folder and has the following 
settings:

Fig. 9-178: ICR UQC Workflow Element
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Configuration Files
The tag <icr> contains the configuration for this application.

MantricsServer.xml Configuration
<icr>

<server port="8132">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</icr>

MantricsNode.xml Configuration
<icr slotCount="4">

<active>false</active>
<server port="8132">10.250.170.183</server>
<node port="8133">10.250.170.183</node>
<pool/>
<host>http://10.10.0.49:8080</host>
<host_descr>ICR Address</host_descr>
<host_tooltip>http://10.10.0.49:8080</host_tooltip>

</icr>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

QC Template Sets the quality control template from the list available in the iCR 
system.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 9-179:  ICR UQC Element Configuration Fields
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Replace the default address of the node tag <host> with the HTTP URL of the iCR server. 
The tag <host_descr> contains a label for the host. The tag <host_tooltip> contains a 
tooltip for the host.

Emotion Systems Eff
The Eff workflow element submits video or audio material to the Eff system for quality 
control.

Element Settings Configuration
This element is available in the Quality Control > Emotion systems folder and has the 
following settings:

Note: Ensure that the option W eb Service Control is activated under the File 
Menu of iCR version 5.x.

Fig. 9-180: Eff Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Profile Sets the quality control profile.

Fig. 9-181:  Eff Element Configuration Fields
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Configuration Files
The tag <eff> contains the configuration for this application.

MantricsServer.xml Configuration
<eff>

<server port="8180">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</eff>

MantricsNode.xml Configuration
<eff slotCount="4">

<active>false</active>
<server port="8180">10.250.170.183</server>
<node port="8181">10.250.170.183</node>
<pool/>
<host>http://10.10.0.191:44544</host>
<host_descr>Eff Address</host_descr>
<host_tooltip>http://eff:44544</host_tooltip>

</eff>

Replace the default address of the tag <host> with the HTTP URL of the Eff server. The tag 
<host_descr> contains a label for the host. The tag <host_tooltip> contains a tooltip for 
the host.

Internal (Grass Valley) QC
The Internal (Grass Valley) QC workflow element is the default media quality checker 
element provided with Momentum. This element submits video material for quality 
control, which is able to detect black frames, still frames and blurred frames according to a 
configurable set of threshold sensitivities. 

Report Path Sets the location of the Eff QC report.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Note: On the host machine, the Eff application needs to be started manually. 
On the top left drop-down menu, select the option API.
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Element Settings Configuration
This element is available in the Quality Control > Internal folder and has the following 
settings:

Fig. 9-182: Internal QC Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dest Folder Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Black Detection Performs black frames detection, if activated.

Fig. 9-183: Internal QC Element Configuration Fields
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Configuration Files
The tags <mantricsQC> and <mantricsqc> contain the configuration for this application.

MantricsServer.xml Configuration
<mantricsQC>

<server port="8152">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</mantricsQC>

MantricsNode.xml Configuration
<mantricsqc slotCount="4">

<active>false</active>
<server port="8152">10.250.170.183</server>
<node port="8153">10.250.170.183</node>
<pool/>

</mantricsqc>

The node tag <server port=”xxxx”> contains the IP address and port to connect to the 
internal Momentum QC server. 

Black Error Limit Sets the maximum number of black frames that can be detected: if 
the amount of black frames exceeds this value, the material is sent 
through the Failed port.

Black Sensitivity Sets the level of gray, detected in frame pixels, that enables 
Momentum to consider a frame as black. The value is set between 0 
and 255; a higher value corresponds to more black frames detected.

Black Threshold

Blur Detection

Blur Error Limit

Blur Threshold

Still Detection

Still Error Limit

Still Sensitivity

Block Detection

Contour Accuracy

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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Interra systems Baton
The Interra Baton workflow element submits video or audio material to the Baton system 
for quality control.

Element Settings Configuration
This element is available in the Quality Control > Interra systems folder and has the 
following settings:

Configuration Files
The tag <baton> contains the configuration for this application.

Fig. 9-184: Interra Baton Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

TestPlan Sets the profile from those available in the Baton system.

QC Report Format Specifies the format of the QC report file generated at the end of 
the Baton QC process. Supported formats are: PDF or XML.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 9-185: Interra Baton Element Configuration Fields
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MantricsServer.xml Configuration
<baton>

<server port="8088">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</baton>

MantricsNode.xml Configuration
<baton slotCount="4">

<active>false</active>
<server port="8088">10.250.170.183</server>
<node port="8089">10.250.170.183</node>
<pool/>
<host>http://10.10.0.85:8080/Baton</host>
<host_descr>Baton Address</host_descr>
<host_tooltip>http://hostname:8080/Baton</host_tooltip>
<user>admin</user>
<password>admin</password>
<reportPath/>
<reportPath_descr>Report Path</reportPath_descr>

</baton>

Replace the default address of the node tag <host> with the HTTP URL of the Baton server. 
The tag <host_descr> contains a label for the host. The tag <host_tooltip> contains a 
tooltip for the host.

Replace the default text of the node tags <user> and <password> with the login 
information used to access the Baton web user interface.

Replace the default path of the node tag <reportPath> with the path where you want 
Momentum to store the QC report files in XML or PDF format.

Tektronix Aurora
The Tektronix Aurora workflow element submits video or audio material to the Aurora 
system for quality control. 

Fig. 9-186: Tektronix Aurora Workflow Element
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Element Settings Configuration
This element is available in the Quality Control > Tektronix folder and has the following 
settings:

Configuration Files
The tag <aurora> contains the configuration for this application.

MantricsServer.xml Configuration
<aurora>

<server port="8204">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<AnalyzeErrorCodes>false</AnalyzeErrorCodes>
<RootTag>InstanceFault</RootTag>
<ErrorCodeTag>FaultCode</ErrorCodeTag>
<TimeCodeTag>Timecode</TimeCodeTag>
<DescriptionTag>FaultDescription</DescriptionTag>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Template Sets the template from the list available in the Aurora system.

Report Folder Sets the target location of the Aurora QC report.

QC Report Format Specifies the format of the report file generated at the end of the 
Aurora QC process. Supported formats are: HTML, PDF or XML.

AnalyzeKeySegment When enabled, performs a quality check on the key segments.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 9-187: Interra Baton Element Configuration Fields
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Tektronix Cerify
<DurationTag>Duration</DurationTag>
<MetadataId>Instance.Generic Instance.AURORA_ERROR_RESUME

</MetadataId>
<SplitTimecode>false</SplitTimecode>
<MetadataKind>MEDIAASSET</MetadataKind>

</aurora>

MantricsNode.xml Configuration
<aurora slotCount="1">

<active>true</active>
<server port="8204">10.250.170.183</server>
<node port="8205">10.250.170.183</node>
<pool/>
<host>http://localhost:1001</host>
<host_descr>Aurora Address</host_descr>
<host_tooltip>http://aurora</host_tooltip>

</aurora>

Replace the default address of the node tag <host> with the HTTP URL of the Aurora server. 
The node tag <host_descr> contains a label for the host. The node tag <host_tooltip> 
contains a tooltip for the host.

Tektronix Cerify
The Tektronix Cerify workflow element submits video or audio material to the Cerify 
system for quality control. 

Element Settings Configuration
This element is available in the Quality Control > Tektronix folder and has the following 
settings:

Fig. 9-188: Tektronix Cerify Workflow Element
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Configuration Files
The tag <cerify> contains the configuration for this application.

MantricsServer.xml Configuration
<cerify>

<server port="8114">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</cerify>

MantricsNode.xml Configuration
<cerify slotCount="4">

<active>false</active>
<server port="8114">10.250.170.183</server>
<node port="8115">10.250.170.183</node>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Media Location Sets the media location according to the existing location set in the 
Cerify system. 

Profile Sets the quality control profile.

reportPath Sets the path for storing the report.

HttpReportPath Sets the HTTP path for storing the HTTP report.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 9-189: Tektronix Cerify Element Configuration Fields
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Telestream VantageQC
<pool>default</pool>
<cerifyNode>http://10.10.0.225:80</cerifyNode>
<cerifyNode_descr>Cerify Address</cerifyNode_descr>
<cerifyNode_tooltip>http://cerify:80</cerifyNode_tooltip>
<userCerifyNode>admin</userCerifyNode>
<userCerifyNode_descr>User</userCerifyNode_descr>
<passwordCerifyNode>admin</passwordCerifyNode>
<passwordCerifyNode_descr>Password</passwordCerifyNode_descr>
<Local_to_UNC_Remap_descr>Remap</Local_to_UNC_Remap_descr>
<Local_to_UNC_Remap/>

</cerify>

The node tag <cerifyNode> specifies the web address of the Cerify host server. The tag 
<cerfiyNode_descr> contains a label for the host. The tag <cerifyNode_tooltip> contains 
a tooltip for the host.

The node tags <userCerifyNode> and <passwordCerifyNode> specify the User and 
Password required to login and access the Cerify Web user interface. In addition, the tag 
<Local_to_UNC_Remap> enables you to remap a local path to a specific UNC address.

Telestream VantageQC
The Telestream VantageQC workflow element submits video or audio material to the 
VantageQC system for quality control.

Element Settings Configuration
This element is available in the Quality Control > Telestream folder and has the following 
settings:

Fig. 9-190: VantageQC Workflow Element
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The tag <vantageqc> contains the configuration for this application.

MantricsServer.xml Configuration
<vantageqc>

<server port="8176">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</vantageqc>

MantricsNode.xml Configuration
<vantageqc slotCount="4">

<active>false</active>
<server port="8176">10.250.170.183</server>
<node port="8177">10.250.170.183</node>
<pool/>
<ipvantage>http://10.10.0.26:8676</ipvantage>

</vantageqc>

The node tag <ipvantage> contains the connection details for the Vantage server. 

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Workflow Template Defines the profile to be applied from a list of profiles retrieved from 
VantageQC system.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 9-191: Telestream VantageQC Element Configuration Fields
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Telestream VidChecker
The Telestream VidChecker workflow element submits video or audio material to the 
VidChecker system for quality control.

Element Settings Configuration
This element is available in the Quality Control > Telestream folder and has the following 
settings:

Configuration Files
The tag <vidchecker> contains the configuration for this application.

Fig. 9-192: VidChecker Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Template Sets a template from those available in the VidCheck system.

Report Path Sets the location of the report.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 9-193: Telestream VidChecker Element Configuration Fields
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MantricsServer.xml Configuration
<vidchecker>

<server port="8174">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</vidchecker>

MantricsNode.xml Configuration
<vidchecker slotCount="4">

<active>false</active>
<server port="8174">10.250.170.183</server>
<node port="8175">10.250.170.183</node>
<pool/>
<host>http://10.10.0.84:51060</host>
<host_descr>VidChecker Address</host_descr>
<host_tooltip>http://vidchecker:51060</host_tooltip>
<api_version>6</api_version>
<api_version_tooltip>6 for Vidchecker 6.x</api_version_tooltip>

</vidchecker>

Replace the default address of the node tag <host> with the HTTP URL of the Vidchecker 
server. The tag <host_descr> contains a label for the host. The tag <host_tooltip> 
contains a tooltip for the host.

Set the API version details in the tags <api_version> and <api_version_tooltip>.

Venera Pulsar
The Venera Pulsar workflow element submits video or audio material to the Pulsar system 
for quality control.

Fig. 9-194: Pulsar Workflow Element
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Element Settings Configuration
This element is available in the Quality Control > Venera folder and has the following 
settings:

Configuration Files
The tag <pulsar> contains the configuration for this application.

MantricsServer.xml Configuration
<pulsar>

<server port="8148">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</pulsar>

MantricsNode.xml Configuration
<pulsar slotCount="4">

<active>false</active>
<server port="8148">10.250.170.183</server>
<node port="8149">10.250.170.183</node>
<pool/>
<host/>
<host_descr>Pulsar Address</host_descr>
<host_tooltip>http://pulsar:8093</host_tooltip>

</pulsar>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Template Sets a template from those available in the Pulsar system.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 9-195: Venera Pulsar Element Configuration Fields
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Replace the default address of the node tag <host> with the HTTP URL of the Pulsar server. 
The tag <host_descr> contains a label for the host. The tag <host_tooltip> contains a 
tooltip for the host. 
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Configuring the Feature Extraction Workflow Element
The Script workflow elements enable you to develop scripts containing rules and 
customized functions to manipulate your workflow. The following Script elements are 
available:

• HD-SD Virtual Router
• Script

The configuration details for these elements are provided in the following sections.

HD-SD Virtual Router
The HD-SD Virtual Router element is a Visual Basic script-based element that submits 
video material to a router, which checks the resolution of the video. By default, the element 
propagates the video through the HD port if the resolution is 1920 x 1080 and through the 
SD port if the resolution is lower than1920 x 1080. This setting can be easily customized by 
changing the resolution threshold value in the script; any changes become immediately 
available.

Element Settings Configuration
The HD-SD Virtual Router element has the following settings:

Fig. 10-196:  HD-SD Virtual Router Workflow Element
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For a more detailed description of Momentum scripting, see the appendix in the 
Momentum Operator’s Guide.

Configuration Files

MantricsServer.xml Configuration
<scripting>

<server port="8112">10.250.170.183</server>
<policy>Weighted</policy>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Language Sets the programming language of the script; the options are Visual 
Basic (.NET), C# and Python.

Libraries Folder Specifies the target folder for the Script Library files and is available 
for C# and VB.

Script Opens a script editing window where you can create or edit the 
script.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: Add ports to this element according to the functions assigned by the 
script to each port.

Fig. 10-197:  HD-SD Virtual Router Element Configuration Fields
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<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</scripting>

MantricsNode.xml Configuration
<scripting slotCount="4">

<active>true</active>
<server port="8112">10.250.170.183</server>
<node port="8113">10.250.170.183</node>
<pool/>

</scripting>

Script
The Script workflow element enables you to use a script inside the Momentum workflow, 
in order to create new customized functions. This element supports the programming 
languages: Visual Basic, Jscript and Python.

Element Settings Configuration
The Script element has the following settings:

Fig. 10-198:  Script Workflow Element
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Element Settings Configuration
For a more detailed description of Momentum scripting, see the appendix in the 
Momentum Operator’s Guide.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Need instance Requires the HQ instance of the material to complete the operation, 
if selected.

Language Sets the programming language of the script; the options are C#, 
Python or Visual Basic (VB).

Libraries Folder Specifies the target folder for the Script Library files and is available 
for C# and VB.

Script Opens a script editing window where you can create or edit the 
script.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: Add ports to this element according to the functions assigned by the 
script to each port.

Fig. 10-199:  HD-SD Virtual Router Element Configuration Fields
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Configuration Files

MantricsServer.xml Configuration
<scripting>

<server port="8112">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</scripting>

MantricsNode.xml Configuration
<scripting slotCount="4">

<active>true</active>
<server port="8112">10.250.170.183</server>
<node port="8113">10.250.170.183</node>
<pool/>

</scripting>
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Configuring the Transcoder Workflow Elements
The Transcoder workflow elements enable you insert transcoder elements to transcode 
media files into different formats, depending on the supported codecs.

 The following transcoders are available:
• Capella Systems Cambria
• Dalet iCR Transcoder
• EEG CCPlayFilePro
• FFmpeg Proxy
• FFmpeg Transcoder
• Grass Valley Alchemist XF
• Grass Valley Quasar XF
• Harmonic Rhozet ProMediaCarbon PMC Bumper
• Harmonic Rhozet ProMediaCarbon PMC EDL Exporter
• Harmonic Rhozet ProMediaCarbon PMC Transcoder
• Harmonic Rhozet ProMediaCarbon Segments Consolidator
• Harmonic Rhozet WFS EDL Exporter
• Harmonic Rhozet WFS Transcoder
• Telestream FlipFactory
• Telestream Vantage Transcoder
• Wohler RadiantGrid
• Audio Morph
• Omneon Consolidator
• Thumb Generator

The configuration details for these elements are provided in the following sections.

Before Starting
Before configuring transcoding engines, check the following:

• Make sure that the Momentum application is installed on a machine connected on the 
same network of the third party transcoding device you want to use.

Note: All the elements described in this section require configuration of 
the files MantricsServer.xml and MantricsNode.xml.
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• Check that the Momentum Transcoder Service has the Log On As setting that uses the 
same account of the third party application service you want to use.

• Make sure that the location of the media files is fully accessible by both Momentum 
and third party applications.

• Make sure that the firewall of third party machines is configured to allow the service to 
communicate on the appropriate port.

Adding a Transcoding Engine
Transcoding engines are configured by modifying the files MantricsServer.xml and 
MantricsNode.xml, where each module has a related section and can be enabled or 
disabled by setting the value of the related Active node to true or false respectively.

To add a transcoding engine to Momentum:
1 Open the Control Panel > Administrative Tools > Services window and stop the 

Momentum Server and the Momentum Node services.
2 Navigate to the directory C:\Mantrics and open the files MantricsServer.xml and 

MantricsNode.xml using a text editor.
3 Find the configuration sections corresponding to the transcoder you want to add, and 

replace the default settings as described in Configuring the Momentum Farm, on 
page 22. Some transcoders require additional, non-standard configuration which is 
described in the following sections.

4 Save the files MantricsServer.xml and MantricsNode.xml to store the new settings.
5 Open the Control Panel > Administrative Tools > Services window and re-start the 

Momentum Server and the Momentum Node services.

Capella Systems Cambria FTC
The Capella Systems Cambria workflow element transcodes a wide range of professional 
digital video formats, including HQX .

Element Settings Configuration
This element is available in the Transcoding > Capella systems folder and has the 
following settings:

Fig. 11-200: Capella Systems Cambria Transcoder Workflow Element
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MantricsServer.xml Configuration
<cambria>

<server port="8220">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</cambria>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Preset Sets which preset is to be used for the transcoding.

Destination Sets the destination directory. Type in the UNC path or set it using 
the browser.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 11-201:  Cambria Transcoder Element Configuration Fields
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Dalet iCR Transcoder
MantricsNode.xml Configuration
<cambria slotCount="4">

<active>false</active>
<server port="8220">10.250.170.183</server>
<node port="8221">10.250.170.183</node>
<pool/>
<ipCambriaServer>http://10.10.5.28:8647</ipCambriaServer>
<profilePath/>

</cambria>

The tag <ipCambriaServer> contains the configuration details to allow this application to 
communicate with Momentum.

Replace the default text of the <ipCambriaServer> tag with the HTTP URL of the Cambria 
server. 

Dalet iCR Transcoder
The iCR Transcoder workflow element enables you to select a profile from the template 
available in the iCR system.

Element Settings Configuration
This element is available in the Transcoding > Dalet folder and has the following settings:

Fig. 11-202: Dalet iCR Transcoder Workflow Element
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MantricsServer.xml Configuration
<icrtranscoder>

<server port="8156">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</icrtranscoder>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Label Sets the label of the instance generated by the transcoding.

Preset Sets the transcoding preset for the iCR system.

DstFolder Sets the destination directory. Type in a UNC path or set it by using 
the browser.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material. 

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 11-203: iCR Transcoder Element Configuration Fields
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MantricsNode.xml Configuration
<icrtranscoder slotCount="4">

<active>false</active>
<server port="8156">10.250.170.183</server>
<node port="8157">10.250.170.183</node>
<pool/>
<icrTranscodeNode port="8080">10.10.0.49</icrTranscodeNode>

</icrtranscoder>

The tag <icrtranscoder> contains the configuration for this application.

Replace the default text of the node tag <icrTranscodeNode> with the HTTP URL of the 
Dalet iCR machine.

EEG CCPlayFilePro Transcoder
The CCPlayFilePro Transcoder workflow element submits video and caption material to 
FilePro CCPlay software for the inclusion of closed captions into professional video 
exchange formats. 

Element Settings Configuration
This element is available in the Transcoding > EEG folder and has the following settings:

Fig. 11-204: EEG CCPlayFilePro Transcoder Workflow Element

Fig. 11-205: CCPlayFilePro Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<ccplayfilepro>

<server port="8206">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</ccplayfilepro>

MantricsNode.xml Configuration
<ccplayfilepro slotCount="4">

<active>false</active>
<server port="8206">10.250.170.183</server>
<node port="8207">10.250.170.183</node>
<pool/>
<host>http://10.10.5.1:8080</host>
<host_descr>CCPlayFilePro Address</host_descr>
<host_tooltip>http://CCPlayFilePro:8080</host_tooltip>

</ccplayfilepro>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Dst Folder Sets the destination directory. Type in the UNC path or set it using 
the browser.

Operation Specifies the operation to be performed by the transcoder as the 
following:
Legalize - Legalize captions embedded in a video file.

Profile Defines a profile for the input files to be collected by the transcoder.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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FFmpeg Proxy Transcoder
The tag <ccplayfilepro> contains the configuration for this application.

Replace the default address of the node tag <host> with the HTTP URL of the CCPlayFilePro 
server and use the port: 8080. The tag <host_descr> contains a label for the host. The tag 
<host_tooltip> contains a tooltip for the host.

FFmpeg Proxy Transcoder
The FFmpeg Proxy transcoder workflow element contains pre-configured settings that 
transcode video, audio or image materials to a 25 fps H.264 encoded video file (MPEG-4). 

Element Settings Configuration
This element is available in the Transcoding > FFmpeg folder and has the following 
settings:

Note: The workflow element FFm peg Proxy is a preconfigured instance of the 
FFm peg workflow element. 

Fig. 11-206: FFmpeg Transcoder Workflow Element
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Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dest folder Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Select Video params Checkbox to display settings to transcode video source material. 
(Default: Unselected)

Select Audio params Checkbox to display settings to transcode audio source material. 
(Default: Unselected)

Select Image params Checkbox to display settings to transcode graphic image source 
material.(Default: Unselected)

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Video Settings (Displayed when the checkbox Select Video params is selected.)

Video bit rate Sets the video bit rate (default: 512).

Width Sets the width of the video output in pixels. (Default: 480)

Height Sets the height of the video output in pixels. (Default: 270)

Audiotrack bit rate Sets the audio track bit rate (default: 128 kbps).

Audio Settings (Displayed when the checkbox Select Audio params is selected.)

Fig. 11-207: FFmpeg Proxy Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<ccplayfilepro>

<server port="8206">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</ccplayfilepro>

MantricsNode.xml Configuration
<ffmpeg slotCount="4">

<active>true</active>
<server port="8096">10.250.170.183</server>
<node port="8097">10.250.170.183</node>
<pool/>
<ExecutablePath>C:\Mantrics\ffmpeg\bin\ffmpeg.exe</ExecutablePath>

</ffmpeg>

The tag <ffmpeg> contains the configuration for the default transcoder provided with 
Momentum.

The node tag <ExecutablePath> specifies the path where the executable file ffmpeg.exe 
is located.

FFmpeg Transcoder
The Momentum FFmpeg Transcoder element is the default transcoder provided with 
Momentum

This element transcodes video, audio or image materials in a range of different output 
formats. This workflow element can also transcode both Audio and Graphic Image 
instances. In the case of audio files, the FFmpeg transcoder can create MP3 files as proxies 
from Audio Instance source media files.

Audio bit rate Sets the audio bit rate (for example, 128000 is 128kbps).

Image Settings (Displayed when the checkbox Select Image params is selected.)

Image Width Sets the width of the output file in pixels.

Image Height Sets the height of the output file in pixels.

Option Description
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Element Settings Configuration
This element is available in the Transcoding > FFmpeg folder and has the following 
settings:

Note: The FFM peg Transcoder workflow element will complete the 
transcoding process even if the file path of the source media file 
contains special characters in Unicode that are not present in the 
English alphabet (for example, Cyrillic characters.)

Note: The workflow element FFm peg Proxy is a preconfigured instance of the 
FFm peg Transcoder workflow element. 

Fig. 11-208: FFmpeg Transcoder Workflow Element

Fig. 11-209: FFmpeg Transcoder Element Configuration Fields - Part 1
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Option Description

Generic Settings

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Label Sets the label of the Instance generated by the transcoding process.

Dest Folder Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Select Video params Checkbox to display settings to transcode video source material. 
(Default: Unselected)

Select Audio params Checkbox to display settings to transcode audio source material. 
(Default: Unselected)

Select Image params Checkbox to display settings to transcode graphic image source 
material.(Default: Unselected)

isProxy Sets the flag to identify the results of the transcoder element as 
proxy. This is a low quality previews of the related material. When it 
is active, some of the above options become locked to preserve the 
characteristics of the original file.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 11-210: FFmpeg Transcoder Element Configuration Fields - Part 2
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Video Settings (Displayed when the checkbox Select Video params is selected.)

Video Format Sets the output format of the video file.

Extension Sets the extension of the output file (for example, mpg, avi, mov 
etc.)

Video Codec Sets the video codec to generate the output file. Default: copy.

Video bit rate Sets the video bit rate (for example, 6000000 is 60Kbps).
Also displayed when the isProxy checkbox is selected.

Width Sets the width of the video output in pixels.
Also displayed when the isProxy checkbox is selected.

Height Sets the height of the video output in pixels.
Also displayed when the isProxy checkbox is selected.

Video frame rate Sets the frame rate of the output file. Default: Source frame rate.
Other options are: 23.976, 50, 59.94, NTSC (29.97), NTSC (30), PAL 
(25), True Cinema

Aspect ratio Sets the aspect ratio of the output file.

Audiotrack Codec Sets the audiotrack codec of the output file. Default: copy.
Also displayed when the isProxy checkbox is selected.

Audiotrack bit rate Sets the audio bit rate (for example, 128000 is 128 kbps).

Audiotrack frequency Sets the sampling rate of the audio track in Hz (for example, 44100, 
48000, 96000 etc.)

Audiotrack channels Sets the number of audio track channels in the output file.

ExtraParameters Sets other parameters that affect the video output file. For example, 
the option -movflags faststart enables the generation of MP4 
proxy files that can be more easily streamed.

Audio Settings (Displayed when the checkbox Select Audio params is selected.)

Audio Format Sets the output format of the audio file.

Audio Codec Sets the video codec of the output file.

Audio bit rate Sets the video bit rate (for example, 6000000 is 60Kbps).
Also displayed when the isProxy checkbox is checked.

Audio frequency Sets the sampling rate of the audio in Hz (for example, 44100, 
48000, 96000 etc.)

Audio channels Sets the number of audio track channels in the output audio file.

Extra Parameters Sets additional parameters that may affect the output audio file.

Image Settings (Displayed when the checkbox Select Image params is selected.)

Image Extension Sets the extension of the output file (for example, png, bmp, gif, jpg, 
tif, tga, icb, vda, vst etc.)
Not displayed when the isProxy checkbox is selected but 
Momentum sets the proxy extension to png.

Option Description
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MantricsServer.xml Configuration
<ffmpeg>

<server port="8096">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</ffmpeg>

MantricsNode.xml Configuration
<ffmpeg slotCount="4">

<active>true</active>
<server port="8096">10.250.170.183</server>
<node port="8097">10.250.170.183</node>
<pool/>
<ExecutablePath>C:\Mantrics\ffmpeg\bin\ffmpeg.exe</ExecutablePath>

</ffmpeg>

The tag <ffmpeg> contains the configuration for the default transcoder provided with 
Momentum.

The node tag <ExecutablePath> specifies the path where the executable file ffmpeg.exe 
is located.

Image Width Sets the width of the output file in pixels.
Also displayed when the isProxy checkbox is selected.

Image Height Sets the height of the output file in pixels.
Also displayed when the isProxy checkbox is selected.

Extra Parameters Sets other parameters that affect the output image file.

Option Description
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3GP (3GPP file format) ISMV/ISMA (Smooth 
Streaming

PCM signed 16-bit little-
endian

raw MLP

3GP2 (3GPP2 file format) JACOsub subtitle format PCM signed 24-bit big-
endian

raw MPEG-1 video

3GPP AMR Lego Mindstorms RSO PCM signed 24-bit little-
endian

raw MPEG-2 video

a64 - video for 
Commodore 64

LOAS/LATM PCM signed 32-bit big-
endian

raw MPEG-4 video

Adobe Filmstrip Loki SDL MJPEG PCM signed 32-bit little-
endian

raw null video

ADTS AAC (Advanced 
Audio Coding)

Matroska PCM signed 8-bit raw TrueHD

Apple CAF (Core Audio 
Format)

MD5 testing PCM unsigned 16-bit big-
endian

raw VC-1 video

Apple HTTP Live 
Streaming

MicroDVD subtitle format PCM unsigned 16-bit little-
endian

raw video

ASF (Advanced / Active 
Streaming Format)

Microsoft Windows ICO PCM unsigned 24-bit big-
endian

raw WavPack

AST (Audio Stream) MIME multipart JPEG PCM unsigned 24-bit little-
endian

RealMedia

Audio IFF MP2 (MPEG audio layer 2) PCM unsigned 32-bit big-
endian

RTP output

AVI (Audio Video 
Interleaved)

MP3 (MPEG audio layer 3) PCM unsigned 32-bit little-
endian

RTSP output

Berkeley/IRCAM/CARL 
Sound Format

MP4 (MPEG-4 Part 14) PCM unsigned 8-bit SAP output

caca (color ASCII art) 
output device

MPEG-1 Systems / MPEG 
program stream

Per-frame MD5 testing SDL output device

CRC testing MPEG-1 Systems / MPEG 
program stream (VCD)

piped image2 sequence Segment

Creative Voice MPEG-2 PS (DVD VOB) PSP MP4 (MPEG-4 Part 14) Smooth Streaming Muxer

CRI ADX MPEG-2 PS (SVCD) QuickTime / MOV Sony OpenMG audio

D-Cinema audio MPEG-2 PS (VOB) raw AC-3 Sony Wave64

DV (Digital Video) MPEG-TS (MPEG-2 
Transport Stream)

raw Chinese AVS (Audio 
Video Standard) video

SoX native

extract pts as timecode v2 
format, as defined by 
mkvtoolnix

Multiple muxer tee raw data SSA (SubStation Alpha) 
subtitle

F4V Adobe Flash Video MXF (Material eXchange 
Format)

raw Dirac streaming segment muxer
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FFM (FFserver live feed) MXF (Material eXchange 
Format) D-10 Mapping

raw DNxHD (SMPTE VC-3) SubRip subtitle

FFmpeg metadata in text NUT raw DTS Sun AU

FLV (Flash Video) Ogg raw E-AC-3 SWF (ShockWave Flash)

framecrc testing On2 IVF raw FLAC SWF (ShockWave Flash) 
(AVM2)

G.729 BIT file format PCM 32-bit floating-point 
big-endian

raw G.722 VC-1 test bitstream

GIF Animation PCM 32-bit floating-point 
little-endian

raw G.723.1 WAV / WAVE (Waveform 
Audio)

GXF (General eXchange 
Format)

PCM 64-bit floating-point 
big-endian

raw H.261 WebM

IEC 61937 (used on S/PDIF 
- IEC958)

PCM 64-bit floating-point 
little-endian

raw H.263 WebVTT subtitle

iLBC storage PCM A-law raw H.264 video Windows Television (WTV)

image2 sequence PCM mu-law raw id RoQ Yamaha SMAF

iPod H.264 MP4 (MPEG-4 
Part 14)

PCM signed 16-bit big-
endian

raw MJPEG video YUV4MPEG pipe

FFmpeg Transcoder - Video and Audio Format Options
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AJA Kona 10-bit RGB 
Codec

H.263 / H.263-1996 MPEG-4 part 2 Sun Rasterfile image

AMV Video H.263+ / H.263-1998 / 
H.263 version 2

MPEG-4 part 2 Microsoft 
variant version 2

TIFF Image

Apple ProRes Huffyuv / HuffYUV MPEG-4 part 2 Microsoft 
variant version 3 (codec 
msmpeg4v3)

Truevision Targa image

Apple (codec prores) Huffyuv FFmpeg variant Multicolor charset for 
Commodore 64 (codec 
a64_multi)

Uncompressed 4:2:2 10-bit

Apple (iCodec Pro) (codec 
prores)

id RoQ video (codec roq) Multicolor charset for 
Commodore 64, extended 
with 5th color (colram) 
(codec a64_multi5)

Uncompressed 4:4:4 10-bit

ASUS V1 JPEG 2000 OpenJPEG JPEG 2000 
(codec jpeg2000)

Uncompressed packed 
4:2:0

ASUS V2 JPEG-LS PAM (Portable AnyMap) 
image

Uncompressed packed 
4:4:4

Avid 1:1 10-bit RGB Packer LCL (LossLess Codec 
Library) ZLIB

PBM (Portable BitMap) 
image

Uncompressed packed MS 
4:4:4:4

Avid Meridien 
Uncompressed

libschroedinger Dirac 2.2 
(codec dirac)

PC Paintbrush PCX image Uncompressed packed QT 
4:4:4:4

BMP (Windows and OS/2 
bitmap)

libtheora Theora (codec 
theora)

PGM (Portable GrayMap) 
image

Uncompressed RGB 10-bit

Cirrus Logic AccuPak libvpx VP8 (codec vp8) PGMYUV (Portable 
GrayMap YUV) image

Uncompressed YUV 4:1:1 
12-bit

copy libx264 H.264 / AVC / 
MPEG-4 AVC / MPEG-4 
part 10 (codec h264)

PNG (Portable Network 
Graphics) image

Ut Video

DPX image libx264 H.264 / AVC / 
MPEG-4 AVC / MPEG-4 
part 10 RGB (codec h264)

PPM (Portable PixelMap) 
image

VC3/DNxHD

DV (Digital Video) libxavs Chinese AVS (Audio 
Video Standard) (codec 
cavs)

QuickTime Animation 
(RLE) video

Windows Media Video 7

FFmpeg video codec #1 libxvidcore MPEG-4 part 2 
(codec mpeg4)

Raw video Windows Media Video 8
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Flash Screen Video Lossless JPEG RealVideo 1.0 XBM (X BitMap) image

Flash Screen Video Version 
2

Microsoft Video-1 RealVideo 2.0 X-face image

FLV / Sorenson Spark / 
Sorenson H.263 (Flash 
Video) (codec flv1)

MJPEG (Motion JPEG) SGI image XWD (X Window Dump) 
image

GIF (Graphics Interchange 
Format)

MPEG-1 Video Snow Zip Motion Blocks Video

H.261 MPEG-2 Video Sorenson Vector Quantizer 
1 / Sorenson Video 1 / 
SVQ1

FFmpeg Transcoder - Video Codec Options
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AAC (Advanced Audio 
Coding)

G.726 ADPCM (codec 
adpcm_g726)

PCM A-law / G.711 A-law PCM unsigned 24-bit big-
endian

ADPCM IMA QuickTime id RoQ DPCM PCM D-Cinema audio 
signed 24-bit

PCM unsigned 16-bit little-
endian

ADPCM IMA WAV iLBC (Internet Low Bitrate 
Codec) (codec ilbc)

PCM mu-law / G.711 mu-
law

PCM unsigned 32-bit big-
endian

ADPCM Microsoft libgsm GSM (codec gsm) PCM signed 16-bit big-
endian

PCM unsigned 32-bit little-
endian

ADPCM Shockwave Flash libgsm GSM Microsoft 
variant (codec gsm_ms)

PCM signed 16-bit big-
endian planar

PCM unsigned 8-bit

ADPCM Yamaha libmp3lame MP3 (MPEG 
audio layer 3) (codec mp3)

PCM signed 16-bit little-
endian

RealAudio 1.0 (14.4K) 
(codec ra_144)

ALAC (Apple Lossless 
Audio Codec)

ibopus Opus (codec opus) PCM signed 16-bit little-
endian planar

RFC 3389 comfort noise 
generator

Android VisualOn AAC 
(Advanced Audio Coding) 
(codec aac)

libspeex Speex (codec 
speex)

PCM signed 24-bit big-
endian

SEGA CRI ADX ADPCM

Android VisualOn AMR-WB 
(Adaptive Multi-Rate 
Wide-Band) (codec 
amr_wb)

libtwolame MP2 (MPEG 
audio layer 2) (codec mp2)

PCM signed 24-bit little-
endian

SMPTE 302M

ATSC A/52 E-AC-3 libvorbis (codec vorbis) PCM signed 24-bit little-
endian planar

Sonic

ATSC A/52A (AC-3) MP2 (MPEG audio layer 2) PCM signed 32-bit big-
endian

Sonic lossless

ATSC A/52A (AC-3) (codec 
ac3)

Nellymoser Asao PCM signed 32-bit little-
endian

TTA (True Audio)

Copy (default) OpenCORE AMR-NB 
(Adaptive Multi-Rate 
Narrow-Band) (codec 
amr_nb)

PCM signed 32-bit little-
endian planar

Vorbis

DCA (DTS Coherent 
Acoustics) (codec dts)

PCM 32-bit floating point 
big-endian

PCM signed 8-bit Windows Media Audio 1

FLAC (Free Lossless Audio 
Codec)

PCM 32-bit floating point 
little-endian

PCM signed 8-bit planar Windows Media Audio 2

G.722 ADPCM (codec 
adpcm_g722)

PCM 64-bit floating point 
big-endian

PCM unsigned 16-bit big-
endian

G.723.1 PCM 64-bit floating point 
little-endian

PCM unsigned 16-bit little-
endian
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Configuring the FFMpeg Frame Rate
To reduce possible errors while working with the FFMpeg transcoder, the available frame 
rates are stored in the configuration file C:\mantrics\FFMpegFramerateConfig.xml. The 
content of this file is as follows:

<?xml version="1.0" encoding="utf-8"?>
<root xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema">

<node label="Source frame rate" value="" />
<node label="23.976" value="23.976" />
<node label="50" value="50" />
<node label="59.94" value="59.94" />
<node label="NTSC (29.97)" value="29.97" />
<node label="NTSC (30)" value="30" />
<node label="PAL (25)" value="25" />
<node label="True Cinema" value="24" />

</root>

Each <node label="xxx..."> tag specifies the value of a commonly used frame rate.

You can add new nodes if frame rates have values other than those listed. When running 
Momentum, the label parameters appear as a drop-down list in the Video frame rate field 
of the FFmpeg workflow element, enabling you to select the appropriate frame rate. The 
value parameter is passed to the transcoder.

Grass Valley Alchemist XF Transcoder
The GV Alchemist XF transcoder workflow element transcodes content using presets and 
can also create proxies.

Element Settings Configuration
This element is available in the Transcoding > Grass Valley folder and has the following 
settings:

Fig. 11-211: GV Alchemist XF Transcoder Workflow Element
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MantricsServer.xml Configuration
<alchemistOD>

<server port="8186">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

preset Sets which preset is to be used for the transcoding.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

destination Sets the destination directory. Type in the UNC path or set it using 
the browser.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 11-212: GV Alchemist XF Transcoder Element Configuration Fields
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<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</alchemistOD>

MantricsNode.xml Configuration
<alchemistOD slotCount="4">

<active>false</active>
<server port="8186">10.250.170.183</server>
<node port="8187">10.250.170.183</node>
<pool/>
<ipAlchemistODServer>http://10.10.5.22:35061</ipAlchemistODServer>

</alchemistOD>

The tag <alchemistOD> contains the configuration for the GV Alchemist XF transcoder.

In the node tag <ipAlchemistODServer>, insert the web address and port number, using 
the HTTP protocol to identify the host server of the Alchemist application.

Grass Valley Quasar XF Transcoder
The GV Quasar XF transcoder workflow element transcodes content using presets and can 
also create proxies.

Element Settings Configuration
This element is available in the Transcoding > Grass Valley folder and has the following 
settings:

Fig. 11-213: GV Quasar XF Transcoder Workflow Element
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MantricsServer.xml Configuration
<quasarOD>

<server port="8183">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

preset Sets which preset is to be used for the transcoding.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

destination Sets the destination directory. Type in the UNC path or set it using 
the browser.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 11-214: GV Quasar XF Transcoder Element Configuration Fields
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<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</quasarOD>

MantricsNode.xml Configuration
<quasarOD slotCount="4">

<active>false</active>
<server port="8183">10.250.170.183</server>
<node port="8189">10.250.170.183</node>
<pool/>
<ipQuasarODServer>http://10.10.5.22:35061</ipQuasarODServer>

</quasarOD>

The tag <quasarOD> contains the configuration for the GV Quasar XF transcoder.

In the node tag <ipQuasarODServer>, insert the web address and port number, using the 
HTTP protocol to identify the host server of the Quasar application.

Harmonic Rhozet PMC Bumper
The PMC Bumper element is not a transcoder but it works on the PMC transcoder and 
enables you to stitch video to the head and tail of other video material.

Element Settings Configuration
This element is available in the Transcoding > Harmonic Rhozet > ProMediaCarbon 
folder and has the following settings:

Note: To use this element, a Rhozet transcoder engine must be available in 
your Momentum system.

Fig. 11-215: PMC Bumper Workflow Element
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Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label of the instance generated by the transcoding.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Preset Sets the output format by selecting a profile from the presets 
available in the Rhozet system.

Dst Sets the destination directory. You can type it by using a UNC path 
or set it by using the browser.

Head Sets the material from the central repository to be stitched to the 
head of the destination material. You can set it by typing in a UNC 
path or by using the browser.

Head Label Sets the label of the head section generated by the transcoding.

Tail Sets the material from the central repository to be stitched to the 
tail of the destination material. You can set it by typing in a UNC 
path or by using the browser.

Tail Label Sets the label of the tail section generated by the transcoding.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 11-216: PMC Bumper Element Configuration Fields
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MantricsServer.xml Configuration
<headAndTail>

<server port="8102">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</headAndTail>

MantricsNode.xml Configuration
<headandtail slotCount="-1">

<active>false</active>
<server port="8102">10.250.170.183</server>
<node port="8103">10.250.170.183</node>
<pool/>
<headAndTailNode port="1120">10.10.0.222</headAndTailNode>
<headAndTailNode_descr>Rhozet Host</headAndTailNode_descr>

</headandtail>

The PMC Bumper is not a transcoder element but it works on the PMC transcoder. The 
server tag <headAndTail> contains the configuration for this application.

The node tag <headAndTailNode port=””> defines the IP address and port number used 
to send API commands from the third party application. If the PMC Bumper node and the 
Rhozet node are installed on different machines, include the IP address of the Rhozet 
machine. The node tag <headAndTailNode_descr> contains a label for the server.

Harmonic Rhozet PMC EDL Exporter
The PMC EDL Exporter element can be used to export an Edit Decision List (EDL).

Fig. 11-217: PMC EDL Exporter Workflow Element
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This element is available in the Transcoding > Harmonic Rhozet > ProMediaCarbon 
folder and has the following settings:

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dst Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Label Sets the label of the instance generated by the transcoding.

Tail Sets how many seconds are added to the tail of the EDL.

Schema Sets the metadata schema to be used.

PresetAudio Sets the audio transcoding profile for the Rhozet system.

Preset Sets the transcoding profile for the Rhozet system.

Export To Sets the EDL output format. The values are: Final Cut or Consolidate 
(see Harmonic Rhozet PMC Bumper, on page 282).

Head Sets how many seconds are added to the head of the EDL.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Fig. 11-218: PMC EDL Exporter Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<rhozetConsolidate>

<server port="8100">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<MacMapDirectory/>

</rhozetConsolidate>

MantricsNode.xml Configuration
<rhozetconsolidate slotCount="-1">

<active>false</active>
<server port="8100">10.250.170.183</server>
<node port="8101">10.250.170.183</node>
<pool/>
<rhozetConsolidateNode port="1120">10.10.0.222

</rhozetConsolidateNode>
<rhozetConsolidateNode_descr>Rhozet Host</

rhozetConsolidateNode_descr>
</rhozetconsolidate>

The tag <rhozetConsolidate> contains the configuration for this application.

The server tag <MacMapDirectory> defines the directory in which the exported XML EDLs 
are saved and maps a Microsoft Windows directory to the corresponding Apple Mac 
directory. For further details, see Configuring Additional Momentum Features, on page 323.

For example:
<MacMapDirectory>

  <MapDir windir="\\mtraining" macdir="/Volumes/" />

</MacMapDirectory>

The node tag <rhozetConsolidateNode port=””> defines the IP address and port number 
used to send API commands from the third party application. The node tag 
<rhozetConsolidateNode_descr> contains a label for the server.

Harmonic Rhozet PMC Transcoder
The PMC Transcoder element enables you to select a profile from the presets available in 
the Rhozet system. Use it to set the destination directory in which the transcoded file is 
created.

Note: Ensure that the Nexus Service is running on the host machine.
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This element is available in the Transcoding > Harmonic Rhozet > ProMediaCarbon 
folder and has the following settings:

Fig. 11-219: PMC Transcoder Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dst Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Label Sets the label of the instance generated by the transcoding.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Preset Sets the transcoding preset for the Rhozet system.

Fig. 11-220: PMC Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<rhozet>

<server port="8084">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<overwriteInstance>false</overwriteInstance>

</rhozet>

MantricsNode.xml Configuration
<rhozet slotCount="-1">

<active>false</active>
<server port="8084">10.250.170.183</server>
<node port="8085">10.250.170.183</node>
<pool/>
<rhozetNode port="1120">10.250.170.183</rhozetNode>
<rhozetNode_descr>Rhozet Host</rhozetNode_descr>

</rhozet>

The tag <rhozet> contains the configuration for this application.

The server tag <overwriteInstance> defines the behavior if an instance of the transcoded 
material, with the same characteristics, is already present in the database. Set the value to 
true to overwrite or false to preserve the existing instance.

For example:
<overwriteInstance>true</overwriteInstance>

The node tag <rhozetNode port=””> defines the IP address and port number used to send 
API commands from the third party application. The node tag <rhozetnode_descr> 
contains a label for the server.

extraParam Sets additional parameters for the XML file that is sent to the 
transcoder node in order to enable specific filters or functionality. 
For example, it is possible to extract the timecode track from the 
essence instead of reading the timecode from the wrapper 
metadata.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material. 

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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The Segments Consolidator element uses the key segments associated with a material to 
create a new Title and, in addition, creates an XML document associated with the new 
material that is used to publish this content to the Brightcove or FreeWheel video-on-
demand (VOD) systems.

Element Settings Configuration
This element is available in the Transcoding > Harmonic Rhozet > ProMediaCarbon 
folder and has the following settings:

Note: Ensure that the Nexus Service is running on the host machine.

Fig. 11-221: PMC Transcoder Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label of the instance. The available values are contained in 
the InstanceLabelConfig.xml file.

Switch new title Passes the new Title to the following steps of the workflow, if active.

Dst Sets the destination directory. Enter the UNC path or set it using the 
browser.

Preset Specifies the Rhozet preset used to consolidate the material.

Schema Sets the category of metadata that can be applied to the material 
(see the Momentum Operator’s Guide for details).

TitleId Sets the Material Id value for the material (use of the Momentum 
system variables is allowed).

Title Sets the Title value for the material (use of the Momentum system 
variables is allowed).

Brightcove export Check to select export of the new title to Brightcove VOD service.

Brightcove Publisher ID Set to the publisher ID provided by Brightcove to allow the user to 
publish content.

Fig. 11-222: Segments Consolidator Element Configuration Fields
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MantricsServer.xml Configuration
<rhozetSegmentsconsolidator>

<server port="8078">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</rhozetSegmentsconsolidator>

MantricsNode.xml Configuration
<rhozetsegmentsconsolidator slotCount="4">

<active>false</active>
<server port="8078">10.250.170.183</server>
<node port="8079">10.250.170.183</node>
<pool/>
<rhozetConsolidateNode port="1120">10.10.0.9</rhozetConsolidateNode>

</rhozetsegmentsconsolidator>

The tag <rhozetSegmentsconsolidator> contains the configuration for this application.

The node tag <rhozetConsolidateNode port=””> defines the IP address and port number 
used to send API commands from the third party application.

For example:
<rhozetConsolidateNode port="1120">10.10.0.9</rhozetConsolidateNode>

Brightcove Notify Email Enter the email address used to confirm a successful export to 
Brightcove.

Freewheel export Check to select export of the new title to the FreeWheel VOD 
service.

Freewheel Notify Email Enter the email address used to confirm a successful export to 
Freewheel.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Note: Ensure that the Nexus Service is running on the host machine.
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Harmonic Rhozet WFS EDL Exporter
The WFS EDL Exporter element can be used to export an Edit Decision List (EDL).

Element Settings Configuration
This element is available in the Transcoding > Harmonic Rhozet > WFS folder and has the 
following settings:

Fig. 11-223: WFS EDL Exporter Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dst Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Profile Type Sets the type of profile that is recalled from the device. You can 
choose from the options: Preset or WTemplate.

Fig. 11-224: WFS EDL Exporter Element Configuration Fields
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MantricsServer.xml Configuration
<rhozetWFSConsolidate>

<server port="8086">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</rhozetWFSConsolidate>

MantricsNode.xml Configuration
<rhozetwfsconsolidate slotCount="4">

<active>false</active>
<server port="8086">10.250.170.183</server>
<node port="8087">10.250.170.183</node>
<pool/>
<rhozetWFSConsolidateNode port="8731">10.10.0.222

</rhozetWFSConsolidateNode>
<rhozetWFSConsolidateNode_descr>WFS Host

</rhozetWFSConsolidateNode_descr>
</rhozetwfsconsolidate>

The tags <rhozetWFSConsolidate> and <rhozetwfsconsolidate> contain the 
configuration for this application.

The node tag <rhozetWFSConsolidateNode port=””> defines the IP address and port 
number used to send API commands from the third party application. The node tag 
<rhozetWFSConsolidateNode_descr> contains a label for the server.

Schema Sets the metadata schema that will be used with the EDL.

Head Sets how many seconds are added to the head of the EDL.

Tail Sets how many seconds are added to the tail of the EDL.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description

Note: Ensure that the Nexus Service is running on the host machine.
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Harmonic Rhozet WFS Transcoder
The WFS Transcoder element enables you to select a profile from those available in the 
WFS system. You can select from a transcoding preset or workflow template. You can also 
set the destination directory in which the transcoded file is created.

Element Settings Configuration
This element is available in the Transcoding > Harmonic Rhozet > WFS folder and has the 
following settings:

Fig. 11-225: WFS Transcoder Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dst Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Fig. 11-226: WFS Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<rhozetWFS>

<server port="8092">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<overwriteInstance>false</overwriteInstance>

</rhozetWFS>

MantricsNode.xml Configuration
<rhozetwfs slotCount="4">

<active>false</active>
<server port="8092">10.250.170.183</server>
<node port="8093">10.250.170.183</node>
<pool/>
<rhozetWFSNode port="8731">10.10.0.222</rhozetWFSNode>
<rhozetWFSNode_descr>WFS Host</rhozetWFSNode_descr>

</rhozetwfs>

The tags <rhozetWFS> and <rhozetwfs> contain the configuration for this application.

Label Sets the label of the instance. The available values are contained in 
the InstanceLabelConfig.xml file.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material. 

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Profile Type Sets the type of transcoding profile that is recalled from the device. 
You can choose from the options: Preset or WTemplate.

ExtraParam Sets additional parameters for the XML file that is sent to the 
transcoder node in order to enable specific filters or functionality. 
For example, it is possible to extract the timecode track from the 
essence instead of reading the timecode from the wrapper 
metadata.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Option Description
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The server tag <overwriteInstance> defines the behavior if an instance of the transcoded 
material, with the same characteristics, is already present in the database. Set the value to 
true to overwrite or false to preserve the existing instance.

For example:
<overwriteInstance>false</overwriteInstance>

The node tag <rhozetWFSNode port=””> defines the IP address and port number used to 
send API commands from the third party application. The node tag 
<rhozetWFSNode_descr> contains a label for the server.

Telestream FlipFactory Transcoder
The Flip Factory transcoder element chooses a preset from the factory settings available in 
the Flip Factory system. Momentum supports build version 7.4.976 of the Flip Factory API. 

Element Settings Configuration
This element is available in the Transcoding > Telestream folder and has the following 
settings:

Note: Ensure that the Nexus Service is running on the host machine.

Fig. 11-227: FlipFactory Transcoder Workflow Element

Fig. 11-228: FlipFactory Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<flipfactory>

<server port="8134">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</flipfactory>

MantricsNode.xml Configuration
<flipfactory slotCount="4">

<active>false</active>
<server port="8134">10.250.170.183</server>
<node port="8135">10.250.170.183</node>
<pool/>
<flipFactoryNode port="9000">10.250.170.183</flipFactoryNode>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Dst Sets the destination directory. Enter the UNC path or set it using the 
browser.

Preset Sets the profile from the available factory settings in the Flip Factory 
system.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: FlipFactory is a product that is not going to be further developed and 
consequently dismissed by Telestream. The end-of-life plans for the 
entire family of FlipFactory software products are as follows:
End of Sale: June 30, 2015
End of Support: December 31, 2016
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<flipFactoryNode_descr>Flip Factory Host</flipFactoryNode_descr>
<user>demo</user>

</flipfactory>

The tag <flipfactory> contains the configuration for this application.

The node tag <flipFactoryNode port=””> defines the IP address and port number used to 
send API commands from the third party application. The node tag 
<flipFactoryNode_descr> contains a label for the server.

Telestream Vantage Transcoder
The Flip Factory transcoder element uses its own profile setting to transcode contents and 
create proxies.

Element Settings Configuration
This element is available in the Transcoding > Telestream folder and has the following 
settings:

Fig. 11-229: Vantage Transcoder Workflow Element

Fig. 11-230: Vantage Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<vantagetranscoder>

<server port="8192">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</vantagetranscoder>

MantricsNode.xml Configuration
<vantagetranscoder slotCount="4">

<active>false</active>
<server port="8192">10.250.170.183</server>
<node port="8193">10.250.170.183</node>
<pool/>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material. 

Workflow template Defines the profile to be applied from a list of profiles retrieved from 
the Vantage Transcoder. 

Output nickname
Used as a filter to process only those files generated by the Vantage 
profile that are assigned the specified nickname. If this field is left 
empty, the transcoder accepts all output files generated by the 
Vantage profile.
By restricting the files accepted by the Vantage Transcoder on 
nickname, you can improve the performance of the transcoder.
To specify a nickname in the Vantage profile, you need to edit the 
bricks in the Vantage interface. In particular, set the parameter 
Output media file nickname in the Flip brick.

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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<ipvantage>http://10.10.0.26:8676</ipvantage>
</vantagetranscoder>

The tag <vantagetranscoder> contains the configuration for this application.

The tag <ipvantage> contains the connection details for the Vantage server.

Wohler RadiantGrid Transcoder
The RadiantGrid transcoder element uses its own profile setting to transcode contents and 
create proxies.

Element Settings Configuration
This element is available in the Transcoding > Wohler folder and has the following 
settings:

Fig. 11-231: RadiantGrid Transcoder Workflow Element

Fig. 11-232:  RadiantGrid Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<radiantgrid>

<server port="8130">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</radiantgrid>

MantricsNode.xml Configuration
<radiantgrid slotCount="4">

<active>false</active>
<server port="8130">10.250.170.183</server>
<node port="8131">10.250.170.183</node>
<pool/>
<radiantUri>http://10.10.0.43</radiantUri>
<username>demo@radiantgrid.com</username>
<password>password</password>

</radiantgrid>

The tag <radiantgrid> contains the configuration for this application.

The node tag <radiantUri> specifies the web address of the RadiantGrid host server.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Storage Profile Defines the storage profile to which the transcoded media are 
saved from a list of profiles retrieved from the RadiantGrid system. 

Transcode Profile Defines the transcoding profile from a list of profiles retrieved from 
the RadiantGrid system.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

isProxy Sets the flag to identify the results of the transcoder element as 
proxies. These are low quality previews of the related material. 

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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Audio Morph Transcoder
The node tags <username> and <password> specify the credentials used to log on to the 
RadiantGrid host server.

Audio Morph Transcoder
The Audio Morph transcoder element enables you to manipulate the audio tracks in a 
media asset by adding, removing or swapping tracks.

Element Settings Configuration
This element is available in the Transcoding folder and has the following settings:

Fig. 11-233: Audio Morph Transcoder Workflow Element

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Fig. 11-234:  Audio Morph Transcoder Element Configuration Fields
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MantricsServer.xml Configuration
<AudioMorph>

<server port="8190">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</AudioMorph>

Output file path Sets a specific path as the target location for the files created by the 
Audio Morph element.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Tracks count Contains the total number of tracks in the new media asset.

Replace audio Specifies replacement content for audio tracks set to an unavailable 
language. For example, an Audio Morph element may be set for 
Track1 ENG and Track2 POR, and the Replace audio option set to - 
Mute -. If one or both of the languages selected for Track1 and 
Track2 are missing in the source material, one or both will be 
replaced by a - Mute - content.
The Do not replace value forces the failure of the task if the selected 
language for the track is missing.

Switch new instance When enabled, activates the newly created Instance and 
propagates the new Instance to the next step of the workflow. The 
default setting is False (unchecked).

Track1...n Provides one field for each unit in the Tracks count field. The value is 
a language specified in the configuration file 
AudioTrackLanguages.xml.The order is the one used to add the 
audio tracks to the new media asset and has the following special 
keywords:
• Mute: creates an audio track with the volume set to zero.
• Same as source: copies the content of the same audio track as used in the 

source file into a specific track of the destination file.
• Source audio: allows selection of a specific track from those available in 

the source material, referring to its position instead of using the language 
label. By default, a maximum of 32 tracks is considered.

The order is the same as that used to add the audio tracks to the 
new media asset.

Pool Sets the name of the pool associated with the element.

Note: The result of the Audio Morph action is a new media asset with a specific 
set of audio tracks. A new proxy needs to be created for playback and 
review in the media player.

Option Description
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MantricsNode.xml Configuration
<AudioMorph slotCount="4">

<active>true</active>
<server port="8190">10.250.170.183</server>
<node port="8191">10.250.170.183</node>
<pool/>

</AudioMorph>

The tag <AudioMorph> contains the configuration for this application.

The node tag <node port=””> specifies the port and IP address of the AudioMorph server.

Configuring Audio Track Languages
To specify the list of available languages for use with media assets, for example, the Audio 
Morph element, you can use the following configuration file:

C:\Mantrics\AudioTrackLanguages.xml

This file contains a list of the languages that are available and the three letter labels for 
identifying them as follows:

<root>
<node value="SIL" label="- Mute -"/>
<node value="As source" label="- Same as source -"/>
<node value="ORI" label="Original"/>
<node value="ENG" label="English"/>
<node value="FRE" label="French"/>
<node value="DEU" label="German"/>
<node value="ITA" label="Italian"/>

Edit the <node> tags as required to build a list that matches the audio content ingested 
with the material in a workflow. The following values are initialized by default:

• The tag <node value="SIL" label="- Mute -"/> contains a value that creates a muted 
audio track, with the volume set to zero.

• The tag <node value="ORI" label="Original"/> contains a value that creates an 
audio track in the original language.

• The tag <node value="As source" label="- Same as source -"/> contains a value that 
copies the content of the same audio track of the source file into a specific track of the 
destination file.

Note: The configuration tags for the Audio Morph element are included in the 
section <wfc> of MantricsNode.xml.

Note: The configuration tags for the Audio Morph element are included in the 
section <workflowNodeConfig> of MantricsNode.xml.
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Omneon Consolidator
The Omneon Consolidator element enables you to send key segments to an Omneon 
Consolidator. The consolidator can then process the key segments to produce a new media 
file that is the consolidation of the key segments created by the operator and return the 
new file to Momentum.

In addition, the Omneon Consolidator can also delegate processing and file transfer 
activities to a remote Omneon server (Spectrum or Mediagrid) if required. When processed 
remotely, operations such as local file transfers are performed in local storage, freeing-up 
the network connection between the Momentum Node and Omneon Storage, which no 
longer needs to transfer the clip essence data.

Element Settings Configuration
This element is available in the Transcoding folder and has the following settings:

Fig. 11-235: Omneon Consolidator Workflow Element

Fig. 11-236:  Omneon Consolidator Element Configuration Fields
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MantricsServer.xml Configuration
<omneonConsolidator>

<server port="8212">10.250.170.183</server>
<policy>Failover</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>

</omneonConsolidator>

MantricsNode.xml Configuration
<omneonconsolidator slotCount="4">
<active>false</active>
<server port="8212">10.250.170.183</server>

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Label Sets the label of the instance. Available values are contained in the 
InstanceLabelConfig.xml file.

Destination Dir Sets the destination directory. Type in a UNC path or set it by using 
the browser.

Schema Sets the metadata schema to be applied to the new Title.

New Title ID Pattern Specifies a template for the new Title ID to ensure that the Logger 
uses this naming convention when exporting XML files to the 
Omneon system. For example: 
{material.GetMetadata(“Core.Title”, 

db.GetTask().ArgAtIndexAsStringArray(0)[0])}

Set Start Timecode to 
zero

When checked, Omneon Consolidator creates new sub-clips 
starting from the key segment and will set the start timecode to 
00:00:00:00.

Roles filter Links the Omneon Consolidator element to a specific role. If not 
checked, all roles can access the Omneon Consolidator element 
from the Actions on the Logger page.

Role Sets the user role that is permitted to access the Omneon 
Consolidator element and restricts viewing of the element in the 
Actions on the Logger page. 

Pool Sets the name of a pool associated with the element to balance the 
processing load.
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<node port="8213">10.250.170.183</node>
<pool/>
</omneonconsolidator>

The tag <omneonconsolidator> contains the configuration for this application.

Replace the default address of the node tag <server> with the port and IP address of the 
Momentum server. Replace the default address of the node tag <node> with the port and 
IP address of the Omneon Consolidator server.

Thumb Generator
The Thumb Generator element generates thumbnails for the submitted video material.

Element Settings Configuration
This element is available in the Transcoding folder and has the following settings:

Fig. 11-237: Thumb Generator Workflow Element

Fig. 11-238:  Thumb Generator Element Configuration Fields
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MantricsServer.xml Configuration
<thumbnailGenerator>

<server port="8104">10.250.170.183</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>true</active>
<reconnectRetryCount>6</reconnectRetryCount>
<reconnectTimeout>20</reconnectTimeout>

</thumbnailGenerator>

MantricsNode.xml Configuration
<thumbnailgenerator slotCount="4">

<active>true</active>
<server port="8104">10.250.170.183</server>
<node port="8105">10.250.170.183</node>
<pool/>

</thumbnailgenerator>

The tag <thumbnailgenerator> contains the configuration for this application.

Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Dst Folder Sets the target destination path for the generated thumbnails.

step Sets the frame interval between thumbnails.

Skip blacks Skips black frames during the thumbnails generation, if activated.

Width Sets the width of the thumbnail in pixels.

Height Sets the height of the thumbnail in pixels.

Use Proxy When checked, the workflow generates thumbnails using the proxy 
file.

Pool Sets the name of a pool associated with the element to balance the 
processing load.

Note: The configuration tags for the Audio Morph element are included in the 
section <usc> of MantricsNode.xml.

Note: The configuration tags for the Audio Morph element are included in the 
section <utilsNodeConfig> of MantricsNode.xml.
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Replace the default address of the node tag <server> with the port and IP address of the 
Momentum server. Replace the default address of the node tag <node> with the port and 
IP address of the Omneon Consolidator server.
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Configuring the User Action Workflow Element
The User workflow element enables you to define a role to complete manual workflow 
operations built into an automated workflow.

The following element is available:
• User Action

The configuration details for this element are provided in the following section.

User Action
The User Action workflow element enables the Administrator to decide when a human 
interaction is required in a workflow by selecting a role which is permitted to process a 
specific task. All the assigned processes are displayed on the To Do page (see the 
Momentum Operator’s Guide for more information). 

Element Settings Configuration
The User Action element has the following settings:

Fig. 12-239:  User Action Workflow Element
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Option Description

Name Sets a label for the element.

Color Enables you to select a color to identify the element easily on the 
Dashboard page. Black is equivalent to no color.

Need instance Specifies that the HQ instance of the material is needed in order to 
complete the operation, if activated.

Role Sets the role for completing the workflow operation.

To Do Enables the user to insert a description of the operation for other 
users.

Show Report Popup When checked, opens a popup when an action processes a task in 
the To Do page. 

Report Header Displays this label in the header of the user task report pane, see 
Figure 12-241.

Fig. 12-240:  Impulsive Recognition Element Configuration Fields
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In this element, use the Add Port button to add one or more ports with a specific label in 
order to preselect the decisions that can be performed by the user. 

Each label becomes a button in the Actions pane of the To Do page. This enables the user 
to select the branch of the workflow to which the task needs to be progressed directly from 
the To Do page. 

Report Prompt Defines a label to specify what information needs to be reported by 
the operator completing the task, see Figure 12-241.

Task Layout Certain systems can send Momentum an XML file, by way of a 
Watchfolder template, which generates a task to create a 
placeholder for a media file that is expected at some later time 
(possibly days or weeks later.)
When the User Action element receives this task it creates a queue 
of placeholders, to be presented in the defined Task Layout.
The Task Layout field provides a list of metadata (see below), to help 
the operator to match the placeholder with the target media file.
Available metadata elements are:
• Associate media
• Audio QC
• AudiotrackTagging
• BasebandReview
• CNNLoggerLayout
• DefaultLayout
• DualBasebandReview
• LiveLogger
• LoggerLayout
• Notification
• PublishToSocial
• QLayout
• OnSocial

A file picker component in the Task Layout enables the operator to 
select the file to make Momentum aware of the association. The 
operator then completes the task.
A Wait for File element is generally the next element in the 
workflow and is used to associate the media file with the 
placeholder. A Technical Metadata Retriever element can then be 
used to extract metadata.

Option Description

Fig. 12-241: User Action - Report Popup Dialog

Report Prompt

Report Header
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Configuring User Notifications
Whenever a task is created on a User Action workflow element, a user notification is 
triggered to users having the role specified in the element.

A user notification is a popup message appearing for some seconds at the bottom right of 
the screen, irrespective of the Momentum page that is currently displayed. The notification 
popup contains the following elements:

• A link to the relevant WorkFlow element.
• A link to the relevant Catalog material.
• Either:

• A Take button, re-directing to the relevant ToDo task, or
• A list of Ports on the element through which the task could be propagated.

The Take option is the default setting. To enable the port listing, select 
Notification from the Task layout options in the settings of the UserAction 
workflow element, see Figure 12-242:

The user can work directly through the notification popup, or open the Notification Panel 
by clicking the notification panel icon  at the top-right of the screen, next to the name 
of the logged-in user.

The notification panel lists all unexpired notifications for all tasks in waiting status at the 
UserAction workflow elements:

Fig. 12-242: UserAction Settings menu - Selecting the Notification Task Layout
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Configure user notifications as follows:
1 Set the tag <ServerCommands> to the default values for the ServerCommands host 

and port used in the configuration file ServerCommandsConfig.xml to direct user 
notifications to the correct web page.

2 Set the tag <ServerHooksRouter> to the IP address and port of the Hooks Router to 
enable the Momentum tasks to progress correctly through the workflow and to direct 
user notifications to the correct web page.

Fig. 12-243: User Action Notification Panel

Open Notification Panel Icon

User Action Manual Review 
Task Required

User Action Generating the 
Task Required

Button to Take Ownership of 
the Task

Button to Progress the Task 
to an Output Port
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Using a Mist Streaming Server
Overview
Momentum supports the Mist Streaming Server.

The Momentum Web installer places the Mist server, by default, in the following directory: 
C:\Mantrics\MistServer.

Starting the Mist Server
To start the Mist server (version 2.13-Pro):

1 On the server selected as the streaming server, open the folder containing the Mist 
Server executables. By default they are located in the directory:
 C:\Mantrics\MistServer.

2 Locate the file MistController.exe.
3 Right-click and drag the file to the desktop.
4 Select Create shortcuts here to create a link on the desktop.
5 Right-click on the new link and select Properties.
6 Include the -n flag in the Target field as shown below:
7 Click the Apply button.

Note: The Mist Server application is portable so that its location can be 
changed after installation as required.
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8 Double-click the link icon to launch the Mist Server.
9 A command shell opens and, if no configuration file is found, you are prompted to 

create a new account. Type y followed by [ Enter ].
10 Enter a user name and a password using the format: username:password. These are 

the credentials to use with the configuration files.
11 When required, enter y followed by Enter. The Mist Server starts and the shell reports 

the logs of the different launched protocols.

Stopping the Mist Server
To shut down the Mist Server application:

1 Open the command shell where the Mist server is running.
2 Click [ Ctrl ] [ C ].

Closing the Mist Server application in this way, always saves the Mist configuration files. It 
is, therefore, recommended initially to close the Mist server in this way to preserve the user 
account details.

Fig. 13-244:  Modifying the Target field

Note: Closing the Mist Server application by clicking the standard close button 
on the command shell does not save the Mist Server configuration files.
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Configuring Momentum to use Mist Server
First, initialize the MabtricsConfig.xml file as follows:

1 Navigate to the directory C:\Mantrics and open the file MantricsConfig.xml in a 
text editor.

2 Locate the <MistHost> tag and replace the default IP value with the IP address of the 
machine currently running the Mist server.

3 Save the file MantricsConfig.xml to store the new settings.

Now modify the MantricsServer.xml file as follows:
4 Browse the file content and locate the tag <Generic>, this contains the parameters 

needed to create new proxies.
5 In the tag <mistAPIUrl>, replace the default IP address with IP address of the machine 

acting as Streaming Server: 
<mistAPIUrl>http://10.10.0.42:4242/api</mistAPIUrl> 

6 Populate the tags <mistUsername></mistUsername> with the username created on 
the Mist Server.

7 Populate the tags <mistPassword></mistPassword> with the password associated 
with the user created on the Mist Server.

8 Save the file to store this information.

If the Momentum installation is using the FFMPEG transcoder, then it is necessary to set 
some parameters in the configuration file MantricsNode.xml:

9 Locate the tag <ffmpeg slotCount="X">.
10 If the installation directory of the Mist Server has been modified, change the path in the 

tag <mistCmdFolder>C:\Mantrics\MistServer</mistCmdFolder> to the new 
location.

In this way, the nodes running FFMPEG can locate the correct executables.

Enabling the MP4 Protocol
Mist server can manage the playback of MP4 streams but this is not a default setting and 
requires activating manually as described below.

Note: The default value for the port, 8080, can be modified but is preferable to 
avoid the use of the port 80 if the Mist server is running on the same 
machine as the IIS server.

Note: This path refers directly to the Mist Server executables stored on the 
streaming server machine.

Note: This path refers directly to the Mist Server executables stored on the 
node machine.
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Accessing the Mist Server Administrator Page
The Mist Server can be managed using a web interface. This interface can be reached using 
the following address in a web browser: http://host-IP:4242

Where host-IP is the IP address of the machine running the Mist Server.

At the login prompt, enter the user name and password credentials created when the Mist 
Server was started for the first time. Now access the administrative configuration tools on 
the Administrator page as shown below:

Installing the Mist Server as a Windows Service
By following the previous steps, the MistServer application is installed automatically and 
then has to be launched manually to create a link to the executable. It may, however, be 
useful to run the MistServer as a Windows service that starts automatically, or is managed 
as a cluster service.

Install the Mist Server as a Windows service, as follows:
1 Download the latest release of the third party nssm tool (nssm 2.24(2014-08-31) at the 

time of writing.)
2 Extract the archive.
3 Open a command shell and navigate to the directory where the program was extracted

Fig. 13-245:  Administrator page login

Fig. 13-246:  Administrator page
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4 Run the following command:
nssm install [Servicename] [Application Path]
For example:
nssm install MistController C:\Mantrics\MistServer\MistController.exe

This statement registers the service as: Startup Type Automatic

Adding the .mp4 Protocol for Streaming
Add the MP4 protocol as follows:

1 Select the option Protocols from the left menu bar to access the Protocols page:

This page reports all active protocols and enables you to add, edit or delete the 
protocols.

2 Click New to access the page for configuring the new protocol:

Note: Before starting the service you must run the MistController application 
manually to create the mist user and activate the protocols.

Note: Using the above procedure the service will be created having the nssm 
application path as its path to the executable, so the nssm will always 
run to start the created service and will be launched using its original 
path. It is, therefore, advisable to locate the nssm executable in a 
Momentum system folder and remember that changing this location 
requires recreating the MistServer service.

Fig. 13-247:  Protocols Page
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3 From the Protocols drop-down list, select the option MP4.exe.

4 Click the Save button to add the protocol to the active protocols list.
5 On the Overview page, activate the Force JSON file save option. Select the option and 

click Save to save changes to the configuration file without turning off the Mist Server.

Fig. 13-248:  Configure new Protocols Page

Fig. 13-249:  Saving the Configuration of the New Protocols Page
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Some additional Momentum modules also require configuration. To achieve full use of their 
Workflow features, configure the following modules and services:

• SendMail Server: Enable the automatic mailing service during a 
workflow.

• Document Data Repository: Configure a storage place where all the files 
connected to the materials of the Catalog are saved.

• Saving searches: Configure a storage place for the searches on the 
Catalog page.

• Mac path conversion: Enable exporting of EDL, converting the path from 
Windows to the Apple Mac OS format.

• XMLDB Interface: Enable the exchange of information with the 
Morpheus XML database. (To be deprecated in 
Momentum version 5.1)

• BXF Receiver: Configure the BXF Receiver module.
• BXF Message Generators: Configure the Morpheus BXF Message Generator 

module.
• BXF Export: Configure the templates for exporting in Morpheus 

BXF format.
• BXF Query: Configure the templates for querying the Morpheus 

database.
• BXF Tx Metadata Receiver: Configure the templates for the BXF Transfer 

Metadata Receiver workflow element to copy values 
from a Transfer Request to a metadata field.

• Metadata Change Notifier: Configure the workflow triggers initiated by the 
Metadata Change Notifier to replicate metadata or 
icon changes across to a secondary or back-up 
system.

• Schedule Missing Material: Configure the templates used to import schedule 
files from a Morpheus Playout Automation system 
used to generate missing material reports.

• Metadata Publisher: Configure template files in order to format the 
available metadata.

• XML Gateway Receiver: Configure ingest using data contained tn XML 
Gateway files. (To be deprecated in Momentum 
version 5.1)

• XML Gateway Export: Configure information exchange with a Morpheus 
server. (To be deprecated in Momentum version 5.1)
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• Audio Tracks Languages: Configure the list of available languages for the 
media assets audio tracks.

• Sony Juke system: Configure access to a Sony Juke module.(To be 
deprecated in Momentum version 5.1)

• Instance labels: Configure the list of the available labels to identify 
specific instances.

• Oracle DivArchive: Configure the interface between the Momentum 
system and a Diva archive system. 

• XCache Receiver: Configure XCache messages. (To be deprecated in 
Momentum version 5.1)

• Transfers Page Contents: Configure the structure of the Transfers page.
• Material Checker: Configure a template for the Material Checker utility.
• Configuring FXP: Configure the FXP protocol.
• XMLDB IF Query: Configure the XMLDB Interface Query. (To be 

deprecated in Momentum version 5.1)
• Morpheus Devices: Configure parameters to enable Momentum to 

communicate with Morpheus and other Playout 
devices in C:\Mantrics\IceConfig.xml.

• Dual Review: Configure dual review of material on two Omneon 
server ports by setting the MediaAsset label pairs in 
C:\Mantrics\IceConfig.xml.

When you include any of the following workflow elements in a workflow, see Chapter 8 for 
information on configuring the element settings.

Configuring Send Mail
Configure Send Mail in the <wfc> section <sendmail> of the file MantricsServer.xml as 
follows:

<SmtpServer>smtp.emailaddress</SmtpServer>
<SmtpServer_descr>SMTP Server</SmtpServer_descr>
<SmtpSSL>true</SmtpSSL>
<SmtpSSL_descr>SMTP SSL</SmtpSSL_descr>
<SmtpUser>user@emailaddress</SmtpUser>
<SmtpUser_descr>SMTP User</SmtpUser_descr>
<SmtpPwd>passwd4momentum</SmtpPwd>
<SmtpPwd_descr>SMTP Password</SmtpPwd_descr>
<SmtpAuthenticate>true</SmtpAuthenticate>
<SmtpAuthenticate_descr>SMTP Auth</SmtpAuthenticate_descr>
<Sender>operator@emailaddress</Sender>
<Sender_descr>Mail Sender</Sender_descr>

Note: Elements that are not listed above, require only a basic configuration.
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1 Replace the default text of the tag <SmtpServer> with the SMTP information for the 
required email server.

2 Set the default text in the tag <SmtpSSL> to true to use secure authentication.
3 Replace the default text of the tag <SmtpUser> with the user name of the sender 

email account.
4 Replace the default text of the tag <SmtpPwd> with the password of the sender email 

account.
5 Set the default text in the tag <SmtpAuthenticate> to true to enable SMTP 

authentication.
6 Replace the default text of the tag <Sender> with the description to appear in the 

sender field of the email.

Configuring the Document Data Repository
In order to save files of various formats (PDF, JPG, DOC, XLS, etc.) to attach to materials 
stored in the Catalog, configure the path to the document data repository in the section 
<auxiliarydata> of the file MantricsServer.xml:

<auxiliarydata>
<server port=”8160”>0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>
<reconnectTimeout>0</reconnectTimeout>
<path>\\hostname\AuxiliaryData</path>

</auxiliarydata>

Configure the default path used as the repository for the files, for example:
<path>\\hostname\AuxiliaryData</path>

Saving Searches
To allow users to save search queries defined in the Momentum Search Tool:

1 Navigate to the directory C:\Mantrics and locate the file queries.xml.
2 Make sure that the file is fully accessible by Everyone with read and write permissions.

Setting Apple Mac Path Conversions
To set the Macintosh path conversion of the XML edit decision list (EDL) export:

Note: The tags using the descr word (for example, <Sm tpPwd_descr>) are 
optional, descriptive tags used by the system to identify the elements.

Note: This file allows users to save the searches in the Catalog and Logger 
pages and in the Material Browser pane of the Editing page.
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1 Navigate to the directory C:\Mantrics and open the file MantricsServer.xml in a 
text editor.

2 In the tag <MacMapDirectory>, set the destination path for the generated files as 
shown in the following example:
<MacMapDirectory>
<MapDir windir="file://server/sharedfolder/" macdir="/Volumes/
sharedfolder/" />
</MacMapDirectory>

3 Save the file MantricsServer.xml to store the new settings.

Setting up an XML DB Interface for a Morpheus Server
The XML DB Interface allows Momentum to exchange information with a Morpheus XML 
Database Interface.

Configuring the Morpheus Server
To configure the XML DB Interface between Momentum and the Morpheus Server:

1 In a text editor, open the file: C:\Mantrics\MorpheusServerConfig-sample.xml.
2 Go to the section <videoServers>:

<videoServers>
<MorpheusVideoServer>
<videoServerName>Name</videoServerName>
<uncPath>Path</uncPath>
<instanceLabel>Label</instanceLabel>
</MorpheusVideoServer>

</videoServers>

The tag <videoServers> contains the list of the Morpheus Video Servers that 
Momentum connects to in order to retrieve data. The VideoNetworkManager can 
manage one or more video servers.
Each Morpheus video server is described by a tag <MorpheusVideoServer> which 
contains the following parameters:

Note: This operation allows Momentum to export an EDL - converting the 
path from Windows to the Macintosh OS. When the XML is imported 
into the editing application on a Macintosh machine, the media file 
connects successfully.

Note: It is planned to deprecate the XML DB Interface functions from 
Momentum version 5.1 It is recommended to use the BXF Receiver, BXF 
Export and BXF Query elements instead.

Tag Description

videoServerName Sets the name of the server
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3 In the <Filters> section:
<filters>

<filter>
<materialType>Type</materialType>
<materialId isExcluding=’true’ | ‘false’>Materialid</materialId>
</filter>

</fiters>

The tag <filters> enables you to customize the way that Momentum manages different 
materials across the XML DB Interface. You can define one or more rules each specified in a 
different <filter> tag. Each filter can refer to the <materialType> and/or to the 
<materialId> parameters as follows:

4 Configure the remaining tags in MorpheusServerConfig-sample.xml as described in 
the following table:

uncPath Identifies the path of the storage folder on the server.

instanceLabel Defines the label to assign in Momentum to identify content 
from the specified server. The instance label appears in a 
workflow in the Instance Switcher for selection in a player. It 
enables you to track a re-acquisition of the same material.

Tag Description

materialType The standard list of Morpheus material types (Programme, 
Commercial, etc.)

materialId The Material ID of the content and contains the attribute 
isExcluding (boolean) which can include or exclude a specific 
Material ID. This tag allows the use of the % character as wild-
card, for example, use NEW% to select all material containing 
NEW in their Material ID.

Tag Description

markInstancesDeleted Configures the behavior of the Morpheus Server when it 
analyzes a deleted instance message. If the value of the 
tag is true, the labels of all the instances related to the 
deleted material are set to DELETE.

retryCount

restartTimeInSecond

Number of attempts to try to reconnect and timespan to 
wait before retrying to connect. These tags manage a 
temporary network disconnection between Momentum 
and the XML database interface.

Sender
to
subject 
body

When configured, the Morpheus Server sends an email 
using the parameters contained in these tags when a 
disconnection occurs.

Tag Description
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5 Save the file MorpheusServerConfig.xml to store the configuration.

Configuring the Metadata Change Notifier (MCN)
The Metadata Change Notifier is designed to detect manual changes to metadata made on 
one Momentum system and replicate these changes to a back-up / secondary Momentum 
or Morpheus Playout Automation system by triggering a synchronization workflow. This 
helps to ensure that the metadata on both systems is always synchronized.

The settings of the MCN are configured in the file: 
C:\Mantrics\MetadataChangeNotifierConfig.xml.

To configure the Metadata Change Notifier utility settings:
• In a text editor, open the file:

connectionMailTo
connectionMailSubject 
connectionMailBody

When configured, the Morpheus Server sends an email to 
notify the user when a new connection with the XML 
database Interface is active.

reSyncOnStart
numberOfDaysToReSync

Determine if a synchronization process starts when the 
connection to the XML database interface is established. 
If <reSyncOnStart> is true, the synchronization 
operation is active and the tag 
<numberOfDaysToReSync> determines the number of 
days before re-synchronizing.

VideoServerConfiguration Manages temporary network disconnections between 
Momentum and the videoServer. It is possible to set the 
parameters <retryCount> (number of attempts to try to 
reconnect) and <restartTimeInSecond> (timespan to 
wait before retrying).

MapItem For each new item of material received from the XML 
database interface, you can assign a specific Momentum 
Metadata Category based on rules, with each separate 
rule defined in a <MapItem> tag 

Defines a rule for each new item of material received from 
the XML database interface. You can assign a specific 
Momentum Metadata Category based on these rules. This 
tag has the following two parameter tags <regex> and 
<catId>.

regex Defines the pattern of the Material ID using a regular 
expression.

catId Defines the Category ID in the Momentum database.

Tag Description

Note: The Metadata Change Notifier service must not be running on both 
primary and secondary Momentum systems to prevent the echoing of 
metadata changes between systems.
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C:\Mantrics\MetadataChangeNotifierConfig.xml

The file has the following structure:
<?xml version="1.0" encoding="UTF-8"?>
<MetadataChangeNotifierConfig xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<EntryPoints>

<EntryPoint genre="MEDIA_ASSET">
<WFElementID>1D530E0435FA4B00A64D811824689055
</WFElementID>
<SearchCriteria>Core.MaterialId = '{Core.MaterialId}'
and Instance.Archive.RACK = 'test'</SearchCriteria>

</EntryPoint>
<EntryPoint genre="TITLE">

<WFElementID>EEBDF3EB3DE746378F0C9EED98CE9CE3
</WFElementID>
<SearchCriteria><SearchCriteria/>

</EntryPoint>
</EntryPoints>
<WFElementIDForIconUpdate/>
<QuietPeriod>10</QuietPeriod>
<UserId/>
<MetadataIDsToExclude>

<MetadataID></MetadataID>
<MetadataID></MetadataID>

</MetadataIDsToExclude>
</MetadataChangeNotifierConfig>

These XML tags have the following functions:

Tag Description

EntryPoints Groups workflow entry points that can be triggered by the 
Metadata Change Notifier.

EntryPoint Defines the information about each workflow entry point 
that can be triggered by the MCN.
Attribute:
Genre: Specifies the entry point for the specific material 
genre (e.g. TITLE, MEDIA_ASSET, etc.)

WFElementID Defines the ID of the workflow element used to trigger a 
workflow task when the metadata change concerns that 
particular material genre.
To find the ID of a workflow element, export the workflow to 
an XML file and copy the ID from the <Element><id> field.

SearchCriteria Defines a search in pseudo query style to filter the material 
according to the criteria in the search string. For example: 
Core.MaterialId = '{Core.MaterialId}' and 
Instance.Archive.RACK = 'test'

WFElementIDForIconUpdat
e

Defines the ID of the workflow element used to trigger a 
workflow task when an icon is set from the user interface (for 
example, from the Catalog page.)
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Configuring Schedule Missing Material Reports
The Schedules page in Momentum provides a view of any scheduled material missing 
from the database of the Morpheus Playout Automation system. This page enables you to 
import schedule files (.SCH) generated by Morpheus, review missing material and generate 
missing material reports using predefined XML or CSV templates.

To use the Schedules page functions, you need to configure the following files in the 
default installation folder: C:\Mantrics:

• SchedulesConfig.xml Defines the channel names and IDs used in the 
playout schedule.

• SchedulesReceiverConfig.xml Defines the location in which Morpheus saves 
the schedule files for import into Momentum, 
parameters for importing the file and rule filters 
to extract secondary events from the schedule 
files for inclusion in the Schedules page.

The Schedule configuration file SchedulesConfig.xml has the following structure:
<?xml version="1.0" encoding="utf-8"?>
<SchedulesConfig xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<DeadlineHours>10</DeadlineHours>
<Channels>

<BroadcastChannel>
<Id>Channel1</Id>
<Name>MTA 1</Name>

</BroadcastChannel>
<BroadcastChannel>

<Id>Channel2</Id>
<Name>MTA 2</Name>

</BroadcastChannel>
<BroadcastChannel>

QuietPeriod A quiet period is a period (in seconds) that MCN maintains 
between the moment the last metadata change is detected 
and a task is created on the entry-point workflow element.

UserID Defines a specific User ID to create a task assigned to a 
specific user.

MetadataIDsToExclude Groups together a list of metadata to exclude from 
triggering a synchronization workflow if those items of 
metadata change.

MetadataID Defines each item of metadata to skip to prevent changes to 
that item from triggering the configured workflow. For 
example:
<MetadataID>Core.Description</MetadataID>
<MetadataID>Core.Title</MetadataID>

When a material is changed for a metadata listed in this tag, 
Momentum ignores the change(s) and does not trigger a 
workflow. 

Tag Description
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<Id>Channel3</Id>
<Name>MTA 3</Name>

</BroadcastChannel>
<BroadcastChannel>

<Id>Channel4</Id>
<Name>MTA 4</Name>

</BroadcastChannel>
<MetadataList>

<Metadata>
<Id>Core.Title</Id>

</Metadata>
<Metadata>

<Id>Core.Path</Id>
</Metadata>

</MetadataList>
</Channels>
</SchedulesConfig>

The tags have the following functions:

The Schedule configuration file SchedulesReceiverConfig.xml has the following 
structure:

<?xml version="1.0" encoding="utf-16"?>
<SchedulesReceiverConfig xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema">


<SchedulesFolder>\\10.10.0.221\video\UsersTestArea\
MTA\MORPHEUS_SCHEDULES</SchedulesFolder>

<RecurseSubdirs>true</RecurseSubdirs>
<FileFilter>*.sch</FileFilter>
<WaitMsForCompletedFile>3000</WaitMsForCompletedFile>

Tag Description

DeadlineHours Defines a span of time, in hours, from the current time during 
which the event is considered as urgent. A zero value means 
that there is no definition of an urgent span of time.

Channels Groups the broadcast channels covered by the playout 
schedule files.

BroadcastChannel For each channel included in the schedule files, specifies the 
channel ID and channel name.

Id Defines each channel ID.

Name Defines the name of the broadcast channel.

MetadataList Groups a list of extra metadata (each reported in a 
<Metadata> tag) that will be rendered as additional 
columns in the Schedules page.

Metadata Defines each element of metadata (contained in an <Id> 
tag) that will be rendered as an additional column in  the 
Schedules page.

Id Contains the metadata for each column to be added to the 
Schedules page.
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<LastAirDateMetadataId>MomentumCore.MomentumCore.ARCHIVE
</LastAirDateMetadataId>
<SecondaryEventRules>

<SecondaryEventRule>
<Identifier XPath="" CaseSensitive="false">
</Identifier>

</SecondaryEventRule>
<SecondaryEventRule>

<Identifier XPath="" RegularExpression="">
</Identifier>

</SecondaryEventRule>
</SecondaryEventRules>

</SchedulesReceiverConfig>

The tags have the following functions:

Tag Description

SchedulesFolder UNC path to the folder containing the schedule files.

RecurseSubdirs When set to true, activates automatic monitoring of the 
subdirectories below the specified directory.

FileFilter Sets a filter on filename to select for schedule files, or 
schedule files with specific names.

WaitMsForCompletedFile Sets a number of milliseconds (MS) for Momentum to wait 
for the arrival of the completed schedule file.

LastAirDateMetadataId Sets the ID of the last_air_date metadata in Morpheus 

SecondaryEventRules Collects a list of rules to extract secondary events (audio, 
graphics, subtitle files) so that they have their own record 
in the Momentum Schedules page.

SecondaryEventRule Defines each rule to extract a specific secondary event 
item for inclusion in the Momentum Schedules page.

Identifier If specified, the Identifier value is used to transform the 
XmlNode value taken by the XPath and replace it 
according to the capturing groups specified in the 
Regular Expression.

Attributes:
• XPath: Mandatory attribute to be evaluated from the <Event> 

tag of the SCH file to obtain the Morpheus ID of the secondary 
event. For example: xpath=“.Fields/
Parameter[@Name=’Subtitles’]/@Value”

• RegularExpression: Optional attribute to filter out values that do 
not match the regular expression. For example: 
RegularExpression=“.+\\(\d{4})\.tga$”

• CaseSensitive: Optional attribute to specify whether to consider 
the case of the Regular Expression when matching. (Default = 
false).
332



Momentum
Configuration Guide
Configuring XML Gateway Receiver

Configuring XML Gateway Export
The tag <xmlGatewayExport> in the files MantricsServer.xml and MantricsNode.xml 
contains the configuration for this feature. For details of the standard parameters, see 
Configuring the Momentum Farm, on page 22.

The following server tags are also available:
• isTitleMandatory: Specifies whether the Title field in the 

XMLGateway message is to be initialized. 
Tasks for messages which do not match 
this setting automatically fail.

• momentumCoreMandatoryFields: Collects all of the tags required to specify 
mandatory fields using the tag 
<momentumCoreMandatoryField>.

• momentumCoreMandatoryField: Specifies a single Momentum Core field to 
be initialized in the XML message. Tasks 
for messages which do not match this 
setting automatically fail.

• momentumInstanceMandatoryFields: Collects all of the tags required to specify 
mandatory fields using the tag 
<momentumInstanceMandatoryField>

• momentumInstanceMandatoryField: Specifies a single Momentum Instance 
field to initialize in the XML message (use 
one or more tags as needed). Tasks for 
messages which do not match this setting 
automatically fail.

• areEmptyFieldsVisible: Creates an XML message, formatted in a 
compact way, which hides all empty 
fields.

• isKeySegmentTimecodeOutNotEmpty: Specifies if the Segment Timecode Out 
field of the XML message needs to be 
initialized.

• checkDstFolderCount: Sets the maximum number of checks 
done by Momentum to verify if Morpheus 
has screened the XML message, copying 
it to one of the directories specified in the 
related element parameters.

• retryDstFolderSeconds: Defines the amount of time elapsed 
between two consecutive checks.

Example:
<areEmptyFieldsVisible>false</areEmptyFieldsVisible>
<isKeySegmentTimecodeOutNotEmpty>false
  </isKeySegmentTimecodeOutNotEmpty>
<checkDstFolderCount>10</checkDstFolderCount>
<retryDstFolderSeconds>30</retryDstFolderSeconds>
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Configuring Audio Track Languages
To specify the list of available languages for use with media assets, for example, the Audio 
Morph element, you can use the following configuration file:

C:\Mantrics\AudioTrackLanguages.xml

This file contains a simple list of the languages that are available and the three letter labels 
for identifying them as follows:

<root>
<node value="SIL" label="- Mute -"/>
<node value="As source" label="- Same as source -"/>
<node value="ORI" label="Original"/>
<node value="ENG" label="English"/>
<node value="FRE" label="French"/>
<node value="DEU" label="German"/>
<node value="ITA" label="Italian"/>

Edit the <node> tags as required to build a list that matches the audio content ingested 
with the material in a workflow. The following values are initialized by default:

• The tag <node value="SIL" label="- Mute -"/> contains a value that creates a muted 
audio track, with the volume set to zero.

• The tag <node value="ORI" label="Original"/> contains a value that creates an 
audio track in the original language.

• The tag <node value="As source" label="- Same as source -"/> contains a value that 
copies the content of the same audio track of the source file into a specific track of the 
destination file.

Configuring a Sony Juke System

To use a Sony Juke library with Momentum, you will need to add the details to the 
configuration file MantricsServer.xml.

To configure a Juke device, open the MantricsServer.xml file in a text editor and locate 
the tag <juke> as follows:

<juke>
<server port="8172">0.0.0.0</server>
<policy>Weighted</policy>
<retryCount>3</retryCount>
<active>false</active>
<reconnectRetryCount>1</reconnectRetryCount>

<reconnectTimeout>0</reconnectTimeout>

<basicmetadata_topic>XDCAM</basicmetadata_topic>
<mappingCat>

<mapItemList>

Note: It is planned to deprecate the Sony Juke functions of Momentum from 
version 5.1. It is recommended to use the Oracle DivArchive archiving 
functions to satisfy your archiving requirements.
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<MapItem>
<regex>ASF\w*</regex>
<catId>F91CD674365A41daB1CC273C49816093</catId>
<!--Film-->
</MapItem>

</mapItemList>
</mappingCat>
<libraryList>

<library>
<name></name>
<ip></ip>

</library>
</libraryList>
<storageLocationsList>

<location>
<UserFTPHomeDir></UserFTPHomeDir>
<host></host>
<user></user>
<pwd></pwd>
<dir></dir>

</location>
</storageLocationsList>

</juke>

The tag <Juke> is organized into several sections:
• General parameters of the Momentum Server
• An optional section to initialize material metadata
• A list of available libraries
• A list of storage locations.

Setting the General Parameters
This configuration section contains the following tags:

• server port: Sets the port for communication between the server and the 
node. By default, the attribute port=”XXXX”  is the same in the 
corresponding sections of the configuration files 
MantricsServer.xml and MantricsNode.xml. If it is necessary 
to change this setting, remember to modify both configuration 
files. The 0.0.0.0 IP configuration is used for monitoring incoming 
traffic from every valid IP address.

• policy: Sets the method for handling the nodes. The options are Failover 
and Weighted (see Configuring the Basic Server Settings).

• retryCount: Sets the number of attempts that the Momentum Server can try 
to establish whether a node is available.

• active: Set to true or false. True means that the Momentum Server is 
ready to register a Momentum Juke Node. False means that the 
Momentum Server ignores all possible Node connection 
attempts.
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The mapping configuration section enables you to add a category ID to the metadata for an 
item of material or to all the materials of a particular type which can be specified using a 
regular expression as shown below:

<mappingCat>
<mapItemList>

<MapItem>
<regex>ASF\w*</regex>
<catId>F91CD674365A41daB1CC273C49816093</catId>
<!--Film-->

</MapItem>
</mapItemList>

</mappingCat>

This section contains the following tags:
• mapItem: Each <mapItem> tag contains a rule for selecting the material 

and a definition of the category ID which is added to the 
metadata of the selected material.

• regex: Contains the regular expression used to select the material.
• catID: Defines the category ID which is added to the material metadata.

Setting the Library Parameters
This configuration section lists all the Juke libraries which are available to Momentum as 
shown below:

<libraryList>
<library>

<name></name>
<ip></ip>

</library>
</libraryList>

This section contains the following tags:
• library: Defines one Juke library and contains the name and IP tags.
• name: Defines a name which identifies a Juke library. This name 

becomes the label for the library in the Momentum interface.
• ip: Defines the IP address for a specific library.

Setting the Storage Location Parameters
This configuration section defines the storage locations used as a destination when 
ingesting material from the Juke or as a source when archiving materials from the Juke 
disks as shown below. 

<storageLocationsList>
<location>

<UserFTPHomeDir></UserFTPHomeDir>
<host></host>
<user></user>
<pwd></pwd>
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<dir></dir>
</location>

</storageLocationsList>

The Juke accesses these directories using FTP so the server containing these directories 
must have an active FTP server.

This section contains the following tags:
• location: Defines a single folder and provides the information required to 

connect to an FTP server.
• UserFTPHomeDir: Reports the home directory for the account used to log onto the 

FTP server.
• host: Contains the IP address of the server which is running the FTP 

server.
• user: Defines the account used to access the FTP server.
• pwd: Defines the password for the FTP account.
• dir: Specifies a directory below the home directory as the target for 

Juke operations.

Configuring Instance Labels
To specify the label of an instance, set the label value in the configuration file 
C:\Mantrics\InstanceLabelsConfig.xml.

An example of the typical content of the file is as follows:
<root xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<node value="HQ" label="High quality master instance"  />
<node value="To-Air" label="Instance to be aired"  />
<node value="SQ" label="SQ"/>
<node value="Avid" label="Avid"/>
<node value="SOCIALMEDIA" label="SOCIALMEDIA"/>
<node value="FACEBOOK" label="FACEBOOK"/>
<node value="TWITTER" label="TWITTER"/>
<node value="COPY_TEMP" label="COPY_TEMP"/>
</node>

</root>

The tag <node> contains the following parameters:
• Value: The full label to be inserted into the metadata of an instance.
• Label: A short text description of the instance label. It is used in the 

drop-down menus of an element’s parameters for setting a Label 
parameter.

You can add more node tags as required, in order to identify the instances produced in a 
workflow.
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The content and layout of the Transfers page is defined in the configuration file 
C:\Mantrics\TransferRequestsConfig.xml.

This file defines the structure of the table where transfer requests are reported and the 
values associated with each column. 

When Momentum receives a BXF message, some of the request data is automatically stored 
in the system database, while other data requires a specific mapping from the BXF file to 
the database. This is done by mapping the Xpath values of the BXF file to a specific field in 
the database. The file TransferRequestsConfig.xml can retrieve this value, using a 
<Field> tag that points to the same database field specified in one of the 
<targetMetadata> tags of the BXFReceiver template Default.xml, and uses it to populate 
the Transfers page.

The file TransferRequestsConfig.xml is structured as follows:
<?xml version="1.0" encoding="utf-16"?>
<TransferRequestsConfig xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema">

<DeadlineHours>0</DeadlineHours>
<Columns>

<Column>

<Field>channel</Field>

<Label>Network</Label>

<Type>List</Type>

<Options>

<Option>

<id>Station</id>

<text>Station - mapped</text>

</Option>

<string>Vision</string>

<string>Line1</string>

<string>Line2</string>

</Options>

</Column>
<Column>

<Field>MaterialType</Field>
<Label>Type</Label>
<Type>List</Type>
<Options>
<string>COMMERCIAL</string>
<string>JUNCTION</string>
<string>PROGRAMME</string>
</Options>

</Column>
<Column>

<Field>requiredDate</Field>
<Label>First Air Date</Label>
<Type>Date</Type>

</Column>
<Column>

<Field>morpheusId</Field>
<Label>Morpheus ID</Label>
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<Type>String</Type>
</Column>

</Columns>
</TransferRequestsConfig>

This section contains the following tags:
• DeadlineHours: Defines a span of time, in hours, from the current time during 

which the request is considered as urgent, and marked with a 
colored dot on the Transfers page, for example, 4 hours or less to 
on-air. A zero value, or empty tag,means that there is no 
definition of an urgent timespan and no highlight marker for 
urgent transfer requests is displayed.

• Columns: Collects all of the column definitions on the Transfers page.
• Column: Defines the data for a single column on the Transfers page.
• Field: Sets the database field which populates the value of the 

column.The values for this tag are restricted to the values used to 
store the transfer request data in the database. See the 
introduction of this section for more details about how this 
mapping works.

• Label: Defines the label that appears in the column header.
• Type: Defines the kind of filter input which is active on the column. The 

following values are available:
• String: A text input field is available for typing strings to filter the 

column’s content, for example Morpheus material types: 
COMMERCIAL, PROGRAMME, JUNCTION. etc.

• Date: A date selector to filter the column’s content.
• List: A list of checkboxes to filter the column’s content.

• Options: A collection of all options available in a checkbox filter. It is active 
only if the tag <Type> is set to List. 

• string: Provides the label for a single list option in the <Options> tag. 
There is no limit to the number of options in a list.

Configuring the Material Checker Template
The Momentum MaterialChecker is a utility that enables you to trigger a workflow when 
specific pre-defined time constraints are exceeded. For example, you might create an 
archive or delete workflow to be triggered when certain material files have been in a 
location longer than a configured time limit. You can configure a Windows task schedule on 
the application server to start and run the MaterialChecker periodically (e.g., daily) to 
check the target files.

You can trigger a workflow either by way of BXF messaging or using a Send to... workflow 
element.

The Momentum server installer includes an executable file for the MaterialChecker utility 
together with a sample of the Material Checker template, which is saved in the default 
installation location:

C:\Mantrics\MaterialCheckerTemplate\MaterialCheckerTemplate.xml
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The MaterialChecker executable is located in the following folder:
C:\Mantrics\Program Files\Mantrics S.r.L\MaterialChecker.exe

This file defines the parameters employed by the Material Checker to trigger a workflow 
based on specific timing parameters.

The file MaterialCheckerTemplate.xml is structured as follows:

<?xml version="1.0"?>
<MaterialCheckerTemplate>

<Genre>VIDEO</Genre>
<DateMetadataList>

<DateMetadata>
<Date/>
<TimeToAddInDays>-30</TimeToAddInDays>
<DateMetadataId>Core.CreationDate</DateMetadataId>
<DateOperator>Lesser</DateOperator>

</DateMetadata>
</DateMetadataList>
<AdditionalQuery/>
<BXFPublisher>

<Active>false</Active>
<BXFRouteLabel>Test</BXFRouteLabel>
<Origin>Momentum1</Origin>
<Destination>Momentum2</Destination>
<BXFAction>remove</BXFAction>

</BXFPublisher>
<SendToPublisher>

<Active>false</Active>
<SendToElementId>68BC5293C0C3457D8283958D5BBFA709

</SendToElementId>
<Priority>5</Priority>
<UserId>60F2B532673749A79246EA6B84E5B1E4</UserId>

</SendToPublisher>
<LogEnable>false</LogEnable>
<WriteReport>false</WriteReport>

</MaterialCheckerTemplate>

This file contains the following tags:
• Genre: Defines the target material for the template to check. 

Permitted values are: VIDEO (to work on TITLES), 
MULTIMEDIA (to work on Instances), empty tag (as 
MULTIMEDIA).

• DatemetadataList: Collects one or more date metadata fields to search.
• Datemetadata: Defines the date parameters to use as the criteria to trigger 

a workflow.
• Date: Defines a date value; if empty the Material Checker uses 

the current date.
• TimeToAddInDays: Sets the number of days to add to the specified or current 

date. A negative value specifies a number of days before 
the specified or current date.
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• DateMetadataId: Defines the ID of a date metadata to compare against.
• DateOperator: Specifies an operator to use in combination with the date 

field. You can specify either: Lesser, LesserOrEqual, Greater, 
or GreaterOrEqual.

• AdditionalQuery: Contains an optional additional query, if required, to 
search other metadata (excluding date metadata). You can 
leave this tag empty.

• BXFPublisher: Collects the parameters to trigger a workflow using BXF 
messages.

• Active: When true, the workflow is triggered using BXF messages. 
Default: false.

• BXFRouteLabel: Specifies the label of the BXF Route to use for BXF 
messaging.

• Origin: Defines the Origin of the BXF message.
• Destination: Defines the Destination of the BXF message.
• BXFAction: Defines the action required by the BXF message. You can 

set to: add, remove or update.
• SendToPublisher: Collects the parameters to trigger a workflow by way of the 

Send to... workflow element.
• Active: When true, the workflow is triggered using the Send to... 

workflow element. Default: false.
• SendToElementId: Defines the ID of the specific Send to... workflow element 

to trigger. Use the Export XML... function to report the IDs 
of your workflow elements.

• Priority: Sets the priority of the task that is triggered by the Material 
Checker.

• UserId: Defines the ID of the user that creates the workflow task.
• LogEnable: When true, a log is generated to record the result of the 

search performed by the Material Checker. Default: false.
• WriteReport: When true, a text report is generated to document the 

results of the search performed by the Material Checker. 
The report is saved in the same folder as the Material 
Checker executable.

•
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Product Support
Providing Information to Grass Valley
If you experience any technical or operational difficulties with a Grass Valley product please 
do not hesitate to contact us to request assistance.

There is a lot of information you can give us that will enable us to diagnose your problem 
swiftly. Please read the following guidelines, as these suggestions will help us to help you.

Basic Information
• For Units: Provide the exact product Model, unit Serial Number and Software 

Version information.

Software Application
• Inputs: Provide full details of the Input Signals being used including any 

references, etc., and where they are being generated.
• Outputs: Provide full details of the Output Signals required and how they are being 

monitored.
• System: Provide a brief description of the system in which your equipment is 

currently being used.

Your Contact Details
In addition to the above, remember to provide us with your contact details to enable us to 
get in touch with you swiftly:

• Name(s)
• Telephone
• E-mail addresses
• Business address
• Contact Details

Customer Support
For details of our Regional Customer Support Offices, please visit the Grass Valley website 
and navigate to Support/Contacts Support.

http://www.grassvalley.com/support

Customers with a support contract should call their personalized number, which can be 
found in the contract, and be ready to provide their contract number and details.
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Contact Us
Grass Valley Technical Support
For details of our Regional Customer Support Offices please visit the Grass Valley web site 
and navigate to: Support > Customer Care.

https://grassvalley.com/support

Customers with a support contract should call their personalized number, which can be 
found in their contract, and be ready to provide their contract number and details.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
http://www.grassvalley.com

https://grassvalley.com/support
http://www.grassvalley.com
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